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Overview

1  Overview

GENIUS TOOLS Starter® is used to start locally installed applications using a centrally

managed configuration. All required data is synchronized from a central storage location

(Caddepot) to the local computer (Cadpool). The software offers global administration

capabilities for heterogeneous IT landscapes and user-specific adaptation options.

1.1  GENIUS TOOLS Starter philosophy

GENIUS TOOLS Starter lets you manage centrally configured operating environments.

Typically, a company uses one productive operating environment. This operating

environment can be synchronized to all user computers. An operating environment can

contain any number of Starter projects, which are configured with just a few mouse clicks

and distributed to either all or only to specific users.

GENIUS TOOLS Starter can provide for multiple operating environments, so that test

environments or environments with customer-specific configurations can be configured

with little effort. Also, GENIUS TOOLS Starter can integrate publicly available

configurations.

Using synchronization between the administration computer and a number of client

computers, you can manage large and complex installations, distribute central

configuration settings to each workstation and also distribute the required data. Changes

to the configuration are thus automatically made available to all users. Configurations can

differ between users by organizing them in units. 

The following procedure applies to all programs:

1. the environment can be cleaned first and 

2. GENIUS TOOLS Starter settings are made.

Supported applications
Administrators can create projects with object data and predefined configuration settings

for the following CAD applications. 

– AutoCAD, AutoCAD Architecture, AutoCAD LT and AutoCAD Mechanical

– Creo Elements / Direct Modeling

– Creo Parametric

– Inventor

– SolidWorks
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For projects of the above applications different settings can be made in different

configuration layers, e. g. for departments (units). Projects can be set up for different

versions.

The following applications will be automatically detected if they are installed on the user

computer. The latest version will be opened.

– Creo Elements / Direct Drafting

– Creo Schematics

– Creo View

– Geomagic Design X

– KeyVR

– Keyshot

– Mathcad

1.2  Component modules

GENIUS TOOLS Starter provides user-friendly graphical interfaces for easily managing CAD

installations as well as any other program. It consists of four components:

– GENIUS TOOLS Environment Administrator for managing operating environments

– GENIUS TOOLS Project Configurator for configuring projects within an operating

environment

– GENIUS TOOLS Starter App for starting the configured projects

– GENIUS TOOLS Config Editor for editing configuration blocks 

GENIUS TOOLS Environment Administrator
GENIUS TOOLS Environment Administrator provides functionality for managing operating

environments. Use GENIUS TOOLS Environment Administrator to

– create new operating environments

– change properties of an operating environment

– update GENIUS TOOLS Starter and GENIUS TOOLS for Creo in an operating

environment

– configure license servers and synchronization settings

GENIUS TOOLS Environment Administrator is a stand-alone administrative tool. The

executable file gtsa.exe is located in the Installdepot directory.
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GENIUS TOOLS Project Configurator
GENIUS TOOLS Project Configurator provides functionality for configuring different

projects with only a few mouse clicks. End users can thus start projects with an application

using specific configuration settings. Use GENIUS TOOLS Project Configurator to

– define adaptable configuration settings for homogeneous or heterogeneous CAD

landscapes

– define unit-specific settings

– manage different projects.

GENIUS TOOLS Project Configurator is started from the user menu of GENIUS TOOLS

Starter App, but the administrator may deny users access.

GENIUS TOOLS Starter App
The configured projects are listed in GENIUS TOOLS Starter App for the users, who can

select a project with a specific configuration. The user interface also displays additional

information, e. g., available licenses, working directory and error messages.

GENIUS TOOLS Starter App is a stand-alone tool. The executable file gts.exe is located in

the Caddepot directory under Software.

GENIUS TOOLS Config Editor
Administrators can edit configuration settings with GENIUS TOOLS Config Editor as well as

compare them in different versions for Creo Parametric.

GENIUS TOOLS Config Editor is a stand-alone tool. The executable file GTConfigEditor.exe

is located in the tools directory, which is a directory in both the installation computer as

well the user computer. 

GENIUS TOOLS Config Editor also starts by clicking a config file in GENIUS TOOLS Starter

App, though administrators may deny users access.

1.3  Advantages of using GENIUS TOOLS Starter

The use GENIUS TOOLS Starter offers the following advantages:

– project-oriented workflow

– creating projects that unite the program to be launched, required licenses, specific

configuration and related data

– support for different working environments

– easy handling through graphical user interface 
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– central configuration of application computers

– synchronization based on a configurable interval

– organization of users into units and subunits

– role-based permission concept

– management of configuration blocks (component files of a configuration)

– blocking access to projects

– support for multiple languages

For CAD applications, the following advantages are added:

– fastest possible startup of CAD application, as all data is stored locally

– licensing with FlexLM, fail-safe mode and license borrowing supported

– creation of project options which users can select

– easy configuration of a CAD landscape

– license management

– easy offline work using license borrowing

– Windchill integration

– database-driven management of Creo Parametric configuration settings

1.4  License-dependent features

Starting with GENIUS TOOLS Starter 6.0.1, the product functionality depends on the type

of license you are using. From the year 2020 onwards, GENIUS TOOLS Starter is only sold

with subscription licenses.

The following functions are available with a subscription license for GENIUS TOOLS Starter.

Subscription

function

Description Release

Dynamic access to

Windows user

management with

LDAP/Active

Directory

(lightweight

directory access

protocol)

Creates access to Windows user management and

enables live queries so that user assignment is always

up-to-date. Users thus do not have to be created and

maintained manually.

ð Less maintenance work

6.0.1.0
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Subscription

function

Description Release

Configuring units Adds a group element (“unit”) that can easily reflect

complex configurations such as for company sites and

units. 

ð Easier configuration for companies with many sites

and/ or units 

ð Allows for a reduction of projects 

6.0.1.0

Access to

directory “users” 

Adds a group element (“users”) that can easily reflect

complex configurations for many users.

ð Less maintenance work

6.0.1.0

Selecting Creo

startkey when

starting a project

Provides a project with a choice from several Creo

startkeys (start command that opens Creo with a

defined license package). Users can start a project

with a default startkey or select another one when

opening a project in GENIUS TOOLS Starter App. 

ð Allows the reduction of projects 

7.0.0.0

Apps projects Creates projects that run on any other program.

Assigning a project directory and batch files is

possible.

ð GENIUS TOOLS Starter App can be made the

central access point for users.

7.0.0.0

Operating

satellites in

GENIUS TOOLS

Starter Service

Enables the connection of synchronization servers to

a main server and their automatic synchronization.

ð Faster connection of user computers to a

synchronized satellite

ð Reducing queries from network to main server

7.0.1.0
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Subscription

function

Description Release

Edit and compare

configuration

blocks

Release-dependent config.pro editor and graphic

comparison tool 

ð Quick overview, comparison and editing of project-

related configuration blocks (config_*.pro files)

7.0.1.0

Company-specific

project

collections 

Start projects can be put together in defined project

groups by the administrator. 

ð In many projects, these can be structured

according to your own requirements.  

7.0.2.0

Selectable project

options

Projects can be started with multiple, individually

defined configuration blocks, e. g.for license

extensions or additional programs.

8.0.0.0

Reproducing

organization

structure with

units and subunits

Subordinate units (subunits) can be created to

provide additional configuration levels for project

settings.

ð Better mapping for locations, subunits etc. and the

resulting complex project configurations

ð Allows for further reduction of projects

8.0.1.0

Combined project

options

Users can select a project option in GENIUS TOOLS

Starter App, which activates multiple configuration

options which are located in different directories and

configuration levels, e. g. for license extensions and

add-on applications.

ð Number of projects can be minimized

8.0.1.0

Edit config.pro

files in GENIUS

TOOLS Config

Editor

Creo configuration options can be edited faster with

auto-completion and color coding.

ð Easier comparison and editing of configuration

options, also in batch mode.

8.0.2.0
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Subscription

function

Description Release

Auto projects Settings for auto projects (e. g. Keyshot) can be

specified for the configuration levels standard, unit,

project and user. 

ð Company-specific configurations possible

9.0.0.0

Create and

migrate Creo

Elements/Direct

Modeling

projects 

For Creo Elements/Direct Modeling projects, settings

can be specified for the configuration levels standard,

unit, project and user, and project settings and data

packages can be added or migrated.

ð Integration of an additional CAD application

9.0.0.0

Create SolidWorks

projects

Projects for SolidWorks can be configured in the

layers standard, unit, project and user. Project settings

can be specified and data packages added.

ð Integration of an additional CAD application

9.0.1.0

Create Inventor

projects

Projects for Inventor can be configured in the layers

standard, unit, project and user. Project settings can

be specified and data packages added.

ð Integration of an additional CAD application

9.0.2.0

Create AutoCAD

projects

For the applications AutoCAD, AutoCAD Architecture

and AutoCAD Mechanical, projects can be created for

a specific release and be assigned project and data

directories.

ð Integration of an additional CAD application

9.0.2.0

Support of

AutoCAD LT

Projects can be created for AutoCAD LT 10.0.1.0
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Subscription

function

Description Release

Select alternative

authentication

Users can authenticate against a system other than

Windows. Windchill user data can be imported with

GENIUS TOOLS Project Configurator. For other

systems, e. g. SAP, a self-created file can be used.

ð Compatibility of Starter projects with other

authorization systems, e. g. Windchill

10.0.1.0

Unit-specific

visibility of

projects

The visibility of projects in GENIUS TOOLS Starter App

can be restricted to the selection of a specific unit for

users who are assigned to several units.

ð Use of units for project access

11.0.0.0

Install Creo

projects

Synchronize Creo Parametric setups to user

computers, from which they can be started manually

or automatically.

11.0.0.0

Warning: If you are using mixed licenses (perpetual and subscription) and configure

functionality that is limited to subscription licenses, the projects in GENIUS TOOLS

Starter App will no longer start if there is no subscription license available.

User can see whether projects include subscription functions  by consulting Data base

mode in the footer of GENIUS TOOLS Starter App.

For information on managing PTC license packages, please refer to Assigning Creo

licenses to projects.

Falsely activating a subscription function
When activating a subscription function, a backup copy of the configuration database

sut.db is created. Use this backup copy, if you want to undo an activation of any of the

above functions so you can work again with permanent licenses.

Procedure: 

1. On the installation computer, go to the backup directory: ..

\caddepot\<operatingenvironmentname>\configuration\database\BackupBeforeUpgra

de  

2. Copy the backup file sut.db from the BackupBeforeUpgrade folder.

3. Paste this file into the database directory.
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2  Basics

GENIUS TOOLS Starter allows users to launch projects from different applications, with

settings made centrally by the administrator. 

2.1  Important terms

The administration computer is a computer on which the administrative user has full

write access to the Caddepot directory in order to manage all data on the file system level.

It is the work station where GENIUS TOOLS Environment Administrator and GENIUS

TOOLS Project Configurator is used.

The user computer is the computer on which the end user of an application opens

configured projects with GENIUS TOOLS Starter App. The required applications must be

installed.

Caddepot is a directory on the installation computer that can contain any number of

operating environments. It is the source of synchronizing the local operating

environments on user computers, that is, the source for the local Cadpool directories. The

Caddepot directory must shared to be accessible for distributed work.

An operating environment is a directory in the Caddepot that contains all the data

required for working with the desktop application. This includes configuration data,

libraries, templates and additional applications. The operating environment also contains a

database with all configured projects. An operating environment can contain an arbitrary

number of projects.

If you work across a network, the directory for the operating environment is the Caddepot

on the administration computer and the Cadpool on the application computers.

The operating environments contains the software components GENIUS TOOLS Starter,

GENIUS TOOLS Starter App and GENIUS TOOLS Project Configurator of a defined version.

A Starter project combines specifications that are made in GENIUS TOOLS Project

Configurator, namely

– the program to be started,

– the required licenses, 

– the project directory and

– the associated data,

with configuration settings that can be made in the configuration levels using manually

created configuration blocks.
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It can be selected by users in GENIUS TOOLS Starter App and starts with locally available

data and the configuration settings defined centrally by the administrator. 

For the configuration of a project GENIUS TOOLS Starter reads out different component

files, the so-called configuration blocks. These files can be stored together with batch

files in different configuration levels.

2.2  Workflow and synchronization

Standard workflow: Working locally with synchronization
As of version 6.0 of Startup TOOLS, Creo users work with all data locally on their

computers. This ensures the fastest possible access to the data and also allows users to

work offline. 

Local data (the operating environments) are located in the Cadpool directory and are

synchronized from the central Caddepot directory at a configurable interval, i. e. the data

is copied from Caddepot to Cadpool.

Data synchronization means that local modifications to a configuration will be overwritten

in the synchronization process. Local changes that are to apply to all users – e. g. entries in

a configuration block (config_*.pro file) – must be copied manually to the Caddepot.

Synchronization must be suspended while you are making local changes. To pause

synchronization, open GENIUS TOOLS Project Configurator and select Pause

synchronization from the user menu .

Please note: For data synchronization to work, users need access to the Caddepot

directory. We recommended granting read access only, if you do not want users to

change settings by themselves.

The setup for working locally with synchronization is created by GENIUS TOOLS Starter by

default. If you start the GTS.exe file, it will open from the local Cadpool directory, or create

the Cadpool directory, if it does not exist yet (initial synchronization).

Network mode: Working without synchronization
You can work locally with the data in the Caddepot and without synchronization within a

computer network. To do so, the standard behavior of GENIUS TOOLS Starter has to be

changed and set to network mode, meaning that the file GTS.exe will be started in the

Caddepot directory.

To set access rights for network mode, open GENIUS TOOLS Project Configurator and set

Access rights > Function access > Select unit > Function access > Prevent switch to local

installation: Yes.
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Way of synchronization from Caddepot to Cadpool in GENIUS TOOLS Starter.

2.3  Operating environments

You can manage any number of operating environments with GENIUS TOOLS Starter. This

means that you can have both a test and a production environment installed and manage

environments for different clients.

Each operating environment contains a set of projects, the required data and the GENIUS

TOOLS Starter software. Each operating environment is fully independent of the others.

The directory for the operating environment contains configuration data, libraries and

templates, additional applications as well as the database for project-specific

configuration settings.

Changes to an operating environment and software updates are managed using GENIUS

TOOLS Environment Administrator. Hence, data in an operating environment – such as
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GENIUS TOOLS Starter software, additional applications like GENIUS TOOLS for Creo,

configuration files, or standard parts – cannot be changed by setup programs. This gives

the IT administrator better control over which data is actually being changed or updated

in an operating environment.

2.4  Directory structure

With GENIUS TOOLS Starter you can create projects for Creo Parametric as well as Creo

Elements/Direct Modeling, Inventor and SolidWorks. In order to be able to include data

for other CAD systems, the entire directory structure has been changed in version 9.0.0. 

Warning: Due to these new features in GENIUS TOOLS Starter, the directory structure

and the software are no longer backward compatible, which means that after updating

an operating environment to version 9.0.0.0 or newer, it is no longer possible to revert

to an older version. Read the chapter Important information in the News document

before updating.
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System directories of the first level
_Images contains images (JPEG, PNG, SVG) for the operating environment as well as the

start icon (ICO). See also Configuring the desktop link.

_Information contains messages to the users as text files. See also Sending messages to

the users.

application directory for applications of App projects, e.g. Model Processor.

auth_provider contains the executable file (authentication provider) Auth_Windchill.exe

for authenticating against Windchill.

configuration contains images and icons for units and projects, and the sut.db database

which stores the configuration settings of an operating environment.
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help contains the manuals and installation instructions for GENIUS TOOLS for Creo,

GENIUS TOOLS Starter and Startup TOOLS.

serveronly is only present in the Caddepot directory. It contains additional tools such as

GENIUS TOOLS Comma-to-dot or GENIUS TOOLS Purge. The subdirectory _ErrorLog

contains log files for errors.

software contains the GENIUS TOOLS Starter software.

tools contains the software component GENIUS TOOLS Config Editor and Requirement

Check, a tool which returns a log file with a list of all available applications.

userdata contains user-defined settings, e. g., mapkeys and user images. In contrast to

the directory in configuration/Users, this directory can be managed by the user themselves.

See also User-driven configuration.

The following application-specific directories are created:

auto_cad AutoCAD, AutoCAD Architecture, AutoCAD LT und AutoCAD Mechanical

ced_drafting Creo Elements/Direct Drafting

creo_view Creo View

elements_direct Creo Elements/Direct Modeling

geomagic_design_x Geomagic Design X

inventor Inventor

key_vr KeyVR

keyshot contains all data and configurations for Keyshot.

mathcad Mathcad

parametric contains data packages, standard projects and add-on applications for Creo

Parametric.

schematics Creo Schematics

solid_works SolidWorks

Directories of the second level for the various applications
Each of the above listed application-specific directories has three sub-directories for data,

configuration settings and add-on applications.

apps contains all additional applications.

– For Creo Parametric: the GENIUS TOOLS for Creo products Library and/or Parameter

(gtfc) and the freeware tool GENIUS TOOLS UI File Loader (ui).

– It is represented by the variable GTS_APPS_DIR.
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configuration contains configuration settings for system-wide standards, units, projects,

users as well as further directories.

–  For Creo Parametric: gt_resource_folder.

– It is represented by the variable GTS_CONFIGURATION_DIR.

data contains all data packages (subdirectories) available in a project, e.g., libraries,

materials, ModelCheck configuration files etc.

– A subdirectory of data is represented by the variable GTS_DATA.

install contains all data and setup files for installing Creo Parametric on user computers.
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3  Starter projects

A Starter project combines specifications that are made in GENIUS TOOLS Project

Configurator, namely

– the program to be started,

– the required licenses, 

– the project directory and

– the associated data,

with configuration settings that can be made in the configuration levels using manually

created configuration blocks.

It can be selected by users in GENIUS TOOLS Starter App and starts with locally available

data and the configuration settings defined centrally by the administrator. 

An administrator can thus make GENIUS TOOLS Starter App the central starting point at

work for users.

The setup of a Starter project requires object data, which are located in the data directory,

as well as configuration blocks, which can be located in the configuration directories

standard, units, projects and users. The separation of the object data from the

configuration data and additional applications ensures that objects of an operating

environment can be used for several projects.

A Starter project can be created with the following components:

– start variables (supported by GENIUS TOOLS Starter)

– environment variables (GTS)

– configuration blocks (GTS)

– previously started programs (defined by batch files)

– Windows registry (GTS)

– settings (GENIUS TOOLS Project Configurator)

for units and individual projects:

· servers

· licenses

· language and license key (as project options)

and additionally for users:

· access rights

· visibility and presentation of projects



24GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

Starter projects

Structure of a  Starter project set up with standard settings and project settings

Starter projects can be created for all applications. Each project can be assigned a project

directory and a data directory. The first, general steps are described in the General

procedure chapter.

The license to start a CAD application / Starter Core license is returned after 120 minutes

of runtime, unless the CAD application is closed before. After this runtime, the CAD starter

license is free again and can be used by the next user.

For CAD applications, you can additionally define startup behavior, license server and

environment variables. Accordingly, the settings for these applications are more in-depth

and are described in the respective chapters: 

– AutoCAD
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– Creo Elements/Direct Modeling

– Creo Parametric

– Inventor

– SolidWorks

3.1  Data packages

The directory data is the system directory of an application, under which the files related

to an operating environment can be found. All object data are stored in the subdirectories,

the data packages:

<GTS-working-environment>\<application>\data\<data-package>

For example, for Creo Parametric: <GTS_ROOT_DIR>\parametric\data\sut_creo9.

Please note: Data packages are subdirectories in the system directory data of an

application.

A reference to a data directory from a configuration block is made with the variable
$GTS_DATA.

Hint: If possible, always work with variables.

For Creo Parametric, object data is provided with the Startup TOOLS product package, see

Creo data packages.

3.2  Configuration blocks

Most software programs do not allow to make specific settings for different user groups,

projects and locations. To provide this possibility, GENIUS TOOLS Starter creates a specific

configuration from different configuration component files, the configuration blocks.

A configuration block

– is a text file that contains one or more configuration options, i. e. settings for the

application,

– must be given an application-specific name (see table below),

– is one of many configuration files that are read by GENIUS TOOLS Starter to create the

configuration of a Starter project,

– can contain conditions, that define whether to include them into the configuration

(Conditional configuration blocks).
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Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,

configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks using the add-on program

GENIUS TOOLS Config Editor, which provides color highlighting, auto-completion and

error messages.

The following configuration blocks can be used for the respective applications.

Configuration block Content Example

Creo Parametric

1 config_*.pro

(alos: Config-

Datei)

All settings (configuration

options) for running the

application

config_sut_de_c6p_dir_file.pro

config_c5p_mapkeys.pro

2 config_*.sup Settings that cannot be

modified by the user

config_design_de.sup

SolidWorks

3 config_*.sldreg All settings,

Embedding of additional

applications (add-ins)

config_addin_compose.sldreg

Inventor

4 config_*.xml General settings config_dir_file.xml

5 ui_*.xml Settings for the user interface ui_customization.xml

6 *.addin Embedding of additional

applications (add-ins)

AdditiveMFG.inventor.addin

3.3  Batch files

Batch files are used to execute configuration commands at different times. 

If you want to execute additional instructions before an application is started or when

changing to another project, you can place unit or project-specific batch files in the

corresponding directories of the configuration layer. You can also use batch files to set

additional environment variables or copy additional data.
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The batch files names have to start with one of the following prefixes. 

Types of batch files

Prefix Start time Comment

prestart_ Started before the

configuration is created.

When a project is started, GENIUS TOOLS

Starter calls the prestart_ batch files before

the config.pro files for the project are

assembled.

poststart_ Started after the

application has been

started.

This type of batch file can be used for

accessing the running Creo session with the

help of additional programs.

start_ Started before the

application is started.

When a project is started, GENIUS TOOLS

Starter assembles the config.pro files for the

project, then calls the start_ batch files.

stop_ Started after the

application is closed.

Please note that Enable stop batches has to

be set to Yes in the Project Configurator

under Configuration > (Select unit) > Creo

Settings > Startup Settings.

For Creo Elements/Direct Modeling, only start batch files can be executed.

Warning: What if Creo Parametric does not start? The most common cause is that a

batch file causes the Creo call to stop. If there are start issues, first check which batch

file could cause the Creo call to stop.

Batch files are subject to the same call hierarchy as configuration files. Unlike configuration

files, however, batch files cannot be located in the PDM directory.

User or computer-specific batch files
GENIUS TOOLS Starter can call batch files depending on which user or computer starts a

project. These batch files and their call sequence do not differ from the general batch

files. 

Use the following prefixes and be careful not to use special characters.
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Batch file Prefix (without the

characters <>)

Beispiel

User-dependent U_<WindowsUSername

>_

U_MUELLER_stop_copy_workspace.bat

Computer-

dependent

C_<WindowsComputern

ame>_

C_CAD13_start_map_drive.bat

Please note: User and computer groups are converted into units when updating to

version 11.0.0.0 and later. Configuration blocks that were created for user or computer

groups (UG_<nameofusergroup>_config.pro or CG_<nameofcomputergroup>_config.pro),

will be migrated into a new unit directory of the same name.

3.4  PDM directories

The PDM directory will be included into the call hierarchy for files when you are working

with a PDM system, e. g. Windchill. It contains additional settings that are defined on

starting the PDM system, as well as commented-out settings for Starter projects. Settings

that are commented-out are stored in the file exclude.txt.

As soon as the PDM system is activated, the PDM directories within all configuration

directories relevant to a project will also be included into the configuration call hierarchy.

All configuration blocks located in the PDM directories will be used.

Please note: The PDM directories were named SEARCHMODE until version 9.0.1.

3.5  Configuration concept

All data for the configuration of a starter project are located in an operating environment

in the system directory configuration of the respective application. When a project is

started, all configuration and batch files from the subdirectories standard, units, projects

and users are taken into account, i. e. from the configuration layers.

3.5.1  Configuration layers

The task of GENIUS TOOLS Starter is to perform configuration settings on different

configuration levels. These levels are: 

– Standard (global settings)

– Units (departments / locations)
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– Projects

– Users

All configuration blocks and batch files for an application are stored in these configuration

levels and processed according to the call sequence for files, see next chapter. If you work

with subunits, the configuration of a starter project is additionally determined by the

organizational structure. 

Directories of the configuration layers
The following directories are available for the configuration layers. They are located in the

system directory configuration.

1. Standard directory:

<GTS-OperatingEnvironment>\<Application>\configuration\standard

2. Unit directory / directories: subdirectory /subdirectories of units

<GTS-OperatingEnvironment>\<Application>\configuration\units\%

GTS_UNIT_DIR_NAME%

(The variable contains the name of the last selected unit).

3. Project directory: subdirectory of projects

<GTS-OperatingEnvironment>\<Application>\configuration\projects\%

GTS_UNIT_DIR_NAME%

4. Users directory: subdirectory of users

<GTS-OperatingEnvironment>\<Application>\configuration\users\%USERNAME%

Please note: In order to work with data for other CAD systems in the future, the entire

directory structure has been changed in version 9.0.0 of GENIUS TOOLS Starter. Consult

the comparison of the old and new directory structure. The adjustment of the paths is

done automatically during an update. 
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1. Standard directory

Configuration options in the directory standard always apply as long as they are not

overwritten by specifications in subordinate folders.

2. Unit directory / directories

The directory units contains the individual unit directories, e. g.

<GTS_ROOT_DIR>\parametric\configuration\units\manufacturing. 

All unit directories are located on the same level, including those of subordinate units

(subunits). Subunits are created by the arrangement in the organization tree.

3. Project directory

The directory projects contains the  individual project directories, i. e. subdirectories with

project-specific information, e. g. <GTS-

OperatingEnvironment>\parametric\configuration\projects\project_creo8p_de.

You can select a project-specific directory in the settings for a project. Without this

specification, the directory will be inherited from the standard or unit settings.

Please note: Unit and project directories are not generated by creating a unit or

project in GENIUS TOOLS Project Configurator, but must be created manually.

4. Users directory

The directory users contains subdirectories for all users, e.g.

<GTS_ROOT_DIR>\parametric\configuration\users\cfoster. 

When synchronizing from Caddepot to Cadpool only the directory for the specific user is

copied from the Users directory.

3.5.2  Call sequence for files

Configuration blocks (config files) and batch files can be located in these configuration

directories: standard directory for global system settings, unit directories, project

directories and user directories for user-defined settings. The files are processed in the

following sequence by GENIUS TOOLS Starter. A configuration block will only be read if it

falls into the selection made by the user for a unit and/or a project.

1. standard (global directory)

1.1. standard > PDM, if a PDM system (e. g. Windchill) is activated

2. units (individual subdirectories)

2.1. units > PDM, if a PDM system is activated

3. projects (individual subdirectories)

3.1. projects > PDM, if a PDM system is activated
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4. users (individual subdirectories, named by Windows / Windchill user name)

4.1. users > PDM, if a PDM system is activated

5. userdata (configurable)

Please note: The directories units and users can only be used with a subscription license.

The directory PDM was named SEARCHMODE until version 9.0.1.0.

The following applies to all files:

– A file is only read if it is in the selection made by the user for a unit and project.

The following applies to Batch files, IPJ files and Creo UI files:

– The first file found is read.

The following applies to configuration blocks (Config_*.pro files):

– All files are read. The last entry of a configuration option is the valid value. 

– If you work with subordinate units (subunits), the configuration blocks of a unit can be

overwritten by another unit. The sequence depends on the organization tree, see 

Mapping an organization.

– The PDM directory must be activated extra, see PDM directories.

Call sequence of configuration blocks and batch files for a Starter project

The processing order of the files significantly influences the configuration result for a

starter project. In addition, the settings in GENIUS TOOLS Project Configurator determine

the configuration of the project, see next chapter.

Example of a project configuration: Creo Parametric
The following graphic illustrates the call hierarchy for configuration blocks and batch files,

if user C.Forest chooses the unit UK and starts Project 1. The value of the last configuration

block is the valid value.
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The following configuration blocks are used if Windchill is not used. If values are listed

multiple times in several blocks, the value in the last-mentioned file is taken over, in the

example from the file <GTS-

Arbeitsumgebung>\configuration\users\CForest\config_mapkey.pro.

<GTS-Arbeitsumgebung>\configuration\standard\config_mapkey.pro

<GTS-Arbeitsumgebung>\configuration\standard\start_.bat

<GTS-Arbeitsumgebung>\configuration\units\UK\config_unit.pro

<GTS-Arbeitsumgebung>\configuration\units\UK\config_mapkey.pro

<GTS-Arbeitsumgebung>\configuration\units\UK\*.bat

<GTS-Arbeitsumgebung>\configuration\projects\Project1\stop_.bat

<GTS-Arbeitsumgebung>\configuration\projects\Project1\config_sut_de_c6p_dir.pro

<GTS-

Arbeitsumgebung>\configuration\projects\Project1\creo_paramatric_customization.ui

<GTS-Arbeitsumgebung>\configuration\users\CForest\config_mapkey.pro

<GTS-Arbeitsumgebung>\configuration\users\CForest\config_customization.ui

<GTS-Arbeitsumgebung>\configuration\users\CForest\start_*.bat

<GTS-Arbeitsumgebung>\userdata\CMeier\config_user.pro

<GTS-Arbeitsumgebung>\userdata\CMeier\config_user.ui

For the selected project 1, the project settings made in GENIUS TOOLS Project

Configurator also apply, e. g. to the license servers, startkeys or environment variables.
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3.5.3  Call sequence for settings

Settings in GENIUS TOOLS Project Configurator – e. g. for license servers, synchronization

behavior or additional environment variables – are made for the configuration layers

standard, units and projects.

As always, the last setting overwrites the settings of the above configuration levels.

The following sequence for settings in GENIUS TOOLS Project Configurator applies: 

1. Global settings: Standard 

2. Unit

3. Subunit(s): If you work with subunits, their hierarchy depends on the organizational

structure, see Call hierarchy for subunits.

  The settings for units and subunits are made in the menu page Configuration.

4. Project

  The settings for projects are made in the menu page Projects.

Call sequence for the settings made in GENIUS TOOLS Project Configurator

Please note: The configuration logic has been changed with the introduction of Units

as of version 6.0.1.

User and computer groups have been abolished in version 11.0.0.0 and are now

available as units. 

3.6  General procedure

There are two types of starter projects, general and CAD specific. The created starter

projects are displayed to the users in GENIUS TOOLS Starter App. 

To configure a general starter project, you can follow the procedure below. The additional

options that apply to CAD-specific projects are described in the respective chapters.
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BASIC PROCEDURES

1. Set up operating environment

Questions: How should the operating environment be set up?  

Procedure: Create operating environment with GENIUS TOOLS Environment Administrator

and define license and synchronization server(s).

2. Define organizational structure

Questions: How complex is the structure of your company? Will you be working with

subordinate business units, e. g. Construction as a subunit of Italy?

Procedure: Map the organizational structure in GENIUS TOOLS Project Configurator.

CROSS-PROJECT PROCEDURES

3. Create configuration blocks

Questions: Which configuration options should be predefined for users on a starter

project? Which configuration settings, mapkeys and project options should apply

company-wide and which should apply to a unit or specific project?

Procedure: Write application-specific configuration blocks (config files) and place them in

the appropriate directories of the configuration layers.

Hint: We recommend defining settings and configuration options in the highest

possible configuration level, i.e. as few as necessary for individual projects. For example,

individual projects may contain the version-specific settings. 

4. Set environment variables

Questions: Do the various configuration layers require different environment variables?

Procedure: Environment variables can be assigned and defined in GENIUS TOOLS Project

Configurator for each configuration layer.

5. Include additional programs

Questions: Which other programs should be started with the application?

Procedure: Make specifications in batch files.

6. Define global settings and unit settings

Questions: Which license server(s), which synchronization settings should apply? How

should projects be displayed in GENIUS TOOLS Starter App?

Procedure: Define global settings as well as settings for units in GENIUS TOOLS Project

Configurator.

7. Display project information for users

Questions: Which information about the project should be available to users?

Procedure: Information displayed in GENIUS TOOLS Starter App can be restricted, see

chapter Granting function access rights.
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PROJECT SPECIFIC PROCESSES

8. Create a project

Questions: Which project and data directory should be assigned to the project?

Procedure: Define project settings in GENIUS TOOLS Project Configurator.

9. Define language or make it available for selection

Questions: Should users be able to choose the language of the application? 

Procedure: Set language in GENIUS TOOLS Project Configurator or create as project

option.

10. Display project

Questions: Should the project be accessible for all or certain users?

Procedure: Restrict access for defined user groups (roles), see chapter Restricting project

access. 

CAD-SPECIFIC PROCESSES

Projects of the CAD applications can furthermore be provided with:

– additional project options, e. g. for license extensions, add-ins, see chapter Making use

of project options,

– additional information in the tabs of GENIUS TOOLS Starter App, e. g. on the

configuration blocks used, see Customizing information panes,

– the possibility to borrow licenses, see chapter  Displaying license information.

Creo Parametric projects can be used to assign license packages to individual workstations

or users, see chapter Assigning Creo licenses to a project.

3.7  Conditional configuration blocks

Configuration blocks are read in different ways. There are basic and conditional

configuration blocks. Conditional configuration blocks are used to create combined

project options and to work with units without unit folders.

Basic configuration blocks: without tag ID

The configuration block (config_*.pro file) is given a meaningful name and stored in one of

the directories Standard, Unit, Project, User. If the directory is valid for the selected project,

the Config.pro module is read out. 

– Control: Call hierarchy of the directories determines which configuration block is used

for the project, see Call hierarchy for configuration files. 

– Notation: config_*.pro, e.g.: config_1_lic_sim_live.pro
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Conditional configuration blocks: with tag ID

A tag ID is a textual identifier that is recognized by GENIUS TOOLS Starter. By adding a tag

ID to a configuration block, its validity can be linked to conditions.

– Notation: config_*.TAGID.pro, e. g. config_mbd.europe.berlin.mbd.pro

GENIUS TOOLS Starter distinguishes between unit tag IDs and free tag IDs.

Unit tag ID
A unit tag ID is an additional textual marking in a configuration block that defines a unit

and limits the validity of the block to it. This means a conditional configuration blocks with

a unit tag ID is activated by the selection of a unit in GENIUS TOOLS Starter App.

Unit tag IDs can be used

– as name of the unit folder

– as name of an image file: to assign images to a unit

– in configuration blocks: to restrict configuration options to a unit, see Using unit tag IDs.

Free tag ID 
A free tag ID is an additional textual marking in a configuration block that defines a

combined project option and limits the validity of the block to it, e. g. config_lic.mbd.pro.

That means users have to activate the project option – here: mbd – in GENIUS TOOLS

Starter App in order for the configuration block to be read at project start. The first

configuration block with the free tag ID creates a checkbox.

Free tag IDs can be choosen freely, but cannot be assigned to a unit.
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4  GENIUS TOOLS Environment Administrator

GENIUS TOOLS Environment Administrator is an administrative tool for managing

operating environments. Use GENIUS TOOLS Environment Administrator to handle the

following tasks.

1. Create operating environments  

2. Add components to an existing operating environment

– project directories (directories with config.pro and other project-specific files)

– data directories

– additional applications

3. Update operating environments (Software update for GENIUS TOOLS Starter App and

GENIUS TOOLS for Creo)

4. Modify settings for an operating environment for

– license servers

– synchronization servers (Caddepot, Cadpool)

The next chapters describe each function in detail.

4.1  User interface

GENIUS TOOLS Environment Administrator must be started with write access to the

caddepot directory.

Warning: GENIUS TOOLS Environment Administrator can only be used with work

environments and Startup TOOLS software that have the same or older versions.

If you open the software from an administration computer which does not have an

AppData directory, you must start GENIUS TOOLS Environment Administrator with the

command -gts:appdata=%TEMP%.
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When you select a function on the GENIUS TOOLS Environment Administrator start page,

a wizard with one or more dialog pages is displayed. The inline help on the right side

supports each task of the workflow.

Dialog for completing three tasks and integrated help

First, you always need to select the Caddepot. Then, the option list shows the operating

environments that are available for selection.

All changes in Caddepot are stored in a database that cannot be edited by multiple users

at the same time. The following hint message means that another user is working either in

GENIUS TOOLS Project Configurator or in GENIUS TOOLS Environment Administrator.
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Notification that the selected operating 

environment is currently modified by another user

User menu
To access general settings for GENIUS TOOLS Environment Administrator, click on the

gear symbol  in the header.

Language: user interface language

You can switch the user interface language between English, German and French at any

time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set

to German. For all other locale settings, the software first starts with an English user

interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

Help (F1)

Opens the installation manual for GENIUS TOOLS Starter. The help corresponds to the

document GENIUS TOOLS Starter Installation.pdf in the directory help of an operating

environment.

Reference card

Opens a reference card for a quick overview of all functions.

Info (F12)

Shows the current GENIUS TOOLS Starter version. 

Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the

program window.
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4.2  Creating an operating environment

GENIUS TOOLS Environment Administrator lets you create different operating

environments with just a few mouse clicks.

The function Create creates an empty, new operating environment. This contains the

directory structure, the GENIUS TOOLS Starter software GTS.exeand an empty database,

sut.db. All settings defined in GENIUS TOOLS Project Configurator are stored in this

database file, which is located in the <OperatingEnvironment>\configuration\database

directory.

If you have purchased the Startup TOOLS product package, the add-on application

GENIUS TOOLS for Creo is automatically installed in the

<OperatingEnvironment>\parametric\apps directory when you create a new operating

environment. This provides you with an operating environment with standardized

templates (start object templates, project-specific libraries, drawing frames, ModelCheck

configurations), interface and function configurations for Creo (config.pro, config.sup

config.ui) and many additional functions for Creo (toolkit applications).

You can add data packages and standard start projects at any time thereafter via the Add

Components function.
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Click the Create symbol on the start page to start create a new operating environment.

Step 1: Define operating environment
GENIUS TOOLS Environment Administrator will find the Caddepot and Installdepot

directories automatically if the software is started from a default installation setup.
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Verify the paths for the Caddepot (1) and

Installdepot (3) directories.

Enter a name for the operating environment

(2). The name is used to create a directory of

the same name in the Caddepot and setting

up the directory structure there.

Select a software version (4) from the

Installdepot.

Click Next.

Please note: You can change the name of an operating environment any time by

renaming its directory.

Step 2: Configuring license and synchronization server
The users need to connect to GENIUS TOOLS License Manager in order to use a full

version of GENIUS TOOLS Starter App.

Data synchronization allows you to keep all data up-to-date on the local application

computers and give users fast access to any changes. 

The synchronization process is adapted to Creo in that it will not update toolkit

applications as long as Creo is running. For this, the toolkit applications, such as GENIUS

TOOLS for Creo, have to be located in the apps directory of Creo Parametric.

Please note: If you do not configure the synchronization settings, Environment

Administrator will create a local operating environment without synchronization.

Under Source (1), enter the name of the

server that GENIUS TOOLS Starter App

should access to get licenses.

Under Synchronization server settings, the

server name (2) that has been entered at

setup is displayed.

Enter the path to the Caddepot directory (3)

of the  synchronization server using UNC

paths (\\GTSServer\caddepot), environment

variables (%GTS_SERVER_NAME%) or a mixed

form (\\%GTS_SERVER_NAME%\caddepot).

Under Targt directory (4) enter the location

where the Cadpool directory should be

located on the application computers. If the
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Cadpool directory is not present yet, GENIUS

TOOLS Starter will try to create it. It will also

create a subdirectory named for the

operating environment. You can use

absolute paths or environment variables that

are available on the application computers.

Please note: GENIUS TOOLS Starter App will add the name of the current operating

environment automatically. This makes it possible to copy operating environments, for

example to create test environments quickly without having to change the settings. Also,

operating environments can be renamed without having to change the settings.

Enter the synchronization interval (5) in minutes. The synchronization interval defines how

often GENIUS TOOLS Starter App should synchronize the data from the central Caddepot.

A synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is

changed and on how many GENIUS TOOLS Starter Apps are running at the same time. If

there are many changes to the data, the interval should be shorter. If many users are

accessing the Caddepot, the interval could be longer to avoid too much network load due

to frequent synchronizations.

Click on Create.

4.3  Adding components to an operating environment

If you want to add components, you first have to install them into the Installdepot

directory from the data setups, see Data setup. With the Add components function you

can then add the following components to an existing operating environment.

For Creo Elements/Direct Modeling:

– TSPRO environment

– SOLIDPOWERPARTS

For Creo Parametric:

– data directories (data packages)

– project directories (directories with configuration blocks and other files)

– Toolkit applications (GENIUS TOOLS for Creo, UI)

Data packages
Data packages are subdirectories of the data directory, e. g. for Creo Parametric:

<mainserver>\GTSTARTER\installdepot\11.0.0.0\parametric\data\sut_creo11.
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If you add data packages to an operating environment, you will get an operating

environment with standardized templates (start object templates, project-related libraries,

drawing frames, ModelCheck configurations), interface and function configurations for

Creo (config.pro, config.sup, config.ui) as well as many add-on functions for Creo (toolkit

applications). 

Click the Add Components symbol on the start page to start the installation assistant.
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Step 1: Select operating environment
First select the operating environment (2)

you want to configure from the Caddepot

(1).

Then select the software version (4) to use

from the Installdepot (3). Select a software

version that has the required components

installed.

Step 2: Add CAD applications
Here, project components that have been installed in the install depot are selected.

Select the CAD application to which you wish

to add components.

For Creo Elements/Direct:

– TSPRO-Umgebung

– SOLIDPOWERPARTS

For Creo Parametric:

1. Ddata packages

2. projects (directories for standard start

projects)

3. toolkit applications (gtfc, ui)

Components for Creo Parametric
Data packages and toolkit applications are added separately.

Projects can be added together with the data package subsequently as well is in their own.

1. Add data packages and create standard projects

All data directories for Creo Parametric from the previously selected software version in

the installdepot are displayed here, e.g. D:

\GTSTARTER\installdepot\9.0.0\parametric\data.

Select a data package. Data packages in gray are directories that have already been

copied to the caddepot once. 
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Enter a target name under which it should be copied in the directory data in the

caddepot. (Caddepot\<operatingenvironment>\parametric\data.) 

The target name can be overwritten. 

When selecting a data package, you can in the second step  create standard projects

whose settings should be adjusted afterwards in the GENIUS TOOLS Project

Configurator. Here, the supplied standard projects – one standard project per Creo

version with and without Windchill – are copied from the project directory

(Caddepot\<Arbeitsumgebung>\parametric\configuration\projects) under a new name

(target project name). 

If a project is grayed out, it means that it has already been copied once. It can be copied

again under new name.

The target project name is the name of the folder in the project directory and at the

same time the name of the project in GENIUS TOOLS Project Configurator. The display

name is the name that appears in GENIUS TOOLS Starter App. It can be changed in

GENIUS TOOLS Project Configurator. 

2. Create standard start projects

If the data packages have already been installed, standard start projects can be created

here as in the previous point.
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3. Toolkit applications

Select the toolkit application you wish to add. 

– GENIUS TOOLS for Creo: Additional functions for Creo Parametric included in the

products GENIUS TOOLS Library and GENIUS TOOLS Parameter.

– ui: Application that allows reloading multiple Customization.ui files.

If it is not possible to tick an application, it means that it already exists in the

application-specific apps directory. The application cannot be created again.

Please note: The toolkit application GENIUS TOOLS for Creo will be automatically

installed to the parametric\apps directory when creating a new operating

environment, if you have purchased the Startup TOOLS product package.

After clicking Add all specified components are added to the operating environment.

4. Customize data packages

When using Startup TOOLS for the first time, we recommend adapting the supplied data

directory (“data package”). All company-specific data should be adapted, such as

– Startup parts,

– material files,

– drawing frames.

Data directories should be created version-neutral.

If data files are accidentally deleted, they can be copied back from the install depot at any

time, i. e. no backup copies need to be made.

Hint: If possible, always work with variables. A reference to a data directory from a

configuration block is made via the variable $GTS_DATA.

Once a data package has been adapted to company-specific requirements, it must be

manually adapted to newer software versions, see Updating Creo data packages and

resource folder.
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4.4  Updating software

All software setups in GENIUS TOOLS Starter unpack their data to the Installdepot

directory. You can use the Update function of GENIUS TOOLS Environment Administrator

to update the software for GENIUS TOOLS for Creo and GENIUS TOOLS Starter App in the

operating environments. This two-step process allows you to make targeted adjustments

to individual operating environments. You can upgrade or downgrade to any version that

is available in the Installdepot.

If you have configured synchronization, the configuration for the software update will be

made in the background without the users having to stop Creo or GENIUS TOOLS Starter

App. The new software version will then be used on the application computer after the

next synchronization.

If you update GENIUS TOOLS for Creo, the synchronization on the application computers

will only be run after Creo has been closed.

Warning: If you are using network mode, make sure that all users have closed GENIUS

TOOLS Starter App and Creo, as the software cannot be updated otherwise.
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In GENIUS TOOLS Environment Administrator click the Update button to start the

installation assistant.
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Software update
First, select from the Caddepot (1) the

operating environment (2) you want to

configure (1).

Then select from the Installdepot (3) the new

software version (4) you want to install.

Under Update settings (5) you can select the

components to update:

– the software GENIUS TOOLS Starter (component of the Startup TOOLS product

package),

– the software of the add-on application GENIUS TOOLS for Creo (component of the

Startup TOOLS product package, also available as GENIUS TOOLS Parameter and

GENIUS TOOLS Library),

Please note: An update of GENIUS TOOLS for Creo does not update the resource folder

(gt_resource_folder). This has to be updated manually, see chapter Update process.

– the tools directory, which contains GENIUS TOOLS Config Editor and Requirement

Check, as well as

– several freeware products which are located in the Caddepot in the serveronly directory

under tools. (GENIUS TOOLS Comma To Dot, GENIUS TOOLS Flexnet Watcher, GENIUS

TOOLS Material Browser, GENIUS TOOLS Purge, FreeCommander, XML-Import and

others). 

Under Migration settings (6), you can set whether access restrictions for projects are

transferred when updating to version 11.0.0.0 and newer.

Result: The update process writes a new software directory for GENIUS TOOLS Starter and

updates the database. For GENIUS TOOLS for Creo, the gtfc directory under apps is re-

written. The main.cfg file remains untouched. The directories tools and serveronly\tools are

copied from the Installdepot to the Caddepot.



51GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Environment Administrator

4.5  Modifying settings

Some settings for operating environments can only be changed using the Modify wizard in

GENIUS TOOLS Environment Administrator. The most important one of these setting is the

Caddepot path. You can also edit synchronization and licensing settings.

Please note: GENIUS TOOLS Environment Administrator only change the standard

settings, that is, the settings for the unit Standard. If you have made individual settings

for a unit or subunit, you have to change these settings using GENIUS TOOLS Project

Configurator (Configuration > Select unit > Synchronization)

In GENIUS TOOLS Environment Administrator click the Modify button to start the

installation assistant.

Step 1: Change license server settings
First, select from the Caddepot (1) the operating environment (2) you want to modify.

Then enter the license server settings (3). You

can also deactivate the license server (4).

An inactive license server will not be used by

GENIUS TOOLS Starter App. This means that

you can only use home-use or educational

Creo licenses.
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Step 2: Change synchronization settings
The server path is always given down to the

Caddepot directory (1).

When Checksum verification (2) is active, a

checksum for each copied file is calculated

and compared to the checksum of the file on

the server. If the checksum differs, the server

is queried for the file again. If checksum

verification is not active, the files will just be

copied.

Warning: Activating checksum verification often allows significantly shorter

synchronization times.

If you have moved your synchronization server, proceed as follows:

1. Create a new Caddepot and adapt the synchronization server settings in the new

operating environment there.

2. Test the new operating environment to make sure that the configuration settings are

correct and the synchronization works.

3. In the old operating environment, switch the synchronization server to the new

Caddepot

When GENIUS TOOLS Starter App is restarted, it switches to the new Caddepot and

synchronizes the data from there.

Warning: Please be extremely careful when changing the Caddepot directory in an

operating environment that is already in use on multiple application computers. Wrong

settings can lead to the application computers not synchronizing. However, it is still

possible to change the Caddepot directory when you move a server. Create a new

Caddepot, then set the synchronization path in the old operating environment to the

new Caddepot. The application computers will switch over accordingly.

Step 3: Edit settings for the application computers
You can activate or deactivate synchronization between the central Caddepot and the

application computer Cadpool directories (1).
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Warning: If you deactivate synchronization, you permanently separate the application

computers from the Caddepot. Any changes you make to the central synchronization

settings or the operating environment will not be transferred to the application

computers!

Under Target directory (2), specify the

location of the Cadpool directories on the

application computers, where the local copy

of the operating environment is stored. If the

Cadpool directory cannot be found, GENIUS

TOOLS Starter will try to create it. A

subdirectory named after the operating

environment will also be created. You can

use absolute paths such as C:\Cadpool, or

environment variables that are available on

the application computers, e.g., %

GTS_SYNC_DESTINATION%.

Under Synchronization interval (3), specify an interval in minutes. The synchronization

interval determines how often GENIUS TOOLS Starter App will synchronize the data. A

synchronization is also run automatically when GENIUS TOOLS Starter App is started.

The best setting for the synchronization interval depends on how often the data is

changed and on how many GENIUS TOOLS Starter Apps are running at the same time. If

there are many changes to the data, the interval should be shorter. If many users are

accessing the Caddepot, the interval could be longer to avoid too much network load due

to frequent synchronizations.

If Start client with Windows (4) is activated, GENIUS TOOLS Starter App will be started

automatically when the operating system is started on the application computers.
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5  GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator is the central application for configuring operating

environments. Use GENIUS TOOLS Project Configurator for managing all project and

operating environment settings.

A Starter project combines specifications that are made in GENIUS TOOLS Project

Configurator, namely

– the program to be started,

– the required licenses, 

– the project directory and

– the associated data,

with configuration settings that can be made in the configuration levels using manually

created configuration blocks.

It can be selected by users in GENIUS TOOLS Starter App and starts with locally available

data and the configuration settings defined centrally by the administrator. 

Project Configurator manages project information by modifying the central sut.db

database.

..\caddepot\<operatingenvironment>\configuration\database.

The project configuration for each operating environment can be synchronized to the

Creo application computers. The storage location is:

..\cadpool\<operatingenvironment>\configuration\database.

Please note: Make sure that Project Configurator has write access to the central

database in the Caddepot so that it can store configuration settings.

Project Configurator is not synchronized immediately. When you make changes in Project

Configurator, you have to save them to the database before they become available to

GENIUS TOOLS Starter App.

5.1  First steps

5.1.1  Starting GENIUS TOOLS Project Configurator

GENIUS TOOLS Project Configurator can be started from the installation computer as well

as from any synchronized application computer. On the installation computer, Project

Configurator is located in the Caddepot directory, on the application computers it is
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located in the Cadpool directory. In both cases, Project Configurator accesses the same

central database in the Caddepot. See also the chapter with Important terms.

Starting Project Configurator on the installation computer
There are two ways to start Project Configurator: 

1. Open GENIUS TOOLS Starter App via

<caddepot>\<OperatingEnvironment>\software\GTS.exe. In the user menu , select

Project Configurator or press F8.

User menu in GENIUS TOOLS Starter App

2. Start Project Configurator directly using a start parameter 

<caddepot>\<OperatingEnvironment>\software\GTS.exe -gts:admin

Starting Project Configurator on an application computer
There are two ways to start Project Configurator: 

1. Open GENIUS TOOLS Starter app via <caddepot>\<environment>\software\GTS.exe. In

the user menu  select Project Configurator or press F8.

2. Start Project Configurator directly using a start parameter

<cadpool>\<OperatingEnvironment>\software\GTS.exe -gts:admin 

The item Project Configurator in the user menu can be hidden for the users (see Assigning

function access rights) so they cannot access Project Configurator from the user interface.

The start parameter -gts:admin cannot override any access restriction for the Project

Configurator.

Login
If a system other than Windows is selected for authentication, a window for entering login

information appears, e. g. Windchill. See chapter Authentication.

Read-only mode
To avoid that several users can make changes to the database of GENIUS TOOLS Project

Configurator the application can now only be used by one person. All others receive a

note about the user who has accessed GENIUS TOOLS Project Configurator and can open

the application in read-only mode.
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When opening GENIUS TOOLS Project Configurator, a lock file is written to the database

directory (Caddepot\<operatingenvironment name>\configuration\database), which is

deleted again when closing the application.

Please note: Make sure to close GENIUS TOOLS Project Configurator with the exit

function to delete the lock file.

If you cannot open GENIUS TOOLS Project Configurator in write mode when no other user

is working with it, delete the LOCK file.

5.2  User interface and navigation

GENIUS TOOLS Project Configurator opens on the Configuration page of the main menu.

Here, you can manage global settings or settings specific to units. 

The main menu (1) is located on the left side of the Project Configurator window and can

be extended to show descriptions by clicking the menu symbol . It gives access to the

pages:

   Organizations

   Configuration

   Projects 

   Project collections

   Resources

   Satellites

When entering the settings, you will find a help section (4) on the right side of the

window, which guides you through the individual input steps. This can be opened and

collapsed with the arrow symbol. 

The user interface can be displayed in a light and a dark color variant.
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User interface of GENIUS TOOLS Project Configurator in light color theme

Please note: Note that GENIUS TOOLS Project Configurator, in contrast to previous

Startup TOOLS versions, does not save changes immediately. To save any changes, click

Save button  in the sidebar (2). Until you save, any changes can be undone by

selecting Revert changes in the user menu.

The Project Configurator window also has a footer (3). The following sections contain

information on the main menu pages and the other control elements.

5.2.1  Main menu

5.2.1.1  Organization

The menu item Organization  is used to manage roles and their access rights to

projects, functions, and units.

Access tab
The Access tab lists restricted projects (1), which determine project access based on their

position in the project permission tree (2), see chapter Restricting project access.

Project access is determined via roles (3). Members are assigned to a role in the Details tab

(4), either as static (GTS) or dynamic (LDAP) entries. 

Access rights for GENIUS TOOLS for Creo and GENIUS TOOLS Starter App functions are

defined in the Function access tab (5) based on the role to which they belong.
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Units tab
Units are created and managed in the Units tab, which you can use to map your

organization in different levels and sub-levels. Read chapter Mapping an organization for

detailed information on working with units.

Please note: With a perpetual license, you can create any number of units, but you can

only drag them into the tree to a maximum depth of 3. To use more depths, you need a

subscription license.

5.2.1.2  Configuration

Use the Configuration page  to manage global settings as well as settings specific to

units and subunits. The Settings list contains several buttons which open the settings pane

and the corresponding help page.
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Dialog window Configuration

Select a unit to show the settings applicable to this type of group. The Standard unit is

used for managing global settings and cannot be deleted. In a newly created database,

only this unit will be available.

Units are manged in the Organization page in the Units tab. 

For more information on the individual settings, please refer to Configuring global

environments and Configuring heterogeneous environments.

5.2.1.3  Projects

In the Projects page   you can create and configure projects for the supported CAD-

applications as well as projects of other applications (“Apps projects”).

Projects can either be made accessible to all users or to a defined group of users, see

Restrict project access.

Projects page for Creo Parametric

For a selected project, the corresponding tabs are displayed for inputting settings, e. g. for

Creo Parametric the tabs Creo, Start, Windchill and Environment. For information on how

to create projects and define their settings, please refer to Creating projects.

Projects without an available license can either be hidden from the user's view in GENIUS

TOOLS Starter App or can be marked with a warning color, see chapter GENIUS TOOLS

Starter App.
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5.2.1.4  Project collections

In the main menu item Project Collections  you can

organize individual projects into project collections, which

are displayed to users in GENIUS TOOLS Starter App. 

There are company-specific project collections, which can

contain any projects, as well as application-specific project

collections, which contain all projects of an application.

Consult the chapter Project collections.

In addition, the display of auto projects can be modified

here. 

Auto projects are Starter projects of an application for

which only one project can be created. This project will be

automatically created by GENIUS TOOLS Starter App with

the latest available software version on the user computer and will be displayed with an

icon of the application. 

Auto projects are generated from the following applications: Creo Elements/Direct

Drafting, Creo Illustrate, Creo Schematics, Creo View, GeomagicDesignX, Keyshot and

MathCad.

Please note: Auto projects are only available with a subscription license.

5.2.1.5  Resources

In the Resources page  different types of resource are created in order to work efficiently

with GENIUS TOOLS Project Configurator. Resources are entries for users and computers, 

as well as startkeys and license servers for Creo applications. Please read the chapter

Resources.

5.2.1.6  Satellites

In the Satellites page   you can set up and monitor additional synchronization servers.

A satellite (also: synchronization or mirror server) is a computer or a sector of a computer

onto which the state of one or more operating environments of a central main server is

mirrored by data synchronization.

Please read the chapter Working with satellites.

5.2.2  User menu

To access the user menu, click on the gear symbol  in the side bar.



61GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Language: user interface language

You can switch the user interface language between English, German and French at any

time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set

to German. For all other locale settings, the software first starts with an English user

interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

XML Import

You can import users and computers from an XML file. If the users or computers are

assigned to a role that has not yet be configured, the role will also be created during the

XML import. When you click XML Import in the user menu, a dialog for selecting the XML

file is displayed.

XML Export

You can export users and computers into an XML file, for example in order to make batch

changes quickly, then re-import the file.

Revert changes

Project Configurator does not save changes immediately, so you can revert any unsaved

changes. If you do so, Project Configurator reloads the database and re-initializes all input

fields.

To revert changes, select Revert changes. A warning dialog is displayed. Confirm the

warning (Reload database. Changes will be deleted.) with Yes.

To save changes, click Save  in the sidebar.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of

the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting

Pause synchronization is saved for the next start and marked by a yellow bar below the

header. When the user resumes synchronization, they are asked whether they want to

resume and overwrite local changes.
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Pause synchronization if you want to prevent local changes from being overwritten until

they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If

you are not allowed to pause the synchronization, the item Pause synchronization is not

displayed in the menu.

Help

– Help (F1): Software manual for GENIUS TOOLS Starter, which corresponds to this

document.

– Support: Contact details for the technical support of INNEO or a company-specific link

which can be set up in GENIUS TOOLS Project Configurator. Inneo's support can be

reached by email, telephone and with Teamviewer. 

– Info (F12): Current GENIUS TOOLS Starter version. 

– Reference card: Quick overview of the functions in GENIUS TOOLS Project Configurator.

– Parameter variable: List of start parameters and environment variables.

Reset window size

Restores the default size of the dialog window of GENIUS TOOLS Starter. The window can

be adjusted to all sizes. 

Switch user – only visible with an alternative authentication system

Switches to another user of the applied authentication system, e. g. Windchill.

Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the

program window.

Starter App

Switch to the GENIUS TOOLS Starter App.

5.2.3  Save database

The sidebar contains the function Save Database . Any settings you make in GENIUS

TOOLS Project Configurator will only become active after you save them. Any changes are

saved to the database sut.db on the installation computer (path:

\caddepot\<OperatingEnvironment>\configuration\database)

As long as you have not saved your changes to the database, you can revert them by

selecting Revert changes in the user menu .



63GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

5.2.4  Footer

The footer in Project Configurator contains the following information.

Data base mode

The state of the database is displayed in the footer:

 Database requires a subscription license. Projects cannot be started when working with

a permanent license.

 Database has been created with a permanent license. It can be accessed by both

permanent and subscription license.

Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is

displayed. For more information, please refer to Procedures and synchronization.

 Synchronization is active 

Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to

the local operating environment as a tooltip.

 Synchronization inactive

The synchronization of toolkit applications is paused as long as Creo is running 

 Local operating environment

There is no synchronization; you work on a local directory 

Running applications

If a supported desktop application is running, the application icon will be displayed in the

footer, e. g.

 Creo Parametric

 Creo Elements/Direct Modeling

Messages

– Red = Error message. Please troubleshoot.
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– Yellow = Warning message. Please decide whether you want to keep on working

regardless.

– Green = Last synchronization run was completed without errors.

– Green / Creating shortcuts: This message shows that the desktop link for GENIUS TOOLS

Starter App has been updated.

5.3  Organizational structure

You can use units to map your organization in various units and sub-units. 

Units are managed in the Units tab in the menu item Organization .

Settings for the units created here are made in the menu item Configuration, see Unit

settings.

Units tab in the Organization dialog window

Please note: Users with a subscription license can create unlimited layers of subunits.

Users with permanent licenses are limited to two layers.

5.3.1  Working with units

The purpose of a unit is to group users into one configuration layer and apply unit-specific

settings. Units are typically used to reflect an organization's structure such as company

departments or sites.

A unit is part of the role-based authorization system, i. e. users are first assigned to a role

and the role is assigned to one or more units. Thus, a user can belong to more than one

unit. In this case, display and settings of projects depend on the unit selection, see next

chapter Displaying units in GENIUS TOOLS Starter App.

The affiliation of users to a unit can be dynamical. In this way, units always reflect the

current staff list and company organizational structure as configured for Windows user

management. If a user quits a company department, their Windows user account is

configured accordingly, and the user is automatically removed from the corresponding

unit. User assignment does not have to be updated manually. See chapter Accessing

Windows user management.
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Please note: To allow a transition phase between managing users and computers

individually and managing them via LDAP queries, users and computers can still be

manually assigned to a unit. However, this is not the recommended procedure for using

units.

5.3.1.1  Creating units

Units are created in the Organization  page. In contrast to user groups and computer

groups, a unit always has to have a role assigned.

Please note: Creating a unit GENIUS TOOLS Project Configurator does not create a unit

directory.

When creating a unit there will be a warning if this is the first functionality that you are

using with a subscription license after a license upgrade.

Please note: With a perpetual license, you can create any number of units, but you can

only drag them into the tree to a maximum depth of 3. To use more depths, you need a

subscription license.

Create

Click the Plus button (1) in the Selection column.

In the following dialog fill in the input fields. Except for the name of the unit, you can enter

all settings later in the selected unit in the Unit and Definition area.

Name

Enter a name for the unit. This is the name displayed to users in GENIUS TOOLS Starter

App.

Please note: The name of a unit does not have to correspond to the name of the unit

folder. Naming a unit folder differently from a unit can be useful for a better folder

structure of files. 

Tag ID

Define the tag ID for the unit, see chapterUsing unit tag IDs. 

Autofulfillment: The tag ID is identical to the unit name. (Small letters.)
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Individually created tag ID: The unit tag ID is freely choosen. Tag IDs must not contain

symbols not allowed in file names, such as ~ " # % & * : < > ? / \ { | }.

Empty: The unit does not have a tag ID. This is not recommended, since no Creo

configuration options can be set up for units without a tag ID.

Please note: When creating a unit in the Create dialog a unit tag ID is assigned, which

can also be used without a unit directory, see example in chapter Using unit tag IDs. 

Unit type 

The unit type is used for better clarity in GENIUS TOOLS Project Configurator, see

arranging units. Select a type or write in the field to create a new type.

Role

Select the role that is assigned to the unit. If the role is not listed here, you have to first

create it in the Organisation  page in the Access tab under Roles.

A unit is part of the role-based system of granting access rights. This means to first assign

a group of users to a role, and then assign the role to the unit. A user can be a member of

several roles.

You can edit the role for a unit at a later point in time in the Definition section. The

corresponding LDAP queries are listed for information purposes only.

Comment

Entering a comment is optional.

Result: 

The newly created unit appears as a new item in the Selection column with the default unit

icon . You can replace this icon with your own images, such as flags, see Displaying

units in GENIUS TOOLS Starter App..

You can now place the unit in several configuration levels in the organization tree, if you

wish to map your organizational structures with units and subunits.

5.3.1.2  Assigning unit folders

A unit can be used with or without a unit directory. 

Working with unit directories offers extensive possibilities for configuration, as a unit

directory can contain the following files:
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– configuration blocks

– PSF files (Creo startkeys)

– batch files

Creating a unit directory
A unit directory is created manually as a subdirectory in the system directory units of an

application.

Caddepot\<operatingenvironment>\<application>\configuration\units\<unitdirectoryna

me>  

The name of the unit directory does not have to correspond with the name of the unit that

is created in GENIUS TOOLS Project Configurator. Different names for a unit and a unit

directory can be advantageous when working with subunits, i. e. for a better overview of

the call hierarchy of settings.

Selecting a unit directory
You can enter the name of the required unit directory in the Create Unit dialog or select it

in the field Tag ID / unit directory in the Defintion segment in the Organization menu item.

Selecting a unit directory in the Organisation menu item

When a directory is selected, its name becomes the unit tag ID. 

5.3.1.3  Deactivating units

Blocking a unit in the Project Configurator is useful if you wish to disregard the

configuration for this unit without deleting the unit, e. g. during tests. 

To do this, go to the Name/Members area and activate the radio button Blocked. The

name of the unit will be crossed through.

You can also block individual users or computers without locking the entire unit, see the

section Blocking individual users or computers.
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5.3.1.4  Using unit tag IDs

A unit tag ID is an additional textual marking in a configuration block (Config_*.pro file)

that defines a unit and limits the validity of the block to it. 

Unlike configuration blocks that are located in a specific Unit folder, configuration blocks

with a unit tag ID can be stored in all folders. They are activated by the selection of the

unit in GENIUS TOOLS Starter App.

This allows settings to be made for a unit even without assigning a unit folder to the unit. 

Creating units without a unit folder
When creating a unit in GENIUS TOOLS Project Configurator, a unit tag ID is suggested.

You can change the name of the unit tag ID thereafter in the Definition area. Do not select

a unit folder.

Unit tag ID / folder name

Defines the tag ID for the unit. If you select a unit folder, its name will also be the name of

the unit tag ID. Unit folders are created manually in configuration\units.

The tag ID preset in the input field can be:

Retained/ overwritten: Defines the unit tag ID. Tag IDs must not contain characters

that are invalid for file names, such as ~ " # % & * : < > ? / \ { | }. German umlauts and

the letter ß are not accepted.

The unit directory preset in the input field can be:

Retained / replaced: Assigns an existing unit folder to the unit; the name of the folder

becomes the unit tag ID (case-insensitive). 

Please note: The name of the unit which users can choose in GENIUS TOOLS Starter

App can be freely set by the administrator and does not necessarily have to correspond

to the name of the unit folder. 
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Use case
In a company two sub-departments (Amsterdam, Berlin) of the Europe division are to work

together on five projects. In two projects (C, D) of the five different license extensions

should be used: Amsterdam should work with AAX, Berlin with BMX.

Initial situation: A unit folder with the name Europe is located in the units system folder

and contains the Creo configuration options (configuration blocks) for the unit Europe.

Procedure: 

In GENIUS TOOLS Project Configurator

1. In the main page Organization main page go to the Select section and click the Plus

button, see Creating units. 

2. Create a unit with the name “Amsterdam” and the tag ID "amsterdam".

3. Create a unit with the name “Berlin” and the tag ID "berlin".

4. Do not assign any unit folders to these units.

5. Add the two units in the organization tree under the unit Europe. 

At file level

6. Create a configuration block named config_lic.amsterdam.pro.

7. Enter the license extensions for AAX.

8. Create a configuration block named config_aax.berlin.pro.

9. Enter the license extensions for BMX.

10.Place the two files in the project folder for project C.

11.Place the two files in the project folder for project D. 

Result: The license extensions AAX and BMX can be restricted to units for projects C and D

without having to create new projects. 

Advantage: Without tag ID four projects would be necessary: Project C with AAX/ with

BMX and Project D with AAX / with BMX.

Project options with several unit tag IDs

A configuration block with a unit tag ID can be used as a project option in one or more

projects. A project option can be limited to one unit by adding a single unit tag ID, but it

can also contain multiple tag IDs.

Validity
When using multiple unit tag IDs, all conditions set by the tag IDs must be met. 
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Example: Validity of a configuration block

A company has the units Construction and Hamburg, but no unit MBD. This means the

configuration block config_lic.hamburg.construction.mbd.pro is valid if the unit

Construction and the unit Hamburg and the combined project option MBD is selected.

Usage
Using multiple unit tag IDs is useful when you have subunits in different configuration

levels.

Example: Configuration block in multiple levels.

For project A, the team Construction in Stratford-upon-Avon, but not in Hamburg, is to

be given NC as an option on the project.

Solution: 1. The units Manchester and Construction are created in GENIUS TOOLS

Project Configurator. 

2. A configuration block with the name config_lic_nc.manchester.construction.nc.pro is

created in the project folder of project A.

3. The project option NC is defined according to requirements (e. g. license extensions),

see Single project options.

Result: The construction team in Manchester can activate the project option NC on

project A. 

Advantage: The project option NC is not available to all members of the Construction

unit, as would be the case if the Configuration block were located in the Construction

unit directory.
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5.3.2  Mapping an organization

Units offer a wide range of options for mapping the structure of a company, since the

settings for a unit can be made at several configuration levels. The configuration levels for

units are created in the standard group in the menu item Organizational Structure.

Basic structure 
If all units are organized in one level, no adjustments are needed in the organization tree.

Arranging units

Units are ordered alphabetically. Within a configuration level, you can place a unit in the

first position by inserting a space at the beginning of the unit name, e. g. " Switzerland".

This will also be applied to the display in the GENIUS TOOLS Starter App selection field.

Subunits for complex organization structures
Units can represent multiple configuration levels, e. g. they can be arranged by region,

country, location, city etc. A subordinated unit is called subunit.

For example: You want to make settings for the Construction team, which is split between

three locations. The organizational structure could look like this.
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All units are displayed on the right of the dialog Organization. You can select a unit there

and drag it to the desired position in the organization tree. The following applies: 

– Dropping a unit under a unit automatically creates a subunit.

– A unit can be used several times in different levels.

– A unit cannot be subordinated to a unit with an identical name.
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Unit "Development" of type "Team"

Search (1,4)

Enter at least three letters to search through units and subunits in the organization tree  or

the selection list . The respective paths will open.

Waste bin(2)

Removes the selected unit from the organization tree. The unit is not deleted.

Plus symbol (3)

Expands the organization tree showing all subunits.

Minus symbol  (3)

Collapses the organization tree to the first layer.

Unit paths (5)

All parent folders in which a unit is located are listed in the unit under Cross Reference.

Categorize units by types
For having a better overview of all units in GENIUS TOOLS Project Configurator it is useful

to arrange units into subdivision in the left Selection column.

Unit type (6)

Unit types are free generic terms, e.g. country or city, which are used for clarity in a

complex organizational structure. 

You can select an existing unit type or create a new one by writing into the field.

The entered name will immediately appear in the left column and will line up

alphabetically in the existing unit type entries. Without an entry, the unit is created under

the type Unit.
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Please note: The arrangement of the units in types has no influence on the

organizational structure, i.e. the configuration hierarchy of the project settings.

5.3.3  Call hierarchy for subunits

The call sequence of subunits corresponds to the arrangement in the organization tree, in

this example: Standard - United Kingdom - Stratford-upon-Avon - Development (1). 

In this example, the following settings define a Starter project 

– the settings for the Development unit,

– the inherited settings from Standard, United Kingdom and Stratford-Upon-Avon as well

as

– settings of the project, see  Call sequence for settings.

If a subunit exists more than once, e. g. Construction (2), inherited settings from the parent

units Switzerland / Brüttisellen or United Kingdom / Stratford-upon-Avon may apply,

depending on the selection by the user.

View call sequence
The more subunits you have, the more difficult it becomes to track at which configuration

levels settings are made and possibly overwritten. You can see this in two locations:

1. In the Config tab of GENIUS TOOLS Starter App: The configuration blocks are listed by

directory.

2. For Creo Parametric projects in the project report under the heading "config.pro": The

config.pro  blocks are listed with path information.
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Directory structure for files
In the units system directory all directories are located on one level, i. e. it is not visible

whether a directory contains settings for a unit or a subunit. For an easier overview at file

level, it may therefore be useful to adjust the unit directory names to reflect the call

hierarchy. You can do this by giving the unit directory a different name to the unit you

create in GENIUS TOOLS Project Configurator.

Please note: The name of the unit directory becomes the unit tag ID when assigning

the directory to a unit. 

Examples for an easy overview of call hierarchy:

Unit directories by country 

and city Unit directories by country

5.3.4  Displaying units in GENIUS TOOLS Starter App

Once users belongs to multiple units, they have to select a unit in the user interface of

GENIUS TOOLS Starter App.

Standard selection
If there are only units in one organization level, the selection field lists all units available to

the user in alphabetical order.
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Hint: If you wish to place a unit at the top of the list, put a space character in front of

the unit name, e. g. " United Kingdom".

Changes to unit names are adapted after restarting GENIUS TOOLS Starter App.

Selection of subunits
If there are subordinated units (subunits) to choose from, a separate dialog box opens.

The unit Stratford-upon-Avon does not appear

because it is the only subunit in United 

Kingdom

Displaying units with icons
You can add a picture to the display of a unit by storing a JPEG, PNG or SVG file in the

_Images subdirectory of the configuration directory in the Caddepot. The name of the file
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has to be identical to that of the unit directory, e. g. United Kingdom.png, or – if you are

working without a unit folder – to that of the unit tag ID.

Images directory under configuration

5.3.5  User and computer groups

With version 11.0.0.0 user and computer groups have been abolished in their previous

form, since the assignment of access rights is defined via roles and roles can only be linked

to units, not to groups. Existing groups are automatically converted into units when

updating:

– Configuration blocks that were created for user or computer groups

(UG_<nameofusergroup>_config.pro or CG_<nameofcomputergroup>_config.pro), will be

migrated into a new unit directory of the same name.

– After the update, the former groups appear as the last subunit in the organization tree,

i. e. they are inserted under each last unit. This corresponds to the call sequence for

settings.

– Group settings (Menu item Configuration) will be transferred to the new unit(s).

Warning: If the environment variables GTS_USER_GROUP or GTS_COMPUTER_GROUP

were used in a configuration block, these variables must be renamed to GTS_UNIT_DIR

when updating to version 11.0.0.0 and later.

Please note: After the update, users with permanent licenses can work with units and

subunits of a further level. A subscription license is required for unrestricted working

with units.

The advantages of units over computer and user groups are:

1. Units can contain sub-units and therefore better reflect the organizational structure of

a company.  
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2. A user can be assigned to several units.

3. The affiliation to a unit does not have to be maintained manually.

For more information on migrating groups, see GENIUS TOOLS Environment Administrator

> Update. 

5.4  Roles

GENIUS TOOLS Starter is based on a role-based authorization concept. This allows you

to grant different access rights to projects and functions to defined user groups.

Roles are managed in the main menu item Organization  in the Access tab (1) under

Roles (2).

Firstly, users are assigned to a role in the Details tab (3). These entries can be static or

dynamic (5). Dynamic user entries change automatically in GENIUS TOOLS Starter when

the entries are changing in the source, e. g. Windows Active Directory. Computer entries

are always static entries.

Secondly, access rights are defined for this role. These rights include access to projects (6)

as well as to functions in GENIUS TOOLS Starter App (4), see chapter Access rights.

If a role configured in this way is assigned to a unit, it becomes a assigned role. For a unit,

you can apply specific settings for the various CAD applications.

A role can also be used  in the permissions tree as a free role  . A free role is not

assigned to a unit but still restricts the access of a project to the members of this role.

Please note: Project and function access rights are always defined for the members of a

role. The role can be assigned to a unit or be used as a free role in the permissions tree.

Details tab of the role "CAD user Stratford-upon-Avon"

The tree for permissions shows – like the tree for units – all units and subunits. These can
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restrict the access of a project. In addition, you can also use free roles  for defining

project access in the permissions tree.

The members list (4) shows all users (or computers) assigned to the selected role. You can

search for users and delete user with the recycle bin icon to the right of the user name.

A crossed name means that a user is blocked, i. e. for this user neither any role nor any

unit configuration is applied. To change the blocked status, go to Resources > Users > Edit

/ create user. 

5.4.1  Usage of roles

Roles are used to group users and assign rights. 

A role must be created and can be assigned to a unit if the members of the role 

– require special functional rights and / or

– should have access to certain projects.

A role must be assigned to a unit if the members of the role 

– work with a special configuration setting.

A role that does not define a unit is called a free role.

Grouping of users
To group users in a unit, a role must be assigned to the unit, under Organization > Unit

tab. 

Assignment of rights: Functional rights
You can use a role to activate functions for GENIUS TOOLS Starter App and GENIUS

TOOLS for Creo for the members of the role under Organization > Access tab > Roles >

Tab: Function Access. 

If a role is neither added to the project tree nor assigned to a unit, the role does not

define any project restrictions, but still determines the access rights for the members of

the role.

Example: A company assigns access to the Editors of GENIUS TOOLS for Creo to

administrators without creating an extra unit for this user group. The procedure for this

example is described in Chapter Free roles for function access.

Please note: Access rights for functions are always cross-unit, i. e. if a user is assigned to

several roles, he receives all function access rights for these roles, regardless of the unit

selected in GENIUS TOOLS Starter App. See chapter View users rights.
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A description of all access rights for GENIUS TOOLS Starter App and GENIUS TOOLS for

Creo can be found in chapter Granting function access rights.

Assignment of rights: Project rights
It is possible to restrict access to a project to certain users. To do this, the users must first

be grouped into a role. The second step is to add the project to the permission tree. If

users are assigned to several roles, the visibility of the allowed projects in GENIUS TOOLS

Starter App can be restricted:

– regardless of the selected unit: cross-unit project access

– depending on the selected unit: unit-specific project access

Please note: Project and function access rights are always defined for the members of a

role. The role can be assigned to a unit or be used as a free role in the permissions tree.

5.4.1.1  Use case: Usage of roles

The company ABC wants to assign certain access rights and projects to the following user

groups and make special configuration settings (in the unit settings). Click a role to go to

the chapter that describes how to create that role.

Name of

the role

User group Funktionsrechte Functional rights Configuration

options

Default roles

Administ

rator

Main

administrator

like GTfC admin

plus

– enter GENIUS

TOOLS Project

Configurator

Operating

environment for

testing, e. g. for

customizing

object data

Yes, e. g. own

drive connection

Everyone All persons for

whom a user

entry was created

in gtpc.

– Can see project

info

– Analyze / borrow

licenses

– etc.

–

free Rollen
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Name of

the role

User group Funktionsrechte Functional rights Configuration

options

GTfC

Admin

Site

administrators

like CAD test group

plus

– Is GTfC-Admin

– Can use network

mode

– –

KeyUser Users trained for

Model Processor

like CAD test group Model Processor

project

–

CAD test

group

Nutzer, die

Projekt der

neuesten Creo-

Version testen

like Everyone plus

– Can pause

synchronization

– Can deactivate

configuration

blocks

Test project

assigned roles

Users DE All users in DE Should see

projects in DE.

Yes, e.g. license

server in

Germany

Users UK All users in UK Should see

projects in UK.

Yes, e. g. license

server in UK

Construc

tion

All designers in

CH, DE, UK

like Everyone plus

– Can deactivate

configuration

blocks

Should see

projects with old

Creo version.

Yes, configuration

blocks for Creo

settings

5.4.2  Adjusting default roles

There are two pre-configured roles Everyone and Administrator. Both contain in the

default settings all Windows user names known to the system. 

Hence, every user is a member of the role Administrator. When you first use GENIUS

TOOLS Project Configurator, you should adjust the role by removing the user entry

Everyone and by assigning some individual users to it.
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Hint: The user entry Everyone in the Members is accessible to all roles and can be used

if you do not want to manage each user manually.

If you delete the user entry Everyone from the Administrrator role, it will still be available

for selection in the Members area (Plus symbol).

Standard role "Administrator" with user entry "Everyone"

The default roles cannot be deleted. The role Everybody can, however, be renamed.

5.4.3  Creating roles

To create a new role , click on the plus button (1) in the Roles area of the Access tab.

Enter the name of the role and an optional comment in the Details tab under General (2).

You can add an image.

The following elements can then be assigned to a role:

– static entries (GTS) of Windows users (3) and/or computers (7),

– dynamic (changeable), e. g. from the Windows user administration (8, LDAP) or an

alternative authentication system.

Dynamic entries are created directly in the role. For static entries, user or computer entries

must be created under Resources. 

Individual users can be created (4), searched for (5) and deleted (6) in the member list.

If you have changed the authentication to a system other than Windows (e. g. Windchill),

the area User groups (authentication provider) appears instead of the LDAP area, in which

the assignment of user groups to a role is possible. The update function  to the right of

the add symbol updates these user groups.

To assign access rights, fill in the Function access tab, see chapter View users rights.
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Creating a new role

5.4.3.1  Adding static entries to a role

You can assign users and computers to a role statically.

Static entries do not change automatically as dynamic user entries do. Changes to static

entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

To assign a user or computer to a role, you have to first create an entry as a Resource

under users / computer. A user or computer can be assigned to several roles.

Procedure: Add users to a role 

1. Under the main menu item Organization , select the role to which you want to add

one or more users. 

2. In the Users section (3), click on the plus button (4). 

3. In the new dialog box that opens, select the users you wish to add to the role.

You can search entries and sort them alphabetically.

Tip: The previous entry Everyone contains all users.
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4. Finish the dialog box by clicking on either:

– Ok: Add selected users and close dialog box,

– Cancel: Close dialog box without adding selected users,

– Apply: Add selected users without closing dialog box.

5.4.3.2  Adding dynamic entries to a role

Dynamic user entries adopt changes from the system in which they have been created.

If GENIUS TOOLS Starter is used by Windows users, this is done automatically for dynamic

entries by means of an LDAP request. If users are to authenticate with a different

authentication system, the entries of this system must be regularly updated manually in

GENIUS TOOLS Project Configurator using the Update function .

Accessing Windows user management

If you are using a subscription license, you can access the Windows user management.

This means that you can assign permissions to users and user groups that have been

defined by your company's central IT management. GENIUS TOOLS Starter App uses live

queries to make sure that user assignment is up-to-date. Thus, you do not have to create

users locally. 

Windows user management is accessed using LDAP queries. LDAP (lightweight directory

access protocol) is a standard network protocol for accessing a distributed directory

service.

Please note: An LDAP query is only available with a subscriptions license. When using a

permanent license, the LDAP tab is not visible.
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Defining an LDAP query
To define an LDAP query, go to the Resources page, select the role that you want to assign

a query to, and go to the LDAP tab.

In GENIUS TOOLS Starter App live queries to Active Directory are executed at the start of

project validation. The LDAP groups are cached for fallback functionality. 

The LDAP fields Description, DisplayName, Initials and Enabled are queried and the entries

are transferred to the following fields. The administrator can overwrite the content of a

field, but not the mapping.

Defining an LDAP query

u Users (LDAP) – Subscription

In the LDAP section, you can assign users from an LDAP query to a role dynamically.

(LDAP: Lightweight Directory Access Protocol)

Blocked (1)

Use this to block the LDAP query.

LDAP query (2)

Enter the name of the LDAP group you want to use.

Comment (3)

Enter an optional comment for the LDAP query.

Delete (recycle bin icon,4)

Removes the LDAP query from the role.

u Modify users

In the section Modify Users you can edit details from LDAP queries or alternative

authentication systems. Specifications for static user and computer entries are edited

under Resources.

Any changes only apply to GENIUS TOOLS Starter.
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Search (5)

Camera column (6)

Double-click the upload icon in the camera column to add a user image.

User name (7)

Displays the user name (Windows / alternative authentication systems).

GTS Alias (8)

Enter a GENIUS TOOLS Starter alias for use in additional applications. The alias is available

in Creo via the environment variable %GTS_USER%. If you do not specify an alias, the

Windows user name will be set

GTS Alias Long (9)

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short (10)

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

LDAP query (11)

Displays the LDAP group or the user group of the alternative authentication.

Comment (12)

Displays the staff position.

Email (13)

Displays the email address.

Accessing alternative authentication systems

If you have selected an alternative authentication method in the global settings, you can

assign user entries that come from this system to a role. Details of users and their

affiliations to user groups are updated with the update function  which appears to the

right of the Add icon. These entries are therefore dynamic, i. e. changes made in the

authentication system are adopted by GENIUS TOOLS Starter and do not have to be

entered manually per entry.

Please note: Integrating an alternative authentication system with GENIUS TOOLS

Starter requires a subscription license.

For Windchill, all user groups and their assigned users are automatically imported from

the specified Windchill server. The following information is adopted:

User group information

"Name" > Group name

"Description" > Description of group

User information

"Name" > User name

"FullName" > GTS Alias Long
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"AlternateUserName1" > GTS Alias Short

"Email" > Email

If you would like to use other authentication systems, you must create an authentication

provider by yourself, see chapter Creating your own authentication provider.

In the section Users (Authentication Provider), the following details can be specified and

modified.

u Users (Authentication provider) – Subscription

In the section User groups (authentication provider) you can dynamically assign these

groups to a role.

Blocked (1)

Blocks the user group.

User group (2)

Enter the user group you want to assign to the role.

Comment (3)

Enter an optional comment or accept the existing one.

Delete (recycle bin icon,4)

Deletes the user group from the role.

u Modify users

Details about individual users can be edited like entries from LDAP queries.

5.5  Granting function access rights

In the Function Access tab, select the rights you wish to grant to the members of a role for

using functions in GENIUS TOOLS Starter App and GENIUS TOOLS for Creo.

Granting function access to the role "Key User"
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Please note: Access rights for functions are always cross-unit, i. e. if a user is assigned to

several roles, he receives all function access rights for these roles, regardless of the unit

selected in GENIUS TOOLS Starter App. See chapter View users rights.

Use case: Function access when a user is a member of several roles

The table shows the function access authorizations for user Anna Help, who is a member

of the roles GTFC Admin, Construction and Everyone.

Example for user A.

Help

Function access: cross-unit

„Can enter GTPC“ „Can use network

mode“

„Can deactivate

configuration

blocks“

Membership in:

Role GTFC-Admin – X X

Role Construction – – X

Role Everyone

Überblick

– – –

Authorizations for

GENIUS TOOLS

Starter:

Regardless of the

selected unit

– X X

Granting access rights
These two functions concern the work with GENIUS TOOLS for CREO (GTFC):

– Is GTFC admin 

– Can use network mode

The other access rights are assigned for GENIUS TOOLS Starter App. If an access right is

not given to a user, the corresponding button does not appear in GENIUS TOOLS Starter

App. Also refer to the chapter GENIUS TOOLS Starter App User Interface.
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Please note: Not every function in the GENIUS TOOLS Starter App can be controlled.

Default functionalities cannot be influenced. Calling up GENIUS TOOLS Starter and

starting a project cannot be influenced.

u Administration

Can enter Project Configurator

Determines whether users are allowed to open GENIUS TOOLS Project Configurator. For

users who do not have this right, a message will be displayed, and the Project

Configurator will be closed when the user confirms the message.

Default for role Administrator: Yes

Default for role Everyone: No

Hint: When GENIUS TOOLS Starter is started locally from the Caddepot directory,

Project Configurator is always accessible. In this way, an administrator will always have

access to the configuration.

Please note: If this right is not assigned to any user, GENIUS TOOLS Project

Configurator will revert to the default setting of granting the right to all users.

Default for role Everyone: No

u Synchronization

Can pause synchronization

The user may pause the automatic data synchronization. Synchronization has to be

paused if you want to make changes to files in the Cadpool locally, otherwise local

changes would be overwritten as soon as the synchronization runs.

Default for role Administrator: Yes

Default for role Everyone: No

Warning: GENIUS TOOLS Starter App will keep the synchronization on pause even after

a restart of the software as long as the user still has this right. If this right is withdrawn

while the synchronization is paused, the synchronization will run automatically when

the software is restarted, which may result in data loss.

u Project

The following settings are also explained in the chapter Customizing information panes.

Can analyze project 

Users are able to analyze and edit all configuration files of a project with GENIUS TOOLS

Config Analyzer. The button  is displayed.

Default for role Everyone: No

Can see project information

Users can open the Info tab containing the project name, paths to the project, data and
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working directory as well as the selected language and the startkey. The button  is

displayed. 

Default for role Everyone: Yes

Can create project report

The user can view all information about the project and user settings in a separate

document. The button  is displayed under the project name. 

Default for role Everyone: No

Can analyze licenses

Controls the visibility of the license evaluation in GENIUS TOOLS Starter App. (See chapter

Displaying license information.) To use this option, you also have to set Show licenses

under Configuration > Creo settings > Tab: Start to Yes.

Default for role Administrator: No

Default for role Everyone: Yes

Can borrow licenses

Users can start the license borrowing process. The button  is displayed in GENIUS TOOLS

Starter App in the Licenses tab. See License borrowing for Creo Parametric users.

Default for role Administrator: No

Default for role Everyone: Yes

Warning: To borrow the PTC licenses, the user has to complete the PTC borrowing

process.

Can disable configuration blocks

The user can temporarily disable Config files (configuration blocks) for a project. Disabled

files will not be used by GENIUS TOOLS Starter App when creating the configuration

settings. See Config.

Default for role Administrator: No

Default for role Everyone: Yes

Warning: Disabled configuration files will become active again on the next project

validation or synchronization.

Hint: This right makes it possible to quickly disable configuration files on individual

computers without having to change company-wide configuration settings.

Can open configuration blocks

Users can view and edit Config files (configuration blocks). See Config.

Default for role Everyone: No

Can save private configuration blocks

Users can edit their private Config files and write them back to the userdata directory in

the Caddepot of the server. See Config. Set the path to the userdata directory in the

configuration settings page under User settings in the Application tab.
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Default for role Everyone: No

Sees auto projects

GENIUS TOOLS Starter will search for certain supported applications on the computer, for

example Keyshot or Mathcad , see auto projects., and will display them in the last installed

software version in GENIUS TOOLS Starter App. 

Default for role Administrator: No

Default for role Everyone: Yes

Can save customized settings/file

Creo Parametric users can view, edit and make a backup copy of the file

creo_parametric_customization.ui, which contains all user-specific settings for the graphical

user interface of Creo.

SolidWorks users can save their user specific settings, which are stored in the registry.

. The button  is displayed in GENIUS TOOLS Starter App in the Backup tab.

Default for role Everyone: No

5.5.1  Assigned roles for function access

A role that defines a unit is called an assigned role. 

If you grant function access for an assigned role, all members of the unit defined by this

role have these rights. 

Please note: Project and function access rights are always defined for the members of a

role. The role can be assigned to a unit or be used as a free role in the permissions tree.

Use case: Granting rights to members of the Construction unit

Company ABC would like to give all designers the right to analyze a project with GENIUS

TOOLS Config Analyzer and generate a project report as PDF.

1. Create role: Construction

2. Assign user to role: Eric Foster, Gerd Miller etc.

3. Tab Function Access: Can analyze project, Can create project report set to Yes

4. Create unit: Construction

5. Add unit to the organization tree: Drag and drop Unit Construction under Berlin

6. Assign role to unit: Assigning the role Construction to the unit Construction

The tree for permissions shows – like the tree for units – all units and subunits. These can

restrict the access of a project. In addition, you can also use free roles  for defining

project access in the permissions tree.
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Result: 

– All designers have access to the newly set rights.

– No projects are assigned. 

– If a designer is also a member of other roles, he receives all the rights of these roles.

A unit can also be used to restrict projects, see Unit-specific visibility.

5.5.2  Free roles for function access

A role that does not define a unit is called a free role.

If a role is neither attached to the project tree nor assigned to a unit, the role does not

restrict any projects, but still determines the access rights for the members of the role. For

example, a company can give administrators access to the editors of GENIUS TOOLS for

Creo without creating an extra unit for this user group.

Example: Assigning rights for site administrators

Company ABC has one site administrator in Germany and one in Great Britain. Both need

the same rights to make settings in the editors for GENIUS TOOLS for Creo, but should

not, like the main administrator, have the right to make settings in GENIUS TOOLS Project

Configurator and use the network mode.

Use case: Assigning rights for site administrators

Company ABC has one site administrator in Germany and one in UK. Both need the same

rights to make settings in the editors for GENIUS TOOLS for Creo, but should not, like the

main administrator, have the right to make settings in GENIUS TOOLS Project Configurator

and use the network mode.

1. Create role: GTfC_Admin

2. Assign user: Eric Foster and Gerd Müller

3. Tab Function access: Function Is GTFC-Admin set to Yes

4. Do not add the role to the authorization tree.
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Result: 

– The two site administrators have access to the GENIUS TOOLS for Creo editors.

– No projects are assigned to the site administrators. 

– If a site administrator is also a member of other roles, he receives all the rights of these

roles.

Please note: Access rights for functions are always cross-unit, i. e. if a user is assigned to

several roles, he receives all function access rights for these roles, regardless of the unit

selected in GENIUS TOOLS Starter App. See chapter View users rights.

A free role can also be used to restrict projects, see Cross-unit visibility.

5.6  Creating projects

GENIUS TOOLS Starter enables users to launch any program with the user component

GENIUS TOOLS Starter App. 

In the main page Projects , projects can be created for the CAD applications Creo

Parametric, Creo Elements/Direct, SolidWorks, Inventor and AutoCAD.

Projects for all other applications can be created as Apps projects with simplified setting

options. Most importantly, they cannot be set up for a specific release.

GENIUS TOOLS Starter App can also generate projects from certain applications

automatically, if they are installed on the user computer, e. g. KeyShot. For such Auto

projects no settings can be defined.

Please note: A project created here only becomes a Starter project after having been

selected in GENIUS TOOLS Starter App (by the user and his unit). That is, only the

selection by users computes the different configuration levels. The corresponding

configuration settings and batch files are then included to make up the project start,

according to the Configuration concept.
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Administrators can restrict the access to a project to defined user groups (roles), see

chapter Restricting project access.

5.6.1  Creating a new project

Choose the application (1) for which you want to create a new project. 

The Plus symbol (2) creates a new button with the name New Project as well as a number if

a project of the same name already exists. The new project becomes visible to the users as

soon as you save your changes to the database.

Click on a project in the projects list to edit the project details in the right pane. Note that

there are further tabs with project details for the CAD applications.

Details for the project "Creo Parametric 9.0"

Some input fields are pre-filled with the default settings, for others a drop-down menu

opens for directory search. 

There are also optional fields (indicated in brackets in the following chapters). If the

optional input fields are not filled in, the system-wide settings (Standard) or the settings of

the unit(s) are inherited by the project.

5.6.2  General project settings

Settings for project display (display name, project image and info text) are entered in the

segment General.

General details

Project name (6)

A unique name without space characters that identifies a project, e.g. project_vers8_en.

The default setting New Project can be overwritten. The project name can be changed at

any time.

Display name (7)

A unique name that is displayed for the users in GENIUS TOOLS Starter App. In GENIUS

TOOLS Starter App, the projects will be listed alphabetically according to their display
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name.

Description (8, optional)

A short text describing the project can be entered which will be shown below Display

name.

Project image (9, optional)

You can upload an image from the _Images directory, which is displayed next to the

project in GENIUS TOOLS Starter App. Use PNG or JPEG files.

Projects are displayed to users in GENIUS TOOLS Starter App as follow.

Display of projects in GENIUS TOOLS Starter App

Administrators can restrict the access to the tabs and project details for different user

groups (roles), which is explained in the chapter Presenting projects to users.

Sorting projects
In the GENIUS TOOLS Starter App, you can set the order of the projects for the users by

dragging and dropping the projects. The Change sorting button (5) in the Projects column

sorts the projects in the application alphabetically by display name.

Restrict project access
Projects can be restricted to users who belong to a defined role with specific access rights.

Members of this role can only view in GENIUS TOOLS Starter App the projects they have

access to. See chapter Restricting project access.

All projects that a user has access to are displayed under Resources > Users > Card view >

Project symbol (right).

5.6.3  Hiding and blocking projects

Projects that shall not be displayed to the user in GENIUS TOOLS Starter App can be

hidden in Projects > Application Type > Projects > First tab > Section: General.
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Blocked projects are displayed in gray in GENIUS TOOLS Project Configurator. Hidden

projects are crossed out.

When you set Hide project to Yes, the project is not listed in GENIUS TOOLS Starter App,

but can still be started using a start parameter. This can be a useful option for Windchill

projects, for example.

Hide project

No (default): The project is listed in the user interface.

Yes: The project is not displayed on the user interface in GENIUS TOOLS Starter App, but

can be selected using the -gts:p=<project name> start parameter.

A blocked project, by contrast, cannot be started using a start parameter.

Block project 

No (default): The project can be accessed.

Yes: The project is not displayed and cannot be accessed on the application computer.

The other specifications differ depending on the CAD application, see CAD-specific project

settings.

5.6.4  Copying a project

You can copy existing projects with the Copy button. Enter a new name and the remaining

settings as in the previous chapter.

If you copy an access-restricted project, the access rights are transferred. 

Copying project Creo Parametric 11.0
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Creo Parametric 11.0 and copy in the permission tree

5.7  Restricting project access

Access permissions for projects are defined in the permissions tree in the menu item

Organization  in the Access tab. To do this, create a role with the desired user group.

Please note: Project access rights are always defined for members of a role. The role can

be assigned to a unit or be used as a free role in the permissions tree.

In the Access tab, select a project in the Projects area using the plus symbol. In a new

window, you can search for the desired projects and add them by ticking them.
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Selecting projects

After selection, the project - in the example Creo Parametric 7.0 - appears in the

permissions tree under Standard. 

An access-restricted project is first inserted under “Standard”

All projects selected in the Access tab are marked as access-restricted with the symbol for

roles on the projects page.

Access restricted project
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Under Standard, the project is accessible to all users. In the permissions tree, access to a

project can now be restricted to a unit or a free role by dragging the project to the

corresponding position. The following options are available:

– Cross-unit visibility (with free roles)

– Unit-specific visibility (with assigned roles)

– Divided unit-specific visibility (with free roles)

Please note: To verify which projects are accessible for a certain user, go to the card

view under Resources > Users and click on the project symbol  on the user's card, see

View users rights.

5.7.1  Cross-unit visibility

For cross-unit visibility of projects, free roles have to be created, i. e. roles that are not

assigned to a unit. You can allow project access 

(a) across all units for the members of a free role by dragging the project under Standard

> Free role, or

(b) across different subunits if the project is under Unit > Free role.

(a) Cross-unit visibility for all units
If a project is created under a free role under Standard, project access is restricted to all

members of the free role. Members of the free role see the project regardless of the

selected unit in GENIUS TOOLS Starter App.

Use case: Enable all key users to access a project

The company ABC would like to limit access to the data revision program GENIUS TOOLS

Model Processor to a small group of designers who have been trained to use this

software. There should not be an extra unit for this group of key users. The key users, who

are members of several units, should be able to open the program out of all units.

1. Create free role: Key User

2. Assign user to role: Eric Foster, Gerd Müller etc.

3. Tab Function Access: No GTPC access, no GTFC admin, no network mode, all project

functions

4. No GTPC access, no GTFC admin, no network mode, all project functions

5. Add role to the permissions tree: Drag and drop Key User under Standard

6. Create project: Model Processor 11.0

7. Select project for access restriction: Model Processor 11.0
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8. Add the project to the permissions tree: Drag Model Processor 11.0 under Key User

Result: 

– Members of the Key User role have the rights listed above.

– Key users have access to the project Model Processor 11.0.

– Key users see Model Processor 11.0 project regardless of the selected unit in GENIUS

TOOLS Starter App. (Cross-unit project access)

– If a key user is also a member of other roles, he receives all rights of these roles. (Cross-

unit function access)

(b) Cross-unit visibility for subunits
If a project is created under a free role under a unit, e. g. Germany, project access is

restricted to all members of this free role. The project is visible to these members in

GENIUS TOOLS Starter App if they select the unit Germany and any of its subunits – here:

Berlin, Hamburg, Leipzig.

This variant is useful if the higher-level unit contains more users than the free role, e. g. if

the unit Germany contains all German-speaking users, including Swiss users. (If all users in

Germany are already defined in the unit Germany , the project should be arranged directly

under the Germany unit, as in the example under View users rights).

Example: Making work guidelines visible to users in Germany and Switzerland with

free roles

This variant is useful if the superordinate unit contains more users than the free role, e. g.

if the unit Germany (Deutschland) contains all German-speaking users, including Swiss

users. (If all users in Germany are already defined in the unit Germany, the project should

be subordinated directly to the unit Germany, as in the example in Unit-specific visibility).

The company ABC wants to make work guidelines with German legal requirements visible

to all users in Germany and work guidelines with Swiss legal requirements visible to all
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users in Switzerland. There are no units which separately map the users in Germany and

Switzerland.

1. Create free role: Users-DE

2. Assign user to the role: Gerd Müller, Fabian Havemann etc.

3. Tab Function Access: Optional

4. Add the role to the permissions tree: Drag and drop Users-DE under the unit

Deutschland

5. Create project: Creo rules of work DE

6. Select project for access restriction: Creo rules of work DE

7. Add project to the permissions tree: Drag Creo rules of work DE under the free role

Users-DE

8. Repeat steps 1-8 with the role “Users-CH” and the corresponding user entries and the

project “Creo rules of work CH”.

Result: 

– Members of the role Users-DE have access to the project Creo roles of work DE if they

select the unit Germany and any of its subunits in GENIUS TOOLS Starter App. (Project

access across subunits)

– Members of the role Users-CH have access to the project Creo roles of work CH if they

select the unit Switzerland and any of its subunits in GENIUS TOOLS Starter App. (Project

access across subunits)
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5.7.2  Unit-specific visibility

As of version 11.0.0.0, it is not only possible to restrict access to a project to certain users

(roles), but also to restrict the visibility of a project to users of a certain unit. This is useful

when users are assigned to multiple units. 

Please note: For unit-specific visibility of a project you have to use roles that are

assigned to a unit.

Use case: Enable designers in Berlin to access the project

The company ABC wants Creo Parametric version 8.0 to be used only by designers in

Berlin, as this version is needed for a specific customer project. The designers in Berlin

should not see the project if they select another unit in the GENIUS TOOLS Starter App

that they are also a member of.

1. Create role: Construction

2. Assign user to role: Eric Foster, Gerd Müller etc.

3. Tab Function Access: Optional

4. Create unit: Construction

5. Assign role to unit: Assign the role Construction to the unit Construction 

6. Add unit to the organizational tree: Drag and drop Unit Construction under the unit

Berlin

7. Create project: Creo Parametric 8.0

8. Select project for access restriction: Creo Parametric 8.0

9. Add project to the permissions tree: Drag Creo Parametric 8.0 under the Construction

unit
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Result: 

– Members of the Construction unit (role: Construction) have access to the Creo

Parametric 8.0 project

– If a member of this unit is also a member of other roles,

– he receives all rights of these roles. (cross-unit function access)

– he can only see the Creo Parametric 8.0 project in GENIUS TOOLS Starter App if he

selects the Construction subunit from the Berlin unit. (Unit-specific project access)

Use case: Making work guidelines visible in Germany and Switzerland with assigned

roles

The company ABC intends to make work guidelines with German legal requirements

visible to all users in Germany and work guidelines with Swiss legal requirements visible to

all users in Switzerland. The Germany unit includes all users in Germany (role: Users-DE)

and the Switzerland unit includes all users in Switzerland (role: Users-CH).

1. Create project: Creo work guidelines DE

2. Select project for access restriction: Creo work guidelines DE

3. Add project to the permissions tree: Drag Creo work guidelines DE under Users DE

4. Repeat steps 1-8 with the role "User-CH" and the corresponding user entries and the

project "Creo work guidelines CH".

Result: 

– Members of the unit Germany (Users-DE role) have access to the Creo work guidelines

DE project.

The project is visible in GENIUS TOOLS Starter App if the Germany unit and any of its

subunit is selected. (Unit-specific project access)
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– Members of the unit Switzerland (Users-CH role) have access to the Creo work

guidelines CH project.

The project is visible in the GENIUS TOOLS Starter App if the unit Switzerland and any of

its subunits is selected. (Unit-specific project access)

5.7.3  Divided unit-specific visibility

With the 11.0.0.0 option to restrict the visibility of a project to the users of a specific unit, a

project can also be restricted to the members of a free role within a unit. For example, a

specific group of people can be given access to a test project within a specific unit.

Use case: Enable project access for test group within unit designers in Berlin

The company ABC would like to set up a test group of designers to test an update of the

Startup TOOLS data packages for Creo Parametric 11.0. To do this, they also need access

to GENIUS TOOLS Material Browser. The testers should be able to pause the

synchronization and open configuration blocks. The test project should only be available

to the testers from Unit Construction in Berlin.

1. Create free role: CAD-Testgruppe

2. Assign user to role: Anna Help, David Graeber etc.

3. Add role to the permissions tree: Drag CAD-Test group into the Construction unit

4. Tab Function access: Can pause synchronization, Can open configuration blocks set to

Yes

5. Create project: Creo 11.0 - Test project and GENIUS TOOLS Material Browser

6. Select project for access restriction: Creo 11.0 - Test project and GENIUS TOOLS

Material Browser

7. Add project to the permissions tree: Drag Creo 11.0 - Test project into the CAD-Test

group role, drag GENIUS TOOLS Material Browser into the CAD-Test group role
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Result: 

– Members of the CAD-Test group role have the rights listed above.

– Members of the CAD test group role have access to the Creo 11.0 Test project if they

select the Construction subunit from the Berlin unit in the GENIUS TOOLS Starter App. 

– All other members of the Construction subunit in Berlin cannot see the test project.

(Divided unit-specific project access)

5.7.4  Project access - overview

This table shows the display in GENIUS TOOLS Starter App of access-restricted projects

when a user is a member of several roles.

Use case: The user Anna Help is member of the free roles Key User and Test Group

and member of the units (and assigned roles) Germany, Construction and

Development. 

The following projects are displayed after selecting: 

(a) Unit Construction at the location Germany > Berlin

(b) Unit Development at the location Germany > Berlin
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User A. Help

Project access

crossunit

(free role)

unitspecific

(assigned roles)

divided,

unit-

specific

(free role)

Model

Processor

11.0

Creo-

Work

Guidelines

Creo

Parametric

8.0

Creo 11.0

- Test

project

Membership in:

Role Key User1 

  free role under Standard

X – – –

Role Users-DE2

  assigned to unit Germany

– X – –

Role Construction3

assigned to unit Construction

– – X –

Role Test Group4

  free role under unit

Construction

– – – X

Role Development

assigned to unit Development

– – – –

Selection in GENIUS TOOLS Starter::

(a) Unit: Germany > Berlin >

Construction

X X X X

(b) Unit: Germany > Berlin >

Development

X X – –

1 This example is described in Enable all key users to access the project.
2 This example is described in Work guidelines DE.
3 This example is described in Enable project access for test group within unit Designers

in Berlin.
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4 This example is described in Enable designers in Berlin to access the project.

5.8  View users rights

The role-based authorization concept of GENIUS TOOLS Starter allows different user

groups to be granted or denied different access rights. User groups are defined as roles.

You can assign access rights for individual projects to the members of a role and grant

rights for certain functions in GENIUS TOOLS Starter App and GENIUS TOOLS for Creo –

see chapters Kapitel Restricting project access and Granting function access rights.

Please note: Project and function access rights are always defined for the members of a

role. The role can be assigned to a unit or be used as a free role in the permissions tree.

In the main menu item Resources , you can view the access rights for individual users in

the card view.

User entries in the card view

Clicking on the icons Function access and Project access opens the following windows. 
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Access rights for user 

Anna Help

List of projects that the user Anna 

Help sees. This may depend on the 

selected unit.

The Function access rights result from all roles in which the user is a member. 

Please note: Access rights for functions are always cross-unit, i. e. if a user is assigned to

several roles, he receives all function access rights for these roles, regardless of the unit

selected in GENIUS TOOLS Starter App. See chapter View users rights.

Project access rights can be cross-unit or unit-specific, i. e. it is possible that a user does

not see an access-restricted project in all units with which she logs into GENIUS TOOLS

Starter App. Please refer to the tabular overview in chapter Restrict project access.

5.9  Resources

The following resources are managed in the main menu item Resources :

Static Entries for

1. user and

2. computers

For Creo Parametric projects,

3. Creo startkeys and

4. Creo license servers can be created.

Units and roles are not considered resources and are created in the menu item

Organization.
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5.9.1  Creating users

In the main menu Resources page , static user entries are created and managed. You can

enter static user entries manually or import existing entries. 

Static entries do not change automatically as dynamic user entries do. Changes to static

entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

Hint: We recommend that you decide whether you will work with static or dynamic

user entries before creating users, as mixing both types of entries greatly reduces the

clarity in GENIUS TOOLS Starter.

You can switch between the card view (default) and the list view with the icons to the right

of the search window.

The resource "User" can be displayed in two views

GENIUS TOOLS Project Configurator saves the last used view. User photos can only be

edited in the list view.

Adding static users manually
Static users are identified by their Windows user names. If you are not working with

Windows users as an authentication method, work with dynamic users.

To create a static user entry, click the Add icon (+) in the upper left corner. A new window

will open. Alternatively, you can write entries into a new row in the list view, see Editing

users in the section below.
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Dialog for adding users

Creating users with regular expressions
User as well as computer names can be specified either directly (so that only the

corresponding user is legitimized) or with regular expressions (a group of users is

legitimized by a definition). When using regular expressions in the fields Windows user and

computer name the entries are extended by ^ and $, i. e. to ^INPUT$. Longer user names

can thus be legitimized by shorter and partial spellings,  e. g. efoster legitimizes both

efoster and ethanfoster. Find a list of regular expressions in the appendix.

Importing existing users
You can import existing entries of Windows users with an Excel list. If you have switched

authentication to a system other than Windows (e. g. Windchill), the Import function ,

which allows you to import users via the authentication provider, appears to the right of

the Plus icon. See Importing users with authentication provider. 

Searching for users
To find existing users, enter a search term in the search input field with at least three
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characters.

u Editing users
To edit a user, double-click on a visiting card or use the list view if you wish to make

several changes. You need to use the list view for assigning a user image.

List view

Blocked (1)

You can block a user, which means that unit settings or role assignment will not be

applied.

Yes/set: Settings or role assignment for this user will not be considered.

No/not set: Settings and role assignment will be used.

Camera (2)

List view: Double-click on the Upload icon to add a photo in PNG or JPEG format to the

user profile.

User name (3)

Enter the user name. If you are in the list view, you can get the user name for the currently

logged-in user by clicking on the person icon . Instead of entering a user name you can

also use regular expressions. See Section below.

GTS Alias (4)

Enter a GTS (GENIUS TOOLS Starter) alias for the user, for use in additional Creo

applications. For example, the GTS alias is used in GENIUS TOOLS Parameter. If you do not

specify an alias, the Windows user name will be set. If you are in the list view, you can get

the Windows user name for the currently logged-in user by clicking on the person icon in

the Windows user column.  The GTS alias is available as an environment variable (%

GTS_USER%) in Creo.

GTS Alias Long (5)

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.

GTS Alias Short (6)

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.
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Comment (7)

Enter an optional comment.

Email (8)

Enter the user e-mail address.

Delete (9)

Clicking the recycle bin icon deletes the user entry.

Viewing user rights
You can view the projects accessible to a user and the functions granted in GENIUS TOOLS

Starter App in the map view, see chapter View users rights.

5.9.1.1  Action: Create user entry with image

Prerequisite:

You have an image in JPEG, PNG, SVG or GIF format. The storage location can be any. The

name of the image file is automatically changed to the user name when it is uploaded. 

Procedure for the new user entry “Anna Help - ahelp”:

1. In the menu item Resources , go to the list view. 

2. Enter the user name in the bottom free line. If you are not working with an alternative

authentication method, this is the Windows user name: ahelp

The upload icon appears in the second column.

3. Click on the icon and select the existing image.

By uploading the image file, a folder with the user name is automatically created under

userdata and the uploaded image is automatically provided with the user name if a

different file name was available.

<working environment name>\userdata\%USERNAME%\%USERNAME%.png

4. Enter the GTS alias: A. Help



113GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

The alias is available as the environment variable %GTS_USER%.

5. Enter the GTS alias long if your company has assigned it: Anna Help

The long alias is available as the environment variable %GTS_USERLONG%.

6. Enter the GTS alias short: ahe

The short alias is available as the environment variable %GTS_USERSHORT%.

7. Save the changes with  in the sidebar.

The changes are saved in the sut.db database, which is located in the caddepot.

5.9.2  Creating computers

Computers are created and managed as permanent entries in the Resources page 

under Computers. Each computer is identified by its Windows computer name.

u Adding computers

To add new computers, click on the Add symbol (1) or write in the last input field of the

list.

u Searching computers

To find existing computers, enter a search term in the search input field (2).
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u Editing computers

Blocked (3)

You can block a computer, which means that unit settings or role assignment will not be

used.

Yes/set: Settings or role assignment for this computer will not be considered.

No/not set: Settings and role assignment will be used.

Computer name (4)

Enter the Windows computer name. You can get the Windows user name for the current

computer by clicking on the computer icon in the Computer name column. Instead of

entering a user name you can also use regular expressions. See section in Creating users.

Comment (6)

Enter an optional comment on the computer.

Delete (7)

Click the recycle bin icon to the right of the Comment column to delete a computer.

5.9.3  Importing users and computers from Excel

GENIUS TOOLS Starter comes with an XML interface to import a large number of users

into the GENIUS TOOLS Starter database in one step.

Follow the procedure described below to import users or computers. This will create static

entries.

Static entries do not change automatically as dynamic user entries do. Changes to static

entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

Format of the Excel table for importing users or computer
The directory caddepot\serveronly\tools\XML-Import contains two Excel tables –

computer.xls and user.xls – that serve as templates for creating XML files for import into

the GENIUS TOOLS Starter database.

Excel table for importing users and assigning them to one or more 

roles

Please note: A role that does not yet exist will be created on import.
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Requirements:

– The first line in the Excel table is the header line. The header line must not be removed

and has to be formatted in all capital letters.

– Enter the name of the computer or user in the first column.

– You can use the following columns:

For users: For computer:

USERNAME (mandatory) COMPUTERNAME (mandatory)

DESCRIPTION DESCRIPTION

ROLES ROLES

ALIAS

ALIASLONG

ALIASSHORT

EMAIL

– For roles, you can enter multiple entries, separated by semicolons.

Creating an XML file from the Excel table
After filling in the Excel table, export it from Excel as CSV (comma-separated value) file.

Beispiel: Content of a CSV file with a user list:

USERNAME;DESCRIPTION;ROLE

ahelp;Leipzig;"Users DE;Key User"

efoster;Edinburgh;"Users UK;Key User"

jturner;Edinburgh;Users UK

sholl;Berlin;Users DE

mweber;Berlin;"Users DE;Key User;GTFC Admin"

Please note: The separator character used by Excel depends on your locale. GENIUS

TOOLS Starter supports comma or semicolon as the separator character. You cannot

use either commas or semicolons in the contents of the columns! Please also refer to

Changing the separator for XML conversion.

The directory caddepot\serveronly\tools\XML-Import contains two batch scripts for

converting the CSV files into the XML import format. Use computer.bat for converting

computer lists and user.bat for converting user lists. The CSV file has to be called

computer.csv or user.csv and be located in the same directory as the batch script. When

you run the batch script, the XML import file will be written out as computer.xml or

user.xml in the same directory.
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The XML files created by the batch scripts can now be imported into GENIUS TOOLS

Project Configurator. Open Project Configurator, go to the user menu  and select XML

import. Select an XML import file. You will be asked whether you want to delete existing

users or computers. Make your decision. Confirm the import with Yes.

The imported users and computers are now available on the Resources page under Users

or Computers. If the import has created one or more roles, these will be displayed on the

Organization page in the Access tab under Roles.

Changing the separator for XML conversion
The separator character used by Excel for CSV export depends on your locale. You can

define the separator character in the batch scripts for CSV-to-XML conversion

(computer.bat or user.bat) as follows. Comma and semicolon are supported as separator

characters (sep) by default.

csv2xml -v -s:computer.csv -t:computer.xml -sep:;,

-m:1 -xsl:./extend/mode1-stylesheet.xsl 

-alias:eRoot=ROOT,eRecord=RECORD >>result.log

5.9.4  Importing users with authentication provider

For importing users who need to authenticate themselves, e. g. Windchill users, the Import

function  is available. The button appears when switching to another authentication

system than Windows in the unit settings.

For Windchill, all users are imported from the defined Windchill server and the following

information is taken:

"Name" > Username / GTS Alias

"FullName" > GTS Alias Long

"AlternateUserName1" > GTS Alias Short

"Email" > Email

If you want to use other authentication systems you have to create a customized provider,

see chapter Creating your own authentication provider.
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5.9.5  Creo startkeys

A startkey is a configured start command that opens Creo with one or several defined

licenses or license extensions. Startkeys are created in PTC's installation assistant when

setting up or reconfiguring Creo, see Creo startkeys (PSF keys).

An administrator can provide user with a choice of several Creo startkeys per project so

that the quantity of projects can be minimized.

Warning: Using Creo startkeys as a resource is a new feature in GENIUS TOOLS Starter

from version 6.0.1, which means that you need a subscription license to use it. Once

you have configured startkeys in this section, you cannot go back to using perpetual

licenses. See also License-dependent features.

In the main menu item Resources  enter a display name and a comment for a Creo

startkey which users view in GENIUS TOOLS Starter App.

Managing Creo startkeys in main menu Resources

If several start keys have been created, users can select a key when starting a project in

GENIUS TOOLS Starter App. The order of the start keys in the user selection field is that of

the order in the dialog window and can be changed by using drag-and-drop.

Display name (1)

Enter a name for the license key for display in GENIUS TOOLS Starter App.

Comment (2)

Enter a comment for the license key for display in GENIUS TOOLS Starter App. 

Creo startkey (3)

Enter the name of the  license key. This is the name of the PSF file in the bin directory of

PTC (e. g. parametric.psf).

Blocked (4) 

Yes: The Startkey can neither be used nor selected by users.

No: The Startkey can be either directly used or selected by users in GENIUS TOOLS

Starter App.

Startkeys can now be 
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– directly assigned to a project (see chapter Assigning Creo licenses to projects),

– assigned to units and subunits which have access rights to particular projects  and/or

– entered as a global standard (see Configuring global environments > Creo settings).

5.9.6  Creo license servers

In the main menu Resources  you can group one or several Creo license servers into one

resource and then assign this resource Creo License Server to a project or unit.

u Creo license servers

Display name (1)

Enter the name for display of the Creo license server(s).

Comment (2)

Enter an optional comment for the Creo license server.

Creo license server (3)

Enter one or more license servers in the notation Port@Servername (e.g.

7788@<licenseservername>). Separate a series of license servers with semicolons.

Blocked (4)

Yes:  The Creo license server cannot be accessed.

Warning: If you block the Creo license server here, the information from the Creo

startkey (PSF file) will be used. Check whether these information are correct. 

No: The Creo license server can be used.

The Creo license server(s) can now be assigned:

– directly to a project in Projects > Tab: Creo > Section: Creo license server (See chapter

Settings for Creo projects)

– to units and subunits, which in turn can be granted access to specific projects (See

chapter Settings for Creo projects)

– to the global settings in Configuration > Creo settings > Tab: Application > Section: Creo

license server (See chapter Application)

5.10  Global settings: Standard

The next sections explain the potential of configuration options for Starter projects. The

first step is to create the general, global configuration that is required for each system, the

so-called standard configuration. In the next step, deviations from the basic configuration

are made in units and subunits, see chapter Configuring heterogeneous environments.

The Standard group is pre-installed for the global configuration of the system.
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Please note: The group Standard contains the system-wide configuration settings and

is preinstalled. No members can be assigned to it.

Settings are made in input fields and inherited, see Inheritance of the settings.

If you do not specify anything in the drop-down menus, the default settings of GENIUS

TOOLS Starter apply. These are "No".

You can make the following settings:

– GENIUS TOOLS Starter App

– Additional Environmental Settings

– Synchronization

– GENIUS TOOLS License Manager

– Network Connections

– Creo Parametric

– Creo Elements/Direct Modeling

– SolidWorks

– Inventor

– Windchill Settings

Since these settings can be configured separately for all units, the input fields are

explained in the chapter unit settings.

5.10.1  Authentication

By default, GENIUS TOOLS Starter uses the Windows user name, i. e. there is no separate

login process.

However, administrators can specify that users log in with other user credentials, e. g. as a

Windchill user or as a user of an ERP system such as SAP. This makes it possible to connect

Starter projects to existing authorization groups of other systems. In this case, a login

dialog appears when opening GENIUS TOOLS Starter App and GENIUS TOOLS Project

Configurator.

Please note: Integrating an alternative authentication system with GENIUS TOOLS

Starter requires a subscription license.

Authentication is always global, i. e. can only be set in the group Standard. All other

settings may differ in the subordinate units.

In the menu item Configuration , go to the settings for GENIUS TOOLS Starter App to

change the authentication system. For Windchill, the required Authentication provider
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(EXE file) is supplied: select Auth_Windchill.exe from the drop-down menu. How to

proceed, as well as how to create an authentication provider for other systems, is

explained in the following chapters.

Setting to authenticate using Windchill (only globally possible)

Changing the authentication method restarts GENIUS TOOLS Starter App.

Switching from Windows user credentials to other authentication
methods
The user who changes the authentication provider is automatically saved as administrator,

i. e. becomes a member of the Administrator role. For this purpose, the new credentials

are requested before it is possible to save the database. 

The query of the login credentials fails in the following cases:

1. The user name and / or the password are wrong.

– An error message appears.

2. You are offline / user name and password are correct and were used during the last

login.

– A message appears that you are offline.

3. There is no EXE file in the auth_provider directory or it does not have a valid signature.

– GENIUS TOOLS Project Configurator and GENIUS TOOLS Starter App are closed.

Note that it is possible to save a new authentication method even without successfully

entering the credentials, namely by confirming the error message. If you want to make use

of this possibility, e. g. because you access GENIUS TOOLS Project Configurator externally,

make sure that you enter correct credentials and check the role assignments and function

accesses.

Warning: If incorrect credentials are saved for the new authentication method, you

may not be able to re-enter GENIUS TOOLS Project Configurator.

To avoid being permanently locked out of GENIUS TOOLS Project Configurator, you can

manually add your alternative authentication system user name or assign "Everyone" to

the Administration role. 
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Restoring authentication with Windows
If you have locked yourself out of GENIUS TOOLS Project Configurator when switching to

an alternative authentication system, you can use the last used database sut_*.db in

Caddepot under <OperatingEnvironment>\configuration\database\BackupDefaultAuth to

restore the operating environment.

5.10.1.1  Authentication provider

An authentication provider is an executable file that requests or receives user data from an

authentication system.

Any executable file in the auth_provider system folder is recognized as an authentication

provider. GENIUS TOOLS Starter addresses the authentication provider during the

following operations::

1. To authenticate login credentials when starting GENIUS TOOLS Starter App and

GENIUS TOOLS Project Configurator.

2. When querying static user entries.

3. When querying dynamic user entries from user groups. 

For Windchill, such a service is supplied: the file Auth_Windchill.exe.

Authentication provider config

GENIUS TOOLS Starter automatically writes a configuration file named

<AuthenticationproviderName>.cfg in the directory auth_provider. The content is the text

of the field Authentication provider config in the Authentication section.

If you use the supplied provider Auth_Windchill.exe, the Windchill server must be entered

in this field in the notation server=<Windchill-Server-URL>.

If you are creating your own authentication provider, you can enter additional information

required by the authentication system here. See next chapter.

5.10.1.2  Creating your own authentication provider

If users are to authenticate against a system other than Windows or Windchill, a separate

provider must be created. This can be selected in GENIUS TOOLS Project Configurator

under GENIUS TOOLS Starter App > Authentication.

An authentication provider is

– an executable file,

– which is signed and 

– stored in the system folder auth_provider.
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To create your own authentication provider, you need the following information for

output and input.

Input
GENIUS TOOLS Starter passes the following information to the authentication provider:

– username (from the login credentials)

– password (from the login credentials)

– path to the config file <AuthenticationproviderName>.cfg (see Authentication provider

config)

– transfer parameter -users (passed only when querying users)

– transfer parameter -groups (passed only when querying user groups)

Output
GENIUS TOOLS Starter expects the following output from the authentication provider:

For login

The output of the login result (point 1) must be done. All other output is optional.

1. Login result

1 – successful

0 – not successful (e. g. password and / or username wrong)

2 – special case: not successful, system is unavailable

2. Current user as JSON object with the following structure:

{"AlternateUserName1":"<GTS Alias Short>","Email":“<Email>“,"FullName":"<GTS Alias

Long>","Id":"<Id>","Name":"<username>"}

3. Result of the group query for the current user

1 – successful

0 – not successful (e. g. password and / or username wrong)

2 – special case: not successful, system is unavailable

4. List of groups for the current user as a JSON object with the following structure:

[{"Description":"Description of the group","Id":"Group Id","Name":"Group name"}, 

 {"Description":"Description of the group","Id":"Group Id","Name":"Group name"},

…]

User query

A user query in the GENIUS TOOLS Project Configurator imports users and creates static

entries.



123GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Hint: We recommend that you decide whether you will work with static or dynamic

user entries before creating users, as mixing both types of entries greatly reduces the

clarity in GENIUS TOOLS Starter.

1. Result of the user query

1 – successful

0 – not successful (e. g. password and / or username wrong

2 – special case: not successful, system is unavailable

2. List of all users as JSON object with the following structure:

[{"AlternateUserName1":"<GTS Alias Short>","Email":“<Email>“,"FullName":"<GTS Alias

Long>","Id":"<Id>","Name":"<Username>"},

 {"AlternateUserName1":"<GTS Alias Short>","Email":“<Email>“,"FullName":"<GTS Alias

Long>","Id":"<Id>","Name":"<Username>"},

…]

User group query

A user group query imports user groups with their associated users and creates dynamic

user entries. 

1. Result of the user group query

1 –  successful

0 – not successful (e. g. password and / or username wrong

2 – special case: not successful, system is unavailable

2. The user group output must consist of the following two lines per user group:

– Line 1: User group as JSON object with the following structure::

{"Description":"Description of the group","Id":"Group Id","Name":"Group name"}

– Line 2: A list of all users in the user group as JSON object with the following structure:

[{"AlternateUserName1":"<GTS Alias Short>","Email":“<Email>“,"FullName":"<GTS Alias

Long>","Id":"<Id>","Name":"<User name>"},

 {"AlternateUserName1":"<GTS AliasShort>","Email":“<Email>“,"FullName":"<GTS Alias

Long>","Id":"<Id>","Name":"<User name>"},

…]

In this way, all user groups must be output with their corresponding users.

5.10.1.3  Authentication for Windchill users

To change the standard authentication with Windows to Windchill, you can follow this

sequence of necessary steps.

1. Change global settings in the menu item Configuration  > GENIUS TOOLS Starter App

> Authentication.
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– In the drop-down menu, select: Auth_Windchill.exe

– In the field Authentication provider config, enter the Windchill server using the

notation: server=<Windchill-Server-URL>

2. Import users

– Decide whether you are working with static or dynamic user entries.

Static entries do not change automatically as dynamic user entries do. Changes to static

entries must be made manually for each entry in GENIUS TOOLS Project Configurator.

Dynamic user entries adopt changes from the system in which they have been created.

– Import static entries under Resources > Users using the import function  .

– Import dynamic entries under Organization > Access > Roles using the update

function.  .

3. Assigning users to a role

– Create a role.

– You assign static entries individually under Organization > Access > Roles > tab:

Details > section: Users (GTS).

– You assign dynamic entries through user group membership under Organization >

Access > Roles > tab: Details > section: Users (Authentication provider).

4. Editing users

– All user entries can be individually edited and commented. A photo can be added.

– Static entries can be deleted or locked under Resources > Users (GTS) > Editing users

– Dynamic users cannot be deleted or locked because they are associated with a user

group. A user group can be deleted or locked under Roles > tab: Details > section:

Users (Authentication provider) > User groups.

5.11  Configuring heterogeneous environments

IT landscapes very seldom have a homogeneous structure. There are different hardware

setups and different user requirements, so that different configurations for starter projects

arise automatically and heterogeneous environments have to be created. GENIUS TOOLS

Starter has been designed to meet these requirements and makes it possible, to organize

similar configurations into units and subunits. In this way, you may define the following

unit-specific configurations:

– settings for GENIUS TOOLS Starter App 

– settings for data synchronization

– use of license servers
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– PTC data management software (e.g. PDM Windchill for Creo), 

Differences from the standard configuration, that is, from the system-wide settings in the

unit Standard, can be defined for units and subunits  in the Configuration  page.

Unlike the unit Standard, all other units have members that can be entered individually or

dynamically. Use units to assign users dynamically through an LDAP connection. This is

done through a role-based assignment, see chapter Accessing Windows user

management.

A mouse click opens the settings for the selected a unit or subunit as well as for all higher-

level units. These can be hidden with the eye symbol. 

You may not make any specification, i. e. the selection field remains empty and values are

inherited. (See next chapter.) Fields that contain inherited information can be overwritten

by writing into the input field which then appear in black font.

Please note: If an input field inherits values from the higher-level configuration levels,

you will still only see the global default value displayed in

gray.

5.11.1  Inheritance of the settings

It is possible to overwrite the global settings (Standard) in the lower configuration levels. If

the input field of a unit or project remains empty, the setting of the higher configuration

level is adopted.

The specifications in units and projects are inherited as follows. (See also Call sequence for

settings.)

Hierarchy of settings made in GENIUS TOOLS Project Configurator
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Default settings
If settings in a drop-down menus remain empty, the default setting of GENIUS TOOLS

Starter will be inherited. This is "No".

Empty selection field

Please note: Default settings are inherited to the lower configuration level until

overwritten.

5.11.2  Deviations from the standard configuration

This sections explains how to define the language of Creo Parametric as a user-defined

setting as an example for configuring deviations from the standard setting.

5.11.2.1  Defining Creo language for specific users

Before Creo starts, the Creo UI language can be set to one of the following: English,

German, Italian, French, Spanish, Japanese, Chinese (Simplified), Chinese (Traditional),

Korean, Russian, Brazilian Portuguese. The languages are provided for Creo by PTC.

Please note: GENIUS TOOLS Starter does not influence the way different locale settings

interact. For information on supported settings, please refer to the PTC website or the

product documentation.

The UI language for Creo can be defined on four different levels in GENIUS TOOLS Project

Configurator. The language can be set on four configuration levels. If you make settings

on several levels, the last specification is valid, e. g. specifications in a project overwrite the

specifications of units, see Call sequence for settings.

1. System-wide

Main menu Configuration > Creo Parametric >  Standard > tab: Start > Startup settings

2. Unit

Main menu Configuration > Creo Parametric > Select unit > tab: Start > Startup settings

3. Group

Main menu Configuration > Creo Parametric > Select subunit > tab: Start > Startup

settings

4. Project

Main menu Projects > Select project > Creo tab > Startup
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The following example procedure refers to unit settings.

5.12  Unit settings

Having configured the standard settings, i. e. the global settings of the system, you can

now realize deviations from this basic configuration by making settings in the menu item

Configuration  for the different units and subunits of the organization tree.

It is also possible to define settings directly on the project, see Project settings.

Be careful to take into account the order in which the settings are inherited in GENIUS

TOOLS Project Configurator, see Inheritance of the settings.

5.12.1  GENIUS TOOLS Starter App

In the GENIUS TOOLS Starter App area you can set up the desktop link, the support and

basic presentations of projects.

For the presentation of individual projects as well as the tabs that contain additional

information and functions, please refer to Presenting projects to users.

5.12.1.1  Authentication

This setting can only be defined globally, i. e. for the Standard group, see chapter Global

settings: Authentication.

5.12.1.2  Configuring the desktop link

By default, a desktop link for GENIUS TOOLS Starter App is created automatically on the

application computers. You can define the properties of this desktop link in Project

Configurator, including centrally-defined start parameters.

To configure the desktop link, go to the Configuration page , select a group, then select

the settings item GENIUS TOOLS Starter App. Set Create desktop link to Yes. This setting

determines that the desktop link is created or updated according to the configuration with

each program start or synchronization process.

GENIUS TOOLS Starter App starts with the selection of the unit that was last selected by a

user.

Alternatively, you can specify that a desktop link opens GENIUS TOOLS Starter App with a

specific, pre-selected unit by defining the start parameter -gts:units with the ID string of a

unit. This means the user is given a default setting of a unit. If the user is not assigned to

this unit, the unit selection dialog will be displayed.
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The ID string is displayed under Unit argument and can be used for copying. If a user is

not assigned to this unit, the unit selection dialog is displayed.

You can define the following settings for the desktop link.

Name

You can define a name for the desktop link. Without an entry the desktop link will be

named GENIUS TOOLS Starter App - <operating environment name>.

Execution path

Enter the path GENIUS TOOLS Starter App should be run in.

Commandline arguments

Enter any start parameters that should be used by GENIUS TOOLS Starter App.

Warning: If you used start parameters in version 6.0.0, take care to move them to this

setting in Project Configurator. If the start parameters are not specified here, start

parameters in local links will be deleted!

Unit arguments

Shows the start parameter -gts:units and the ID chain of the unit.

Warning: If the start icon is located in the users\public\desktop directory, it cannot be

changed with user access rights. This means that the central icon definition cannot be

applied!

Custom icon graphic
If you want to use a custom icon graphic, you have to place a file of 265*265 pixel in the

_Images directory of the operating environment using the file name

<operating_environment_name>.ico.

5.12.1.3  Support link and logging

In the GENIUS TOOLS Starter App settings under General you can define whether users

should have access to the online support function of INNEO (TeamViewer) or to a

company-specific link or document. You can also hide the Support menu item altogether. 



129GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

u General

Hide support

Hides the menu item Support in the user menu item Help of GENIUS TOOLS Starter App.

No selection (Default): Users are referred to the Hotline website of INNEO.

No: The user sees the Support item in the menu.

Yes: The Support item is not visible.

Support

Enter the URL of a website or the path to a document. Set the above field Hide support to

No.

Log projects without permission

Projects to which a user has no access rights are by default not displayed in the log file.

Yes: Information about the projects is displayed in the log file.

No (Default): Projects are not included in the log file.

Write crash report to Caddepot directory

Unexpected errors are written to a log file by GENIUS TOOLS Starter App (gts_error.log).

The file can also be copied to the server and is saved there as

serveronly\_ErrorLog\<Computer_name>.log.

Yes: The client will copy its log file if an unexpected error occurs.

No (Default): The log file is only available on the client computer.

5.12.1.4  General display of projects

In the Projects area, settings are made for all projects that are available for the selected

group or unit. These settings concern the display of invalid projects and the possibility to

provide the language as a project option. They are described in the chapter Presenting

projects to users.

5.12.1.5  Operating environment clean-up

In the Cleanup of operating environment section of the GENIUS TOOLS Starter App settings

you can define whether an outdated operating environment should be deleted from the

application computers, that is, from the Cadpool directories. The operating environment in

the Caddepot is not affected. The user is asked to confirm before the deletion process is

started.
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5.12.2  Additional environment variables

You can define environment variables that are assigned to the client workstation under

Additional Environment Settings. This allows you to define additional, company-specific

variables that are available after starting an application without having to use batch files.

For a list of the environment variables created or modified, please refer to the installation

document (GENIUS TOOLS Starter Installation.pdf). The table in the installation document

also lists the corresponding deprecated environment variables, which are still being

generated for compatibility purposes.

Name

Enter the name of the environment variable here.

Value

Enter the value of the environment variable here.

Delete

Click the recycle bin icon to the right of the value input field to delete the line.

5.12.3  Synchronization

Synchronization allows for having all important files available locally on the local

workstation. This ensures the fastest possible access to these files. 

No toolkit applications will be synchronized while Creo is running.

Please note: Options that cannot be selected in this dialog box can be changed in

GENIUS TOOLS Environment Administrator.

Please note: If an input field inherits values from the higher-level configuration levels,

you will still only see the global default value displayed in

gray.

u General

Activate synchronization

Shows whether synchronization from the Caddepot to the Cadpool directory is active. If

synchronization is deactivated, all computers will only operate locally. Synchronization is

activated/deactivated with the Modify function of GENIUS TOOLS Environment

Administrator (Step 3 > Client settings).

Target directory

Defines the Cadpool directory on the client workstation.

Please note: Changing this entry leads to an initial installation of GENIUS TOOLS Starter

App on the client.
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Synchronization interval (minutes)

Specifies the interval at which synchronization is performed in minutes.

Please note: For modifications of the synchronization interval to take effect, GENIUS

TOOLS Starter App has to be restarted.

Start client with windows

Determines whether GENIUS TOOLS Starter App should be started automatically with

Windows. 

Save result to Caddepot directory

Determines whether the result of the synchronization should be transferred to the server.

This includes the end time of the last synchronization, the number of copied files,

warnings and errors. The user needs write access in the Serveronly folder. 

Yes: The result of the synchronization is saved as <hostname>.log in

caddepot\serveronly\_SyncResults.

No: The result is not transferred to the server.

u Server

Checksum validation

Shows whether the checksum of a synchronized file is matched with that of the file on the

server. The settings for validating checksums are entered in GENIUS TOOLS Environment

Administrator with the Modify function (Step 2 > Synchronization server settings).

Yes: A checksum is determined for each transferred file and matched with the checksum

from the server. If these differ, the file will be requested again.

No: Files are only copied.

Warning: Activating checksum verification can significantly slow data transfer.

Server name

Displays the name of the synchronization server.

Comment

Displays the description for the server.

Synchronization type

File system: Each file is copied when synchronized.

Service: GENIUS TOOLS Starter Service checks all files for changes and updates only

these changes during synchronization. 

Server path

The UNC path to the synchronization server.
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5.12.4  GENIUS TOOLS License Manager

In order to use the full version of GENIUS TOOLS Starter, you will need a connection to

GENIUS TOOLS License Manager. You can define the server from which GENIUS TOOLS

Starter App should obtain licenses. The specifications for license servers are possible for

the system-wide settings as well as for individual units.

Please note: If no license server is registered or if it is deactivated, only Creo projects

that have an academic or home-use license can be started.

u GENIUS TOOLS License Manager

Active

Activate/deactivate the license server(s).

License server(s)

Enter one or more license servers in the notation Port@Servername (e.g.

7766@<licenseservername>). Separate a series of license servers with semicolons.

Comment

An optional comment on the license server(s).

Hint: The used license server can be found in GT_LIC_SERVER in Creo. You can use this

variable, for example, in GENIUS TOOLS for Creo.

5.12.5  Network connections

u Network drive

Here you can connect a shared network folder that will not be synchronized.

Connect

Specify whether to map the network drive.

Yes: The network drive is mapped when GENIUS TOOLS Starter App is started. If a

drive with the specified drive letter already exists, this drive will be disconnected and

then re-connected according to the configuration, but only if it is not already the drive

to be mapped. This connection will remain active after you stop Creo.

No: Network drive is not mapped. Use this option if the drive mapping is already

established by other means, such as a Windows login script.

UNC path

Specifies the path to any folder on the server.

Usually given as a UNC path: \\COMPUTER\CreoData.

Drive letter

Assigns a drive letter that the drive is mapped to.
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Remap drive

Comparable to the Windows function map network drive.

Yes: After restarting the computer the drive will connect automatically.

No: The drive will not be remapped after a restart.

u User drive

Here you can map an additional user-defined drive.

5.12.6  CAD applications

The unit settings for the various CAD applications are explained in the corresponding

chapters:

– Creo Parametric

– Creo Elements/Direct Modeling

– SolidWorks

– Inventor

5.12.7  Windchill settings

For filling out this tab, read the chapter Automatic Windchill server registration. 

5.13  CAD-specific project settings

For all projects of CAD applications the following can be specified:

– a specific release 

– a project directory: This can contain project specific configuration and batch files.

– a data directory: This contains all object data.

For example, for Creo Parametric: <GTS_ROOT_DIR>\parametric\data\sut_creo9. (For

Creo Parametric, object data is provided with the Startup TOOLS product package).

– the startup behavior

– project-specific environment variables

Hint: We recommend to define settings at the highest possible configuration level, i. e.

to make as few settings as possible for individual projects. For example, individual

projects may only contain the version-specific settings. 

All other specifications differ according to the CAD application and are described in the

respective chapters under Project settings:
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– Creo Parametric

– Creo Elements/Direct Modeling

– SolidWorks

– Inventor

– AutoCAD

Installation directory
For projects of the CAD applications a specific software version can be defined. The

corresponding installation directory is specified in the application in the Configuration

menu item or searched for automatically.

There are three different ways  in GENIUS TOOLS Project Configurator of configuring the

installation directory and its start command:

1. Set a fixed install path on the Configuration page 

2. Set a fixed install path in the project

3. Via the local Windows registry on the application computer

Depending on your requirements, each way of defining the installation directory can make

sense. With several entries, the result is determined by the call order of the settings.

Configuration  u  CAD application

Configuration > CAD application > Select group or Standard > Tab: Application > Segment: 

Application > Install path  

Install path

– Specify a directory on the user computer where the CAD application is installed: This

allows the path to be inherited to projects, if "Given Path" is selected on the project

under Release and the entry is left empty. (see screenshot below, 1).

– Do not specify an installation path: This determines the installation directory

automatically from the local Windows registry and usses the software version from the

project details (2).

Please note: It is generally recommended to determine the installation path from the

local Windows registry.
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Projects  u  CAD application

For an individual projects you can now specify a software version (1) or enter a fixed path

(2). 

Projects > CAD Application > Select project > Tab: CAD application > Segment: CAD 

application  > Release: Select version or "Given path" 

These rules apply:

– GENIUS TOOLS Starter finds the installation directory of an application on the user

computer.

– Fixed path specifications are only necessary if the program is not automatically found.

– If you want to work with different versions or weekly versions, e. g. as a construction

service provider, this should be defined in the project.

– If the local installations are vary considerably or are not known in detail, the installation

can be determined with the help of the local Windows registry.

– If no installation directory is specified, it is read from the registry.

5.14  Making use of project options

Administrators can provide users with choices for a project ("Project Options"). These

appear as a drop-down menu or as a checkbox on all projects that are available to a unit.

Project options can be used to significantly reduce the number of projects. The following

project options can be provided.

– application language (drop-down menu)

– Creo startkey (drop-down menu)

– company-specific project options (checkboxes)
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Options of a Creo Parametric project

The following table describes three options and the procedure for their creation.

Function Description Configuration / creation

Language selects the language in which to start

the application

configured in GENIUS TOOLS

Project Configurator for all

application, see next chapter

Creo

startkey

selects the license package (PSF key)

with which to start a Creo Parametric

project

configured in GENIUS TOOLS

Project Configurator, see

Assigning Creo licenses to

projects

Company-

specific

project

option

activates license extensions,

additional programs or further

configuration settings

created with configuration

blocks for each application, see

Making use of project options

5.14.1  Language

You can grant user the right to can select the language of the projects they have access to.

If the right is not granted, neither selection field nor information about the set language

appears. If you want to provide users with information about this, you can include this in

the name of the project or in the subtitle, e.g. Creo Parametric 9.0. DE.

Language selection field
The right to select a language is granted in Configuration > GENIUS TOOLS Starter App >

Select unit >  Projects and applies to all projects. 
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Project language in GENIUS TOOLS Starter App selectable

Projects of CAD applications support the use of project options. In this area, you can set

up 

– the right to select the project language (drop-down menu in GENIUS TOOLS Starter

App)

– the arrangement of the checkboxes for license extensions, additional programs and

other configuration settings. To create this type of project options, consult the chapter

 Making use of project options.

Specify whether users are allowed to change the preset language, in which the programm

is to start. The language of a project can be preset in the Projects main page under CAD

application > Projects > Tab: Start > Startup settings > Language.

Please note: This option requires that the selectable language has to be available in

the programm installation used. This is not checked by GENIUS TOOLS Starter.

Yes: Users have the right to change the language of a project. If this options is

activated, a drop down menu will be displayed in GENIUS TOOLS Starter App.

No (default): Users cannot change the language. There is no information about the

language that the programm will start in.

5.14.2  Company-specific project options

Administrators can create company-specific project options. These become visible as

checkboxes in the project area of GENIUS TOOLS Starter App.

For projects of the CAD applications, the following company-specific project options can,

for example, be created.

Creo Parametric: additional applications GENIUS TOOLS for Creo, Model Processor User,

Keyshot, mapkeys license extension such as Simulation Live, AAX, Manikin

Creo Elements/Direct Modeling: none

SolidWorks: SolidWorks Composer (Add-in), drawing frames

Inventor: Additive Manufacturing (Add-in), drawing frames, read-only mode

A detailed description of the possibilities to use project options for the respective

application is described in the chapter Project Display in GENIUS TOOLS Starter App of

each CAD application.

Types of company-specific project options
A distinction is made between individual and combined project options as well as switch

options (in italics).
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Project options of a Starter project

Administrators can create project options by placing a basic or a conditional configuration

block in the required configuration layer. The table provides a general overview, while the

following chapters explain the procedure step-by-step.

Function Description Configuration / creation

Single project

option

is a configuration block

which contains one or

more configuration

settings

settings valid according to the call

hierarchy for files,

created with basic configuration blocks,

see Create single project options

Single project

option with key

symbol

is a configuration block

that activates license

extensions for Creo

Parametric or additional

programs

Combined

project option

combines configuration

settings from different

directories and

configuration layers,

after selection further

single project options

may become available

settings valid according to the call

hierarchy for files, if conditions are met

created with conditional configuration

block, see Creating combined project

options
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Function Description Configuration / creation

Switch option

(italic)

for all projects: switches

between different values

of one or more

configuration options

for SolidWorks projects:

activates additional

programs

settings valid according to the call

hierarchy for files,

created with basic configuration blocks,

see Creating switch options

You can specify the number of columns for individual project options and switch options,

see Arranging project options.

5.14.2.1  Single project options

A single project option can contain multiple configuration options, license extensions

and/or add-on programs.

Creating single project options
For each single project option that appears as a selectable checkbox in GENIUS TOOL

Starter App, a basic configuration block must be created, which must contain certain GTS

config variables. (See table below.)

Procedure: 

1. Decide to whom the project options should be available to, using the subdirectories

standard, units, projects or users of the configuration directory, see Directories of the

configuration layers.

2. Consider that all settings are processed according to the Call hierarchy for

configuration files.

3. Go the the desired directory, e. g.

<operatingenvironmentname>\<application>\configuration\projects\project_creo7p.

4. Create a single configuration block in this directory for each project option. The name

of the text file must comply with the application-specific specifications. (See step 5.)

5. Enter the following necessary GTS config variable as comment:

! gts_is_selectable = true for Creo Parametric configuration blocks,

; gts_is_selectable = true for SolidWorks configuration blocks and

<!-- gts_is_selectable=true --> for Inventor configuration blocks.
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6. Specify further GTS config variables in the file as required. The table below lists all

variables.

Take care to use the proper comment characters – they differ for each data type.

Application Configuration block

required (text file)

Com-

ment

charac-

ter

Example

Creo Parametric config_*.pro, config_*.sup ! ! gts_display_name =
Keyshot plugin

SolidWorks config_*.sldreg ; ; gts_display_name =
3DConnexion

Inventor config_*.xml, ui_*xml, *.addin <!--
-->

<!-- gts_display_name =
Additive Manufacturing -->

Result: A checkbox will be created below the project name in GENIUS TOOLS Starter App.

Example: Creating the project option "Simulation Live"  for a Creo Parametric

project

1. Choose the directory which controls the settings for the project (standard, units,

projects, users), e. g. :

<operatingenvironment>\parametric\configuration\projects\project_creo11p.  

2. Create a textfile with the name config_1_lic_sim_live.pro.

3. Enter the following specifications in the configuration file:

! gts_is_selectable = true

! gts_selection_default = true

! gts_creo_lic = 379

! gts_display_name = Simulation Live (Echtzeitsimulation)

! gts_selection_name = Simulation Live

! gts_selectable_pos = 3

Result: Display in of a checkbox for the "Simulation Live" project option in the project Creo

Parametric 11.0

gtpc_settingsApp_example.png
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Example: Creating the project option "FeedbackAddIn" for an Inventor project

1. Choose the directory which controls the settings for the project (standard, units,

projects, users), e. g.:

<operatingenvironment>\inventor\configuration\projects\inventor_23.  

2. Create a text file with the name Feedback.Inventor.addin.

3. Write:

<!-- gts_is_selectable=true -->

<!-- gts_selection_default=true -->

<!-- gts_display_name= FeedbackAddIn -->

<Addin>

<ClassId>{B99DB61B-F61E-4A56-AE2C-3FB608A2547D}</ClassId>

<ClientId>{B99DB61B-F61E-4A56-AE2C-3FB608A2547D}</ClientId>

<LoadOnStartUp>0</LoadOnStartUp>

</Addin> 

Representing single project options
The display of individual project options is controlled by GTS config variables.

Displaying a project option (see table for numbering)

The following table lists the GTS Config variables for the example in the above screenshot.

A full list of variables can be found in the appendix.

1 Creation of project

option

! gts_is_selectable = true

2 Preselection of project

option (checked box)

! gts_selection_default = true 

3 License extension (key) ! gts_creo_lic = 379
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4 Display name in Config

tab

! gts_display_name = Simulation Live(Real-time -

simulation)

5 Display name under

project

! gts_selection_name = Simulation Live

6 Position in selection list

(7the checkbox)

! gts_selectable_pos = 7

7 Text in tool tip of

license symbol (key)

! gts_creo_lic_display_name = Simulation Live

8 Text in tool tip of

project option (text)

! gts_description = Option contains simulation for

fluids for Creo 7.0 and newer. 

Options for Creo Parametric projects
For Creo Parametric projects you can create single project options that select license

extensions such as AAX or Simulation Live.

GTS config

variable

Specification /

Example

Description

gts_creo_lic = <licensenumber>,

e. g. 379 

Creo Parametric: License number(s) of the

extension(s) to be added. Multiple numbers

must be separated with empty space.

– if this entry is set, an icon key appears next to

the checkbox in the project

– license numbers can be read from the

license.dat file in the licensing folder under

PTC/FLEXnet Admin License Server

gts_creo_lic_displ

ay_name =

<text>, e. g.

Simulation Live

Creo Parametric: Tooltip text for license symbol

(key)  

– if not specified, the line under License name

is empty
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GTS config

variable

Specification /

Example

Description

gts_requires_base_l

ic =

<baselicense>,

e. g.

PROE_Foundation

Defines condition: if the base license is not

available, the project option will be deactivated,

i. e. no checkbox is displayed. 

– It checks if the base license is specified in the

PSF key.

– Multiple licenses must be separated with

empty space. The project option will be

deactivated, unless all of the listed licenses

are available.

gts_auto_activate_

base_lic =

<baselicense>,

e. g.

PROE_Foundation

Defines condition: If the base license is

available, the project option will be preselected,

i. e. the box is checked.

– Multiple licenses must be separated with

empty space. The project option will be

deactivated, unless all of the listed licenses

are available.

– Take care not to simultaneously set the

variable ! gts_selection_default to true. 

If the file is to control an auxiliary application, specify the corresponding configuration

option, such as a protkdat entry. (Example: protkdat

$GTS_ROOT_DIR\configuration\application\protk_keyshot.dat). These entries do not

create icons next to the checkbox.

5.14.2.2  Combined project options

Combined project options can contain configuration options, license extensions and/or

add-on programs. They offer possibilities that single project options cannot and are

particularly useful for companies with complex organization structure-

– With one click, several configuration options can be activated that are located in

different directories and levels. (Use case 1)

– Combined project options can be stored in directories other than the project directories.

(Use case 2) 

–  After the selection of a combined project option additional single project options can

be made available. (Use case 3 and 4)
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Users must activate the checkbox of the project option in GENIUS TOOLS Starter App. The

underlying configuration block is then read at project start.

1. Basics: Creating a combined project option
A combined project option appears as a selectable checkbox in GENIUS TOOL Starter App

after having created at least one conditional configuration block with a free tag ID. 

A free tag ID is an additional textual marking on a configuration block that defines a

combined project option and limits the validity of the block to it. The tag ID must not be

assigned to a unit, otherwise it can be freely choosen.

Example: config_lic.mbd.pro  – "mbd" is the free tag ID, if there is no unit called "mbd".

The functionality of a combined project option only comes into its own when you create

multiple configuration blocks with identical tag IDs. These are read across folders and

levels, i. e. the content of all configuration blocks with identical tag IDs is combined

(added). The following rules apply:

– The configuration options specified in the combined project option are read at project

start if all conditions set by tag IDs are met. 

– If configuration options conflict, the option is applied according to the Call hierarchy

for configuration files.

– The first configuration block with the free tag ID creates the needed checkbox of the

same name (here: mbd).

Use case 1: Different contents added across folders

Procedure: For one combined project option, assign one free tag ID to multiple files. The

first free tag ID creates the checkbox to select. 

1. Decide on which projects the project options should be available. Settings can apply

to all ("Standard") or to individual units, projects, or users. 

2. Go to a folder you selected in (1).

3. Create a text file with a meaningful free tag ID, e. g. mbd. The name must start with

config and end with .freetagid.pro, e. g. config_lic.mbd.pro.

4. Specify the required Creo configuration setting(s) in the file. 

5. Repeat this for all configuration blocks in all required folders and settings, for

example: 
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– config_abc.mbd.pro in the unit folder 

– config_lic.mbd.pro in the project folder

– config_mapkeys.mbd.pro in the user folder

Result: The combined project option "mbd" has been created, which contains Creo

configuration options from configuration blocks from three different configuration

levels.

2. Further use cases for one combined project option

2.1. Creating a combined project option with restriction to one unit

Combined project options can be restricted to one unit by adding a unit tag ID to a

configuration blocks with a free tag ID.

A unit tag ID is a textual marker that restricts the validity of a configuration block to a

unit. The difference to a config.pro module that is located in a specific unit directory,

project options with a unit tag ID can be located in all directories and can be activated by

selecting the unit – independent of the storage location.

A unit tag ID is assigned when creating a unit in GENIUS TOOLS Project Configurator, see

Using unit tag IDs.

Please note: A configuration block with a unit tag ID but without a free tag ID does not

generate a project option.

Use case 2: A project should have two different project options depending on the

selection of the unit available for selection.

Consult the example in Using unit tag IDs.

2.2. Creating a combined project option with restriction to several unit

A combined project option can be activated by multiple units, see Project options in a

multi-unit environment.

2.3. Creating a combined project option and further project options

You can create a combined project option that generates further single project options

after selection.

Before selecting "mbd" After selection of the combined project option 

mbd
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Use case 3: When the project option METAL is selected, three additional single

project options (X, Y, Z) are displayed

Procedure: For a combined project option, assign one free tag ID to multiple files and

write GTS Config.pro variables single project options in each of these files.

1. Decide the configuration levels for which the project option should be available, i.e.

system wide ("Standard"), individual units, projects or users. 

2. Go to a directory you selected in (1).

3. Create a configuration block with a free tag ID, e. g. Metall. The name of the text file

must start with config and end with .freetagid.pro, e. g. config_lic.metal.pro.

4. Write into this file the GTS config.pro variables

! gts_is_selectable = true

! gts_display_name = Cabling – “Cabling”  is the display name for the first single

project option that will appear after selecting the project option Metal.

5. Specify further required GTS config.pro variables and/or further Creo configuration

setting(s), see table.

3. Creating multiple combined project options
Each free tag ID creates a combined project option, hence, if two free tag IDs are used in a

file name, there are two combined project options to choose from, e. g.

config.mbd.plastad.pro. If there is no checkbox for selection yet, it will be created.  

The order of the free tag IDs does not affect the validity of the Configuration block. 

This case is typically used in connection with further project options (use case 4) or with

further configuration options (use case 5). 

3.1 Creating two combined project options that allow further project options

only after joint selection

Use case 4: When selecting the project options MBD and PLASTAD together, an

additional project option NC shall be displayed.

Initial situation: The configuration blocks config_lic.mbd.pro and config_lic.plast.pro

already exist.

Procedure: Write GTS config.pro variables to a configuration block to create a single

project option, and add the free tag IDs that already exist to the file name. 

1. Decide on which projects the two project option selections should be available

(Standard, unit, project or User).

2. Place a config.pro blokc (text file) in a directory you selected in (1).

3. Name the file config_lic.mbd.plast.pro.
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4. Write in the file the GTS-Config.pro variables

! gts_is_selectable = true

! gts_display_name = NC   – “NC”  is the display name for the checkbox that will appear after selecting the project options MBD and PLASTAD.

5. Specify further required GTS config.pro variables and/or further Creo configuration

setting(s), see table.

3.2 Creating several combined project options that set a configuration option

after common selection without allowing further project options

It may be useful to apply a configuration setting when two combined project options are

selected without allowing users to choose the setting.

Use case 5: When selecting the project options MBD and PLASTAD together, Creo is

to be started with the license extension NC.

Initial situation: The configuration blocks config_lic.mbd.pro and config_lic.plast.pro

already exist.

Procedure: Add the two existing free tag IDs to the configuration block that contains

information for the license extension.

1. Proceed as in use case 4, steps 1-3.

2. In the file config_lic.mbd.plast.pro specify the corresponding license extension in the

GTS config.pro variables, e. g. for NC-SHEETMETAL:

! gts_creo_lic = 116

5.14.2.3  Switch project options

Switch options are project options that toggle between two values of one or more

configuration settings, such as YES/NO or NORMAL/HIGH.

There are two use cases for switch options:

1. In SolidWorks projects: to start additional programs (AddIns)

Integration of 3DExperience Marketplace as a project option for a Starter project

2. For all projects: to switch between two values of several configuration setting without

having to provide two single project options. This is useful for setting multiple

configuration options, e.g. for display settings in Creo Parametric.



148GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Creating switch options
Switch options are not created by inserting a GTS config variable into a configuration

block, but by using the expression gts_choose. The code is:

gts_choose{ Key || true value || false value }

The value for Key is displayed as the name of the project option next to the checkbox in

GENIUS TOOLS Starter App. The value true value is read if the project option is checked,

otherwise false value applies.

The entire expression can be assigned to one or more configuration options.

1. Example for SolidWorks: Option to start the add-on program "3DEXPERIENCE

Marketplace" with a project

Procedure: The gts_choose expression must contain two values for registry entry.

1. Decide which users the project option should be made available to. Settings can

apply to all ("default") or to individual units, projects or users. Pay attention to the

configuration concept.

2. In the appropriate configuration directory, create a text file that starts with config and

ends with the application-specific extension .sldreg, e.g.

config_addin_experience.sldreg. (See also Configuration blocks für Solidworks .)

3. Write:
Windows Registry Editor version 5.00
[HKEY_CURRENT_USER\SOFTWARE\SolidWorks\AddInsStartup\{1A49690A-CC1F-4C81-
9B96-303C52F14AC3}]
@=dword:gts_choose{SolidWorks Composer||00000001||00000000}

Result: The checkbox SolidWorks Composer appears under the projects. When checked,

this AddIn is started with SolidWorks.

Please note: For integrating AddIns in SolidWorks projects write true value =

00000001 (starts the AddIn) and false value = 00000000 (does not start the AddIn).

2. Example for Creo Parametric: Option to minimize display settings for big

assemblies

Procedure: The gts_choose expression is set instead of the value of the configuration

option and must contain two values.

1. Decide which users should have the project option available. Settings can apply to all

(default) or to individual units, projects or users. Pay attention to the configuration

concept.

2. In the appropriate configuration level directory, create a text file that starts with

config and ends with the extension .pro, e.g. config_switch_bigass.pro. (See also

Configuration blocks für Solidworks .)
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3. In the file, enter the gts_choose expression instead of the value of a configuration

option, for example: 
display_points gts_choose{big assemblies || NO || YES }

Switching values for the Big assemblies option

Result: The key Big Assemblies creates the checkbox of the same name below the

project. If the option is checked  (true value), the gts_choose expression is replaced by

the corresponding value (e. g. NO). 

Hint: The switch expression can be written in two ways:

display_points gts_choose{Große Baugruppen || NO || YES }

or

gts_choose{Große Baugruppen || display_points NO || display_points YES}

Deleting switch options in GENIUS TOOLS Starter App
In contrast to single project options, a value will be read from a switch option even if the

option is not checked (disabled state = false value).

For users who have the right to deactivate configuration blocks in the Config tab of

GENIUS TOOLS Starter App, this means: 

1. Deactivating the configuration block will ignore the content of the configuration block,

i. e. as with all configuration blocks, it will not be included into the configuration.

2. In contrast to single project options, the checkbox of the switch options then

disappears, because neither the checked (true value) nor the unchecked setting (false

value) is to be used for configuration.
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Only checked configuration blocks (in the Config tab) generate checkboxes for switch options

5.14.2.4  Overview of project options by application

The following table lists examples of popular project options for each CAD application and

the configuration blocks needed to create them.

Additional programs Optional

configuration settings

Special feature

Creo

Parametric

GENIUS TOOLS for

Creo, Model Processor

User, Keyshot

– single project option

– use config_*.pro file

mapkeys

– single project option

– use config_*.pro file

switch between two

values

– switch option

– use config_*.pro file

license extensions such

as Simulation Live,

AAX, Manikin

– single project option

– use config_*.pro file

with license number(s)

Creo

Elements/

Direct

Modeling

— — —

SolidWorks SolidWorks Composer

– switch option

– use config_*.sldreg

file

drawing frames

– single project option

– use config_*.sldreg

file

—
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Additional programs Optional

configuration settings

Special feature

Inventor Additive

Manufacturing

– single project option

– use *.addin file

drawing frames

– single project option

– use config_*.xml file

read-only mode

– Special case: set in

GENIUS TOOLS Project

Configurator, like

language selection

5.14.3  Special cases

Inventor
For Inventor projects, it is possible to specify in GENIUS TOOLS Project Configurator

whether users can select to open the project in read-only mode. With this setting, the

checkbox Read-only mode is displayed in the project area. See Read-only mode.

Option to start read-only mode in GENIUS TOOLS Starter 

App

5.14.4  Arranging checkboxes

Single project options and switch options can be selected in checkboxes below the project

name as well as in the Project options tab. The tab can be opened with the arrow symbol,

which becomes visible if some checkboxes cannot be displayed below the project. 

For displaying project options, such as display name, tooltip and position, can be defined,

see Single project options.
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The display of the checkboxes can also be affected by specifying the number of columns.

The default setting is four columns.

Procedure for arranging checkboxes for single and switch options

1. Open GENIUS TOOLS Project Configurator.

2. In the menu item Konfiguration  got to the item Settings.

3. Select a unit, or choose Standard for global settings. 

4. In the the segment Options specify the number columns, here: 2

Settings in GENIUS TOOLS Project Configurator

Result: The checkboxes are arranged in two columns below the project name in GENIUS

TOOLS Starter App.

Display in GENIUS TOOLS Starter App

Please note: The arrangement of project options requires a subscription license.

5.15  Apps-Projects: Creating projects of other applications

In the sub item Apps you can create projects with any other program. For such Apps

projects you can only create one project per application, whereby the latest version is

used.

For Apps projects only simplified settings are available, but specifications from

configuration blocks and batch files can be made, as for all programms, in the four

configuration layers of the directory application. 
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After filling in the general project settings (2), specify the required project and data

directories (3) and the startup behavior (4).

Dialog box for Apps projects

In the GENIUS TOOLS Starter App, you can set the order of the projects for the users by

dragging and dropping the projects. The Change sorting button (5) in the Projects column

sorts the projects in the application alphabetically by display name.

u App

Project directory (optional)

Directory below application\configuration\projects. Batch files are copied from this

directory to the  user computer and executed at project start.

Data directory (optional)

Directory below application\data. From this directory data packages are copied to the user

computer and applied at project start.

u Startup settings

Executable file

– Enter the file that is to be started. It can either be an executable file (such as *.exe, *.bat)

or a file for which a standard application is available on the computer (such as *.docx,

*.html). A command line (cmd) shell or cmd shell application will be executed visibly by

following commands:

– do not stop cmd after execution: start cmd /K "%1"

– stop cmd after execution: start cmd /C "%1"

– If a website is to be called, enter the following command: cmd.exe

Command line arguments

– Enter commands that specify how the executable file is started. Set the commands in

quotation marks.

– If a website is to be called, enter it with the following scheme: /c start
https://www.inneo.co.uk
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Startup folder

Select the startup directory. 

The information about the startup behavior and the required directories are displayed for

each project in GENIUS TOOLS Starter App in the Info tab.

5.16  Auto projects

Auto projects are Starter projects of an application for which only one project can be

created. This project will be automatically created by GENIUS TOOLS Starter App with the

latest available software version on the user computer and will be displayed with an icon

of the application. 

Auto projects are generated from the following applications: Creo Elements/Direct

Drafting, Creo Illustrate, Creo Schematics, Creo View, GeomagicDesignX, Keyshot and

MathCad.

Please note: Auto projects are only available with a subscription license.

The applications are automatically searched on the user computer. If several versions are

installed, the latest version will be used. If the application is not installed on the user's

computer, the Auto project will not be displayed.

Auto projects can, like all projects, be configured in the four configuration layers

(standard, units, projects and users). For each Auto Project, a new folder structure is

created for this purpose which includes a project directory. In GENIUS TOOLS Project

Configurator, they are listed in the Project collections page .
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Individual Auto projects can be hidden in the user interface of GENIUS TOOLS Starter (5).

You can also hide all Auto projects for specific user groups (roles) in the user rights.

In the main page Project collections you can set the display of the Auto projects in GENIUS

TOOLS Starter App, see next chapter.

5.17  Project collections

In the main menu item Project Collections you can organize individual projects into

collections, which are displayed to users in GENIUS TOOLS Starter App. This is especially

helpful for companies that work with many projects. 

Warning: Creating collections for projects requires a subscription license. If you create

a project collection without having a subscription license, you will not be able to

continue using GENIUS TOOLS Starter with a perpetual license.

The order of both collections and individual projects can be defined here by using drag

and drop.

Project collections are displayed to all users, but within a collection only those projects a

user has access to are displayed. If a user has no access to any of the projects, the button

for the collection will not be displayed. 

A distinction is made between company-specific and application-specific project

collections. You can create company-specific project collections and assign individual

projects. Application-specific project collections, on the other hand, already contain all

projects that have been assigned to the an applications in the menu item projects, i. e.

Creo Parametric, Creo Elements/Direct Modeling as well as Apps projects

Company-

specific project

collection

Application-specific project

collection

Collection can be created and

deleted

yes, see below no

Collection can include any project yes no, contains all projects of an

application, 

– Creo Parametric

– Creo Elements/Direct

Modeling 

– or Apps projects
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Company-

specific project

collection

Application-specific project

collection

Individual projects can be added

and deleted

yes no

In addition, this area lists all auto projects, which are displayed automatically.

Creating a new project collection
Create a company-specific project collection by clicking the Plus button Add (1).

Application-specific project collections as well as auto project are generated automatically

and cannot be created nor deleted.

Displaying project collections to users
In the Details dialog (2) on the right, fill in how the project collection should be displayed

in GENIUS TOOLS Starter App.

For application-specific project collections and auto project display names and comments

cannot be edited.

Display name

Enter a name for the project collection. The name of a project collection must be unique.

Duplicate names for project collections are not permitted
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Description

Enter an optional description for the project collection

Image

A collection can be fitted with an image file in JPG, PNG or SVG format. 

Color

A collection can be displayed with an individual color for better visualization.

Hide (3) 

No (default): The project collection is displayed in GENIUS TOOLS Starter App.

Yes: An project collection is not displayed.

Define order (5)

Put projects in the order needed by using drag and drop.

Adding projects to a collection
You can add single projects only to company-specific collections.

The visibility of a project in GENIUS TOOLS Starter App is defined by the affiliation of a

user to a unit and the access rights granted.

Add (4)

Add projects that have been created in the Projects menu item.

A window will open where you can select, search and sort projects.
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Delete

Select a project to delete it.

Search

Search a project by keywords.

User-defined project collection
With version 11.0.0.0, users have the option of marking individual projects as favorites,

which are listed in GENIUS TOOLS Starter App under Favorites, see chapter GENIUS TOOLS

Starter App > Favorites.

5.18  Presenting projects to users

The display of projects in GENIUS TOOLS Starter App can be defined for a unit, subunit or

for individual projects.
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Unit settings
In the menu item Configuration of GENIUS TOOLS Project Configurator, settings are made

for all projects that are available for a unit. These are.

– the display of invalid projects as well as

– the option of providing the language selection as project option.

The menu item Resources lets you control what information about a project or additional

features, such as license analysis, are made available to users, see Providing project

information.

Project settings
In the menu item Projects, individual projects can be provided with an icon and an

additional line of information, see General project settings.

Projects can contain selectable options that are created with configuration blocks, see

Project options.

You can also restrict access to a project to certain units. To do this, assign the permitted

projects to this unit, see Restricting project access

Project collections
The menu item Project collections allows you to group individual projects into collections

and define their order, see Project collections. Project collections can be provided with an

individual colored bar and an icon.

Projects from the “My Projects” collection in GENIUS TOOLS Starter App
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5.18.1  Marking invalid projects

You can control whether users can open projects for which they do not have a license or

the required license extensions.

The following actions and warning colors can be set in the menu item Configuration >

Group (select) > Settings: GENIUS TOOLS Starter App > Segment: Projects. The warning

colors are only displayed after a project has been clicked upon or after activating the

Analyze licenses function in the Licenses tab of the GENIUS TOOLS Starter App.  

u Projects

Display warnings

Warnings appear for projects e. g. without a valid license (Creo Parametric, SolidWorks).

No: No warnings are issued.

Yes: Projects are marked with a yellow bar. The Warning tab appears.

Display invalid projects

Specifies how projects that cannot be started with GENIUS TOOLS Starter, e. g. because no

PSF key is found, are displayed to the user.

No: Projects are hidden.

Yes, as error (default): Projects are marked with a red bar. The Error tab appears.

Yes, deactivated: Projects without are displayed marked a gray background. The Error

tab appears.

Please note: Projects for which no corresponding software version can be found are

never displayed.

Warnings
Project settings can cause warnings other than missing licenses, e. g. if the project

directory cannot be found. The project bar will then be orange and a flag icon appears,

which opens the Warning tab.



161GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

5.18.2  Customizing project information

The info area opens when a project is selected. The info icons open tabs with the

corresponding information.

All projects display the Info tab. The Error and Warning tabs are displayed when an error

has occurred or a project warning has been issued. The other tabs – Licenses, Config,

Project Options and Backup – differ depending on the application, see the respective

chapters in GENIUS TOOLS Starter App.

Selected project with open Info tab

Most info icons and tabs can be hidden by the administrator in GENIUS TOOLS Project

Configurator under Organization > Access > Role > Tab: Function access. Consult the

chapter Granting function access for detailed instructions.

Function Description Configurable under

Function access?

Warning warning icon appears only if project

settings trigger a warning,

opens Warning tab

no

Information opens Info tab with

– project name

– path to project, data and working

directories

– language, and more

button and tab can be

disabled with Can see

project information
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Function Description Configurable under

Function access?

Licenses opens Licenses tab

– shows licenses and license servers

– button for analyzing licenses

– button for access to the license

borrowing process

button and tab can be

disabled with Can analyze

licenses, see Displaying

license details

Configuration

blocks (Config)

opens Config tab

– lists all used configuration blocks

(config files) and additional applications

(Toolkit Application) in the selected

project

– configuration blocks can be opened by

double clicking 

button and tab: no

users can be granted

rights: 

Can open configuration

blocks

Can deactivate

configuration blocks,

see Editing configuration

blocks

Configuration

blocks (UI)

opens UI tab in Inventor projects

– lists lists all used configuration blocks

(ui files) and

– behavior like config tab

like Config tab

Backup opens the Backup tab

– users can create a backup of user-

specific settings

– für Creo Parametric: displays the

customization.ui file, see Backup

mechanism in GENIUS TOOLS Starter

App.

button and tab can be

disabled with Can save

user specific settings /

customization.ui file

Project report Creo Parametric:

opens PDF file containing all information

about the selected project

button can be hidden with

Can create project report

GENIUS TOOLS

Starter App

Config Analyzer

Creo Parametric:

opens separate utility to view and edit all

configuration blocks and batch files used

for the project and their location.

button can be hidden with

Can analyze project
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5.18.3  Displaying license information

The Licenses tab is available for projects of Creo Parametric and SolidWorks. It contains

information on the license servers assigned to the selected project as well as functions to

analyze and borrow licenses, if the users have been granted the corresponding access

rights.

Licenses tab before analyzing licenses

Licenses tab after analyzing licenses
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1. Display license servers
All license servers are listed to which a project has access to.

Visibility: License servers are displayed when Analyze licenses button is enabled.

2. Analyze licenses
Pressing the button  shows all available licenses and extensions as well as the time that

has passed since the last analysis.

Settings: The functions 1 and 2 belong together and can be switched on or off with two

settings in GENIUS TOOLS Project Configurator.

– Configuration > Creo Parametric Settings > Select unit > Tab: Start > Section: Licenses >

Display Licenses to Yes/No

and

– Resources > Select role > Tab: Function access > Section: Projects > Can analyze

licenses. 

3. Borrow licenses
The button  opens the Borrowing dialog.

Settings: Organization > Access > Select Role > Tab: Function Access > Section: Projects >

Can borrow licenses: Yes/ No. 

Creo Parametric

GENIUS TOOLS Starter App borrows its license and then starts the borrowing process from

PTC. Then Creo and GENIUS TOOLS for Creo - if configured in the project - each borrow

their licenses, see License Borrowing Process.

The default and maximum borrowing duration can be preset in Projects > Creo Parametric

> Select project) > Tab: Start > License borrowing

SolidWorks

SolidWorks licenses are borrowed directly from SolidNetWork License Manager Client.

5.18.4  Editing configuration blocks

In the Config tab, users can view and may edit configuration files which configure a

project, so-called configuration blocks.
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1. Open / edit configuration blocks
Double-clicking on a line will open GENIUS TOOLS Config Editor. For this, the user must

be granted the access right Can open configuration files from Starter App, see chapter

Granting function access rights.

2. Disable / enable configuration blocks
Activated configuration blocks are used for the project configuration. For being able to

check the corresponding box, users must be granted the access right Can disable

configuration blocks, see chapter Granting function access rights.

3. Edit personal settings
Users have the ability to edit their local configuration block and write it back to the

administration computer in the userdata directory, see next chapter.

5.18.5  User-driven configuration

Users may overwrite or append the settings established by the administrator, by managing

private configuration blocks on their own. To do so, private configuration blocks must be

saved in the userdata directory to which the user needs to be given write access.

The private configuration blocks in the userdata directory are appended to the

configuration blocks in the users, projects, units and standard directories, i.e. they

overwrite the entries made there. See also the chapter Call sequence for files.

Special characteristic of Creo Parametric configuration blocks

The personal Config_*.pro file is attached to the Config_*.pro files in the users, projects,

units and standard directories as a supplement. The user-defined Customization_*.ui file,

on the other hand, replaces the Customization_*.ui files in the other directories.

Userdata directory
There are two ways to provide users with a userdata directory.

– The Userdata directory is located in the Caddepot of the administration computer, from

where it is synchronized to the Cadpool on the user computer. Users can use the
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directory with their Windows user name in the Userdata directory. For this the userdata

directory must be located under GTS_ROOT_DIR. (See chapter Directory structure.)

– A userdata directory can be set up on any location on the client computer where it does

not undergo data synchronization. 

Defining private configuration blocks
Administrators specify the path to the user data directory and the spelling of the file

names of the configuration blocks in GENIUS TOOLS Project Configurator.

Procedure using SolidWorks as an example

1. In the menu item Configuration, go to SolidWorks under Settings. 

2. In the Application tab, go to the User Settings section.

3. In the field Private configuration folder, enter the path to the userdata directory.

4. In the field Private configuration block, specify the notation for the configuration

module, here for an SLDREG file: config_%username%.sldreg. (There is an overview of

the file endings in the chapter Configuration blocks.)

Application tab in the configuration settings for SolidWorks

Result: The section in the Config tab is visible when an SLDREG file is in the userdata

directory.

Display of a private configuration block in 

GENIUS TOOLS Starter App

Editing private configuration blocks
Users can edit their local, private configuration module in GENIUS TOOLS Starter App. A

double click opens the file.
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The Upload button  is used to write the configuration block back to the administration

computer in the userdata directory. The button is visible if the user has the access right

Can save personal configuration blocks to server.

Please note: Data synchronization must be paused during editing.

5.19  Creo Parametric

A configured Creo Parametric project consists of the following components:

– a defined Creo release or weekly version

– the licenses to be used (Creo-Startkeys)

– configuration blocks for settings of 

– functions and behavior of Creo Parametric (config_*.pro files) 

– user interface ((config.ui)

– additional applications, toolkit applications (GENIUS TOOLS for Creo)

– settings and link-ups for additional applications (batch files)

– Windchill availability in the Creo Parametric session

– start object templates, drawing frames

– project libraries

– plot settings

– ModelCheck configurations

– and many other settings relevant to working with Creo, such as 

– data referenced in the configuration files (colors, materials, templates etc. in the

data directory)

– data for other tasks (information documents, additional tools)

Data packages and configuration directories
A project configuration consists of Creo object data – filed in the data directory – and Creo

configuration files, which can be stored in any of the project-relevant directories standard,

units, projects and users. Separating the Creo object data from the Creo configuration data

and the additional applications ensures that Creo objects in an operating environment can

be used in multiple projects.

Both Creo object data and project-specific configuration files for several Creo versions are

included in the product package Startup TOOLS.

For Creo Parametric the configuration for a Starter projekt is made up by the following

directories:

1. Data directory:

<GTS-OperatingEnvironment>\parametric\data

The data directory is a system directory under which all object data for an application can

be found, the so-called Creo data packages.
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The directory configuration contains the directories standard, units, projects and users.

Their behavior applies to all applications, see directories of the configuration layers and

the call sequence.

2. Standard directory

<GTS-OperatingEnvironment>\parametric\configuration\standard

3. Unit directory:

<GTS-OperatingEnvironment\parametric\configuration\units\%GTS_UNIT_DIR_NAME%

4. Project directory:

<GTS-OperatingEnvironment\parametric\configuration\projects\%GTS_PROJECT_DIR%

5. User directory:

<GTS-OperatingEnvironment\parametric\configuration\user\%USERNAME%

Please note: In order to work with data for other CAD systems in the future, the entire

directory structure has been changed in version 9.0.0 of GENIUS TOOLS Starter. Consult

the comparison of the old and new directory structure. The adjustment of the paths is

done automatically during an update. 

Installation directories of Creo
There are different ways to specify an installation directory and its start command. These

are described in the chapter CAD-specific project settings.

Consider the following criteria:

1. If you want to make sure that each application computer throughout your company

uses the same Creo version, configure the Creo installation directory for the Standard

group in the Configuration page. In this way, you will not have to specify it for each

project.

2. If a variety of versions or weekly versions is in use, for example because you are

providing services for different customers, configure the Creo installation directory in

each project.

3. If local installations are inconsistent or not known in detail, fall back on the local

Windows registry to determine the Creo installation directory. You can specify which

Creo version to look for, the highest weekly version for which will be used.

Please note: It is generally recommended to determine the installation path via the

local Windows registry.

5.19.1  Configuration and batch files

For Creo Parametric projects  you can create configuration blocks and place them in the

configuration levels where they will be processed according to the call hierarchy for files,

see chapter Configuration concept.
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All batch files can be used, see also chapter Batch files.

5.19.1.1  Creo configuration files

The behavior of Creo Parametric is largely determined by the configuration file config.pro.

This is a text file storing all settings that determine how Creo Parametric runs. 

Settings in config files are called configuration options – the calculation accuracy is, for

example, set by the command enable_absolute_accuracy yes.

The config.pro file of Creo can be located in three different folders: 

– in the text directory (<installdir>\Common Files\text),

– in the home directory,

– in the user directory (start directory of the user).

In this order Creo copies the configuration options defined there to a single config.pro

file. If a configuration option is set more than once, the last entry is the valid option value,

i. e. the config.pro file is read from top to bottom.

Configuration options can also be specified in another configuration file, the config.sup

file. The options set there cannot be overridden by the options in the config.pro file. 

The following configuration files determine the settings for a Creo application.

Configuration file Function

config.pro crucial configuration file of Creo

contains settings for a user, e. g.

– appearance of objects and of the graphics window

– behavior when creating, saving or opening objects

– units, tolerances, search paths and default directories

– printing, import and export settings

– settings for optional modules such as Pro/NC, Pro/Sheetmetal,

Pro/Mold

– layers and mapkeys

If a configuration option is not defined, the default value will apply

to Creo.

config.sup contains settings that the user may not modify, i.e., that cannot be

overwritten by the config.pro file, for example to ensure drawing

standards

config.val contains validation settings for data import
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Configuration file Function

creo_parametric_cus

tomization.ui

contains UI customizations for a user

creo_parametric_ad

min_customization.u

i

Created by administrator, contains UI customizations

5.19.1.2  Configuration blocks

By using GENIUS TOOLS Starter, configuration options are not written to the Config.pro

file of Creo, but to different fragmented configuration files of GENIUS TOOLS Starter,

called configuration blocks.

A configuration block for Creo Parametric:

– is a text file that must start with "config_" and 

· end with ".pro", e.g. config_sut_de_c6p_dir_file.pro, config_c8p_mapkeys.pro or

· end with ".sup", e. g. config_de.sup.

– is one of many configuration files that are read by GENIUS TOOLS Starter and converted

into a config.pro file for starting Creo,

– can contain one or more multiple Creo configuration options, i. e. settings for users,

– is not to be mistaken for the config.pro file of Creo, which exists only once,

– is also called config file.

Configuration blocks are created manually and distributed to the desired configuration

layers: standard, units, projects and user. Thus they provide company-wide settings as well

as settings for specific departments and projects. Take note of the Call sequence for files

There are two types of configuration blocks: simple and conditional, see Types of

configuration blocks.

Create configuration blocks (.pro) for Creo Parametric
1. Create a text file in the desired configuration directory starting with config_ and ending

with .pro. 

2. Write the configuration options for Creo Parametric.
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Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,

configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks using the add-on program

GENIUS TOOLS Config Editor, which provides color highlighting, auto-completion and

error messages.

Example: Configuration settings for welding

Create a text file with the name config_c9p_welding.pro. Write:

pro_weld_params_dir $GTS_DATA\library_dir\weld_params_dir

weld_fillet_preferences_file $GTS_DATA\library_dir\weld_params_dir\iso.spwx

weld_plug_slot_preferences_file $GTS_DATA\library_dir\weld_params_dir\iso.spwx

add_weld_mp yes

weld_color 100 50 0

weld_ui_standard ISO

weld_ask_xsec_refs no

weld_dec_places 3

weld_edge_prep_driven_by PART

weld_edge_prep_groove_angle 45

weld_edge_prep_groove_depth 6

weld_edge_prep_instance YES

weld_edge_prep_root_open 1

weld_edge_prep_visibility GENERIC

weld_geom_type_default SOLID

Example: Create single project option for additional application GENIUS TOOLS for

Creo

Create a text file with the name config_1_lic_sim_live.pro. Write:

! gts_display_name = GENIUS TOOLS for Creo

! gts_selection_name = GTFC

! gts_selection_default = true

! gts_is_selectable = true

protkdat $GTS_CONFIGURATION_DIR\application\protk_gtfc.dat

When creating single project options, note that an exclamation mark (!) must be used as a

comment character, e. g. ! gts_is_selectable = true. See chapter Single project options.

As well as the file protk.dat GENIUS TOOLS Starter supports the file creotk.dat.

5.19.1.3  User-driven configuration for Creo Parametric

Users may manage configuration blocks on their own, if granted the appropriate right,

and are thus able to overwrite or append the settings established by the administrator.

This is often done, for example, when working with user-defined mapkeys.
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For a user to administer his or her own settings the configuration files have to be saved in

the userdata directory, see chapter Userdata directory.

Define the storage location in GENIUS TOOLS Project Configurator under  Configuration >

Settings: Creo Parametric >  Select a group > Tab: Application > User settings, as well as the

notation of the private configuration block.

Entering path to the userdata directory and file names

u User settings

Configuration folder

The configuration files of each user can be stored in the directory userdata.

Private config.pro

Name of a user-defined config.pro file, e. g. config_%username%.pro. It is appended to the

config_*.pro files in the users, projects, units and/or standard directories.

Please note: For storing their private config.pro file, users must have write access to

the userdata directory, as well as the access right Can save personal Config.pro file [to

userdata directory] on server. See also Backup tab in GENIUS TOOLS Starter App.

Private customization.ui

Name of a user-defined customization.ui file, e. g. config_user.ui. It replaces any

customization.ui file in the users, projects, units and/or standard directories. See also

Backup tab in GENIUS TOOLS Starter App.

5.19.2  Use in complex organizations

For companies with complex structures GENIUS TOOLS Starter offers advantages through

the following functions.

Company structure GENIUS TOOLS

Starter Functions

Procedure

Global distribution

of locations

Working with satellites See Installation Manual, chapter

GENIUS TOOLS Starter Service.

Working with Units Creating units
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Company structure GENIUS TOOLS

Starter Functions

Procedure

Many departments

and

subdepartments

Map organizational

structure

Creating subunits

Complex

configuration for

license distribution

Optimize Creo license

distribution

Distribute Creo start keys (PSF key)

automatically to user computers

1. Define license server

per project

Define license server per project

2. Assign multiple base

licenses or packages to

a project

Provide several Creo start keys (PSF

key) for selection in the project

3. Assign selectable

license extensions to

individual projects

Create project options with

configuration blocks

Many additional

applications

Selectable options per

project

Create project options with

configuration blocks

5.19.3  Allocating Creo licenses with GENIUS TOOLS Starter

Companies that only have a few workstations may be able to maintain license files at each

workstation individually, but as corporate structures grow this will be a tedious task:

different workstations require different licenses, the expiration of licenses must be

monitored, but most importantly an efficient assignment of licenses and license extensions

to projects becomes difficult.

With GENIUS TOOLS Starter you can:

1. Specify license servers

You can assign one or more license servers to a project. 

2. Assign licenses and license extensions to a project

Creo licenses can be made available to users in various ways, especially to minimize the

number of projects and provide choices for users. See chapter Optimally assigning

licenses.
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3. Distribute Creo startkeys (license keys, PSF keys) automatically

You can distribute Creo startkeys automatically to all user computers. GENIUS TOOLS

Starter copies all PSF files located in the configuration folder (Cadpool) of the user

computer to the bin directory of the Creo installation folder. Alternatively, only those PSF

keys that control a specific project can be copied. See chapter Start.

Automatic copying is greatly beneficial when changes are made to the PSF keys as the

maintenance effort is reduced significantly. 

4. Work offline by license borrowing

Borrowing licenses for a certain period of time is especially advantageous for mobile

working. Users who have the right to borrow licenses can see the button  in the Licenses

tab in GENIUS TOOLS Starter App and can use it to start the license borrowing process of

PTC. 

5.19.3.1  Basic information

This chapter introduces Creo licenses and Creo startkeys.

Creo licenses

When purchasing Creo Parametric software from PTC, you receive a FlexNet license key

(license key for FlexNet). This consists of the name of the base license and – if available –

the numbers of the license extensions (modules), e.g. #116 for NC-SHEETMETAL, #339 for

Mold Analysis.

1. Creo Parametric base license, e. g. Creo Foundation (PROE_Foundation)

– is necessary to start Creo Parametric

– depending on the purchased product, a base license can contain a list of modules and

is then labeled base license package, e. g. Creo Advanced XE

2. Creo Parametric license extensions (also called license key features), e. g. Plastic

Advisor (134)

– extends a basic license (package) with functions

– can be purchased separately

– always requires a base license package

– a license extension package contains several license extensions, e. g. Creo Advanced

Assembly Extension (AAX)

Creo Parametric – together with the previous products Pro/ENGINEER and Wildfire – has

been on the market for over 30 years. During this time many modules have been created

and many products were sold by PTC and resellers. In addition, countless product

packages were created as part of sales initiatives. Thus, it is hardly possible to keep track
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of all basic license packages and their diverse functions. As a result, all long-time users of

Creo Parametric have a different license key architecture.

The following table lists some examples of products and their license keys.

Product Description License key

Creo Foundation Base license PROE_Foundation

Creo Advanced SE Basic license package with

the additional modules

Surface, Design Animation,

Modelcheck, Mold Analysis

Lite and others

PROE_AdvSE

Creo Advanced XE with AAX Basic license package with

the additional modules

Assembly/AAX and other

modules

PROE_FAPAAX

Assembly License extension 6

Creo Advanced Assembly

Extension (AAX)

License extension package

with Notebook (0),

Assembly (6), Process for

Assemblies (97), WebLink

(108), Creo Layout 3D

Integration (292), Creo

Options Modeler Basic (329)

PROBUNDLE_10119

0,6,97,108,292,329

Administrators of Creo Parametric have the task of correctly assigning existing as well as

newly purchased licenses to users. In other words, administrator are faced with a license

structure and have to set up the Creo Parametric startup options, i.e. the Creo startkeys,

accordingly.

Creo startkeys (PSF keys)

A startkey is a configured start command that opens Creo with one or more specified

licenses or license extensions. 

Creo startkeys are created as PSF files and are located in the directory

<creoinstalldir>\Parametric\bin. Startkeys are generated during setup with the PTC

installation wizard or can be reconfiguared later

(<creoinstalldir>\Parametric\bin\reconfigure). Refer to the Creo manuals from PTC for

more information. 
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When the program starts, Creo reads the startkey to determine which licenses and

extensions are to be searched for on which license server(s). This is defined in the

environment variables PTC_D_LICENSE_FILE- and CREOPMA_FEATURE_NAME.

GENIUS TOOLS Starter intervenes in this process and 

– replaces the PTC environment variables: 

when settings are made in GENIUS TOOLS Project Configurator, i. e. for license server

and base license specifications.

or

– adds additional information to the PTC environment variables: 

when settings are entered into configuration blocks, i. e. for license extensions and other

project options, such as add-on programs.

Assigning licenses to a startkey
Each startkey should contain information about the base license package and the license

extensions. One startkey can contain several license extensions, as well as several base

licenses.

Usually, multiple startkeys are created for Creo, since the same license structure is typically

not available for all workstations. The actual number of startkeys required and the license

information they contain depends on the procedure you choose to optimize license usage,

as described in the next chapter. 

Examples for license information in start keys:

Feature in der Datei found.psf: ENV=CREOPMA_FEATURE_NAME=PROE_FOUNDATION ()   

Feature in der Datei manikin.psf: ENV=CREOPMA_FEATURE_NAME=PROE_FOUNDATION (277 278)

Feature in der Datei AAX.psf: ENV=CREOPMA_FEATURE_NAME=PROE_AdvSE ()

5.19.3.2  Determining license servers

If multiple license servers exist in an organization, you can assign one or more license

servers to a specific project, unit or subunit. 

You can also assign multiple license servers to a project and define the order in which the

servers are accessed.

Example: For the unit United Kingdom the license server in the United Kingdom should

be searched first and the license server in Asia last.

1. In the Resources main page create the resource Creo license server with the name

ALLSERVERS, which contains all license servers, e. g.

7788@licserverUK;7788@licserverUS;7788@licserverAS

The order of the servers corresponds to the search query.  
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2. Go to the unit United Kingdom and select the license server ALLSERVERS in the tab

Start in Creo Settings. 

5.19.3.3  Optimally assigning licenses

There are three ways to use GENIUS TOOLS Starter to assign licenses and extensions to

one or more projects.

– Method 1: Fixed assignment of a startkey to a project 

– Method 2: Assigning several startkeys to one project 

– Method 3: Assigning license extensions to a project

Choose the method according to the license structure. 

The three methods can best be explained using an example.

Methods of license usage by example
The following example describes an optimal creation of Creo startkeys for different typical

situations.

Assumptions: The license server CADLICENSES is used. Creo startkeys (PSF keys) are

created by default with the PTC Setup or edited with "reconfigure". They are located in the

bin folder of PTC, e. g. PTC\Creo 8.0.0.0\Parametric\bin.

Initial scenario: One type of license 

A company employs 10 Creo users and has 10 "Creo Foundation" base license packages.

Solution / Method 1: You require one Creo startkey which is assigned to one project. 

– Content of the file parametric.psf:

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_Foundation ()

– In GENIUS TOOLS Project Configurator, assign the startkey parametric.psf to the project

Creo Parametric. (Consult the chapter Assigning Creo licenses to projects for a step-by-

step guide).

Result: 10 users can start the project without any

options.

Scenario A: Several types of licenses

Two construction engineers join the team. The base license package "Creo Foundation" no

longer exists, so the base license package "Creo Advanced SE" is purchased. 
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Situation: There are 10 Creo Foundation base license packages and 2 Creo Advanced SE

base license packages for 12 users.

Solution / Method 1: The existing PSF key is extended. 

– In the parametric.psf file the license specification for Creo Advanced SE has to be added:

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_Foundation PROE_AdvSE ()

– No editing needed in GENIUS TOOLS Project Configurator for the 12 users to work.

Result: 12 users can start the project without any

options.

Result: The project is started without any selections in the GENIUS TOOLS Starter App user

component.

Scenario B: One license type with license extension package

The top-down technology (skeleton models, reference control etc.) is to be used. For this

purpose, two license extension packages "Creo Advanced Assembly Extension" (AAX) are

purchased.

Situation: There are 10 Creo Foundation base license packages and 2 AAX license

extension packages for 10 users. Creo Parametric can be started without AAX and with

AAX (but only 2 times). 

Solution: You can use all three methods. For all of them users are given the option to start

a project with or without an AAX license extension. 

– Content of parametric.psf (as in initial scenario):

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_Foundation ()

– For methods 1 and 2, a second startkey is created with the content:

ENV=PTC_D_LICENSE_FILE-=7788@cadlicenses

ENV=CREOPMA_FEATURE_NAME= PROE_AdvSE (0 6 97 108 292 329)

Method 1: Assigning a startkey permanently to a project.

– GENIUS TOOLS Project Configurator a new project is created with the second Creo

startkey aax.psf.

Result: Two projects can be started without any

options.
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Hint:  Project permissions can be used to grant selected users only the right to see the

project with AAX.

Method 2: Assigning multiple startkeys to a project.

– The second startkey aax.psf is assigned to the project. (See Projects with several startkeys

to choose from).

Result: The project has an option for selecting the

Creo startkey.

Method 3: Assigning license extensions to a project

– The aax.psf startkey is not used.

– Create a configuration block in the project folder which contains information about the

AAX license extension package. (See chapter Single project options for details).

– Contents of the config_aax.pro file:

! gts_creo_lic = 0 6 97 108 292 329

Result: The project has an option for selecting the

AAX license extension (checkbox).

Tabular overview of license usage methods:

Method 1 Method 2 Method 3

Description Fixed assignment of

a startkey to a

project 

Assigning several

startkeys to one

project

Assigning license

extensions to a

project

Project options in

GENIUS TOOLS

Starter App

No options for

project

Selecting a startkey

from a list of

startkeys

Activating one or

more project

option(s)

Settings Projects >

Application > Project

> Tab: Start > Creo

startkey

Projects >

Application > Project

> Tab: Start > Creo

startkey

configuration

Creating a

configuration block

(config_*.pro) in a

configuration

directory
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Method 1 Method 2 Method 3

Advantage Quick provision of a

simple configuration

Number of projects

is minimized

Number of projects

is minimized

significantly

5.19.3.4  Automatic distribution of Creo startkeys

You can automatically distribute Creo startkeys (PSF keys) to all user computers. GENIUS

TOOLS Starter copies all PSF files located in the configuration directory (Cadpool) of the

user computer to the bin directory of the Creo installation directory of the user computer.

The files are copied to the bin directory of the Creo version that is assigned to the project.

Automatic copying is useful when PSF keys were edited. The maintenance effort is

significantly reduced.

The function to copy startkeys is activated in GENIUS TOOLS Project Configurator in the

menu item Configuration under Creo Settings > Tab: Start > Dialog: Creo startkey. There

you can choose:

– whether all Creo startkeys are copied to the bin directory or

– whether only project-relevant startkeys are copied to the bin directory oder

– whether the bin directory is cleaned up before, i. e. all startkeys are deleted before

copying. (This is only possible for startkeys in the units and users directories).

The startkey used for the project depends on the call hierarchy for configuration blocks.
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5.19.4  Installing Creo on user computers

Concept
The installation of Creo Parametric can be configured by providing a Creo setup that is

synchronized on all user computers. Installing can then be done automatically or

manually.

For automatic installation: The installation is started when Starter projects are fully

synchronized and validated.

For manual installation: The installation is started when you double-click on the

corresponding project.

Prerequisites
All folders required for the installation are located under caddepot/<operating

environment>/parametric/install. This folder structure is supplied and should not be

changed so that Creo can be installed without any problems. In addition, certain files must

be stored in this folder so that they can be executed correctly. There is a separate folder

with installation definitions for each Creo main version.

Predefined folder structure:

Folder Subfolder Contents and meaning

definitions standard* > add_files** > creoX

                  > XML > creoX 

                  > XML > help_creoX***

                  > setup

The following files are located directly under

standard:

gts_creo_install_finalize.bat

gts_creo_install_prepare.bat

*The folder standard is a

complete template with all

folders and subfolders for the

installation of Creo version 7-

11. This folder can be copied

and renamed for units.

** The folder add_files is

optional.

*** A setup and an XML file can

also be stored for the help.

scripts – The following files are located

here:

Scripts required to execute the

Creo installations. Do not copy

or change any files in the

scripts folder! 
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Please note: The required batch files – gts_creo_install_finalize.bat and

gts_creo_install_prepare.bat – run before and after the start of the setup under the

logged-in user, i. e. not under admin access rights.

Procedure

1. Under caddepot/<operating environment>/parametric\install\definitions\<standard or

UnitDirectory> are all folders you need for a Creo installation. These must be filled

with the required files.

a. In the event that unit-bound different installations are to be executed, the folder

structure must be copied from the standard folder to unit level.

2. Download the Creo Parametric setups to any computer. Save this setup under

standard > setup > Setup-Name > setup.exe.
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3. Start the setup.exe from the Creo installation directory and complete the entire Creo

setup including the installation in any directory.

4. Copy the following XML files and paste the files into the caddepot of your operating

environment for the Creo version from which you copied the XML files: 

a. <CreoInstallationTargetDirectory>\Creo<CreoVersionNumber>[...]

i. [...]\Common Files\bin\pim\xml > Copy file creobase.p.xml to

\XML\creo<CreoVersionNumber>

ii. [...]\Parametric\bin\pim\xml > Also copy file pma.p.xml to

\XML\creo<CreoVersionNumber>

5. If you need additional files for the setup, e. g. PSF keys, copy these to the directory

add_files\Creo<CreoVersionNumber>.

6. In menu item Configuration  under Creo Parametric > Tab: Install, select the setup

and target directory for the global settings (default) or a unit. You can only enter

“setup”, in which case the front file path is selected automatically.

a. For a setup from a synchronized resource, enter the path accordingly: e. g. %
GTS_ROOT_DIR% ...

7. Define how Creo is installed in the section Definitions.

Execution folder

Enter the execution path.

Install / deinstall

Upgrade: The old Creo version in the target directory is replaced. Enter the installation

directory of the previous version as the target directory.

Parallel: All versions are kept.

Deinstall: The version configured in the project is deinstalled.
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Installation mode

Manual: Setup is executed when the user starts a project in GENIUS TOOLS Starter App.

Automatic: Setup is executed when the setup for the defined Creo version is available

on the computer and the project is validated. 

Warning: Deinstall can only be executed with the Installation mode Manual.

8. You can also make further specifications for global settings and units: Select

additional functions to be installed in the section Options, see Installing.

9. A setup and an XML file can also be stored for the help. Also set Install help to Yes.

10. Enter the administrator's access data and optionally a validity date for the access data

for the desired unit in the section Credentials. Please note that the credentials are only

taken from the last subunit, i. e. if setups are to be carried out in several units,

Credentials must be entered in each of these units.

11. Go to the menu item Projects   > Creo Parametric:

a. In the tab: Install > Source folders, specify that Creo Parametric is to be installed for

this project. If no entries are made, the information from the menu item

Configuration  is loaded.

b. In the tab: Creo, use the information for the lowest and highest weekly version in the

section Creo Parametric to restrict the automated Creo installations to permitted

weekly versions.

If a Creo version with the same major version is already installed and you are

installing a minor update, you must enter the lowest and highest weekly version.
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12. Save the settings in the Project Configurator. GENIUS TOOLS Starter checks whether a

new setup is available and installs it.

5.19.5  Unit settings

In the main page Configuration  you can define the behavior of Creo Parametric. You

can set the behavior here for the system-wide standard (1) as well as for units (2) and

groups (3).

To switch between tabs click on Application, Start, Cleanup or Write (4).

The Application tab in the Creo Parametric settings dialog.

Please note: If an input field inherits values from the higher-level configuration levels,

you will still only see the global default value displayed in

gray.
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You can also specify settings directly for individual projects, which will overwrite the data

specified here for a unit. (Projects > Creo Parametric > Select project > Creo tab.)

For general information on units, see the chapter Configuring heterogeneous

environments: and for the inheritance of settings go to the chapter Call sequence for

settings.

5.19.5.1  Application

u Startup settings

Creo install path

You can specify a directory on the user computer where Creo is installed, or leave the field

empty, which means the installation directory is searched for automatically from the local

Windows registry and the Creo version is used as specified in the project settings. For

more information consult the chapter CAD-specific project settings.

Please note: It is generally recommended to have the installation path be determined

from the local Windows registry.

Data directory

Enter the data directory to be used. The data directory is the main directory of an

operating environment containing Creo-related data.

The following data is stored in the data directory:

– Libraries: all library parts and their directories with MNU file

– Configuration: bend table, search.pro, hole chart, DTL file for drawing

representation, DMT file for colors in Creo, FMT file for displaying parts lists in the

browser

– Materials: material files for Creo in the MAT format

– ModelCheck: configuration files for ModelCheck

– NC:  templates and configurations for NC machining.

– Drawings: files for drawing frames, notes and symbols

Please note: The files config_*.pro, config_*.sup and customization.ui can be stored

separately from the data structure due to their potential multiple use. If you want to use

project-specific configuration files, set the folder for them as the project folder in

GENIUS TOOLS Project Configurator > Projects > Creo.

u Creo Parametric directories

The input fields are described in the chapter Workspace for Windchill.

u Plot configuration

Trail folder

Creo trail files, recording all production steps, are written to this directory, e.g. %TEMP%
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\Proe.

Plot configuration folder

This directory contains the configuration files (PCF and PNT) for the plotters, e.g. %

GTS_ROOT_DIR%\parametric\configuration\plot.

Plot file folder

Directory on the workstation in which Creo stores the plot files. e.g: C:\Temp.

u User settings

Configuration folder

The configuration files of each user can be stored in the directory userdata.

Private config.pro

Name of a user-defined config.pro file, e. g. config_%username%.pro. It is appended to the

config_*.pro files in the users, projects, units and/or standard directories.

Please note: For storing their private config.pro file, users must have write access to

the userdata directory, as well as the access right Can save personal Config.pro file [to

userdata directory] on server. See also Backup tab in GENIUS TOOLS Starter App.

Private customization.ui

Name of a user-defined customization.ui file, e. g. config_user.ui. It replaces any

customization.ui file in the users, projects, units and/or standard directories. See also

Backup tab in GENIUS TOOLS Starter App.

5.19.5.2  Start

In the Start tab you can define the start behavior of Creo Parametric for a unit. 

For managing the behavior of a single project, go to the Start tab in Projects main menu.

u Startup Settings

Startup directory

Enter the working directory of Creo.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer.

Show only installed languages

By default only languages of installed versions are displayed in the drop-down menu (see

above setting). 
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Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.

Enable stop batches

Yes: Additional batch files can be executed after Creo has been stopped.

No: No stop batch files can be executed after Creo has been stopped.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

Activate Creo Update Notifier

Specify whether a notification should be displayed in Creo Parametric when new versions

are available, including information about new functions.

Yes: The notifier from Creo appears. The environment variable

CREO_MOR_NOTIFY_DISABLE is set to "false".

No: No notifier. The environment variable CREO_MOR_NOTIFY_DISABLE is set to "true".

u License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo,

the maximum borrow duration is determined by the environment variable

LM_BORROW_DURATION. Project Configurator does not check whether the value you enter is

valid for Creo.

Default duration

Specify the borrow duration in days that is set as the default when a user borrows licenses.

u Creo startkey

Copy Creo startkey

GENIUS TOOLS Starter copies all Creo license keys (PSF files) located in any configuration

layers of the user computer (Cadpool) to the BIN directory of the Creo installation

directory of the user computer. For each PSF file, a matching BAT file will be created

automatically. If you only want to copy startkeys required for a specific project to the

application computers, set Copy project-related startkey only to Yes.

Yes: All Creo startkeys located in the configuration directory are copied to the BIN

directory of the Creo installation before project selection.

Yes, cleanup before: All startkeys in the bin directory of the specified Creo version are

deleted before the copy process, except cocreatesim.psf und gts.psf. This option can

only be set for units, not for projects.
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Warning: Setting this option may lead to invalid projects, if no Creo startkey(s) are

copied.  

No: Creo startkeys will not be copied to the BIN directory.

Copy project-related startkey only

Only the startkey required for the selected project is copied. This option can only be used

if the above option Synchronize Creo startkey is set to Yes. 

Yes: Only the project relevant startkey is copied to the BIN directory.

No: All startkeys in the configuration directory are copied to the BIN directory.

u Creo License Server

Creo license server 

Select the Creo license servers to be used for the selected unit.  The list is created in

Resources > Creo license servers. 

No selection (default): The license server, which is specified in the Creo startkey, is

used.

u Licenses

Show licenses

Specifies whether the licenses specified in a project are displayed in the licenses tab of

GENIUS TOOLS Starter App.

Yes: Creo licenses are listed. The license status is not obtained; validation is possible

by using the Analyze Licenses function.

No: Creo licenses are not displayed. The settings Get extensions, Calculate licenses by

extension and Identify license users can not be utilized.

PTC license reusable per host

State whether your PTC licenses can be used several times.

Yes: Use this option if you have DUP_GROUP in your PTC license file. The license

validation will calculate the free PTC licenses in a way that PTC licenses that are

already in use by another session on the same application computer will show an

amount of at least one, making the project valid.

No: Use this option if you are unsure or cannot find DUP_GROUP in your PTC license

file.

Please note: For this option to produce the correct result, the PTC license must contain

the keyword DUP_GROUP according to CS234779. This information cannot be

determined by GENIUS TOOLS Starter App.

Get extensions

Define whether extensions should be queried. To use this setting, Show licenses has to be

set to Yes.

Yes: In addition to the basic license, extensions are also queried on the license server.
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No: Only the basic license is queried.

Calculate licenses by extensions

Define whether a free license is calculated based on the basic license or on extensions. To

use this setting, Get extensions has to be set to Yes.

Yes: Extensions are also used for license calculation.

No: Licenses are calculated on the basic license.

Identify license users 

Define whether users of a license are identified.

Yes: User names are displayed on the client as a tooltip of the corresponding license

name. The GTS alias as defined under Resources > User is used.

No: No user names are obtained or displayed.

Please note: To display the name, the user names must be configured via Resources >

Users. Otherwise, the Windows user name is displayed

Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The license servers are pinged

before the license query is started. If the server does not respond to the ping, the query

will still be executed.

The duration you enter is also used as a maximum time for the license query. 

If you expect licenses to be unavailable form time to time, set the timeout to 0, which

means that there is no timeout specified.

Default: 0 (no timeout specified)

u Creo Startkey Configuration - Subscription -

Default Creo startkey

Specify the license key (PSF file) of the respective Creo installation. 

Please note: If a Creo startkey has not been synchronized on the user computer, the

user cannot use this startkey. Make sure that the settings in the units are correct. 

The query for license keys corresponds to the general query sequence: Standard > Unit >

Subunit > Project. See also chapter Assigning Creo licenses to projects.

Empty field: The default Creo startkey is inherited from the higher-level configuration

layer.

Enter a PSF file: You can either enter a file name (e. g. parametric.psf) or a complete

path (e. g. D:\PTC\Creo 9.0.0.0\Parametric\bin\parametric.psf) or you can tick a box in

the section Creo startkey configuration below.
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Warning: If multiple startkeys are permitted for a project in the Creo startkeys section

below, users can select any of them from a drop-down menu in GENIUS TOOLS Starter

App. The default Creo startkey displayed then becomes the default setting for the drop-

down menu. See Using project options.

Drop-down menu: - Subscription - Appears if several startkeys are selected in the Creo

startkeys section below. 

Select Creo startkey: The startkey displayed here is the default startkey in the selection

menu of GENIUS TOOLS Starter App.

Last selected: GENIUS TOOLS Starter App starts Creo with the startkey last used for this

project.

Please note: If you want a unit or project to inherit multiple Creo startkeys from the

higher-level configuration layer and GENIUS TOOLS Starter App to remember the last

startkey selected, no drop-down menu with the selection Last selected will appear.

However, you can create this option by entering a text that does not end with “.psf” in

the input field, e.g. Last selected or Anyothertext.

Creo startkeys - Subscription -

The startkeys displayed here are the startkeys created under Resources > Creo Startkeys. 

If you select several startkeys, that should be available for a Creo Parametric project, a

drop-down menu (project option) is created in GENIUS TOOLS Starter App that displays as

default value either a specific Creo startkey or the last startkey used for this project –

depending on the setting in the upper section Default Creo startkey.

5.19.5.3  Cleanup

Configuration files of Creo Parametric are not overwritten by default. If a new file is to be

created, a previous deletion of the old configuration file is necessary. Here, you can

manage the cleanup settings of GENIUS TOOLS Starter App for Creo projects. 

u Text directory

Config.pro, Config.sup, Customization.ui and – from Creo version 11.0.0.0 –

Mapkeys.pro

Defines whether these configuration files are deleted or retained in the text directory of a

Creo installation.

Yes: Delete

No: Retain

Please note: Make sure the user has access rights to delete files in the text directory of a

Creo installation. This will be of special importance if Creo is installed in Programs.
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u Home directory

Config.pro

Determines whether this configuration file in the user's home directory is deleted or

retained.

Yes: Delete

No: Retain

Customization.ui and – from Creo version 11.0.0.0 – Mapkeys.pro

Determines whether these files in the directory .Settings  in PTC_WF_ROOT are deleted or

retained.

Yes: Delete

No: Retain

u Startup directory

Config.pro, Customization.ui, Config.val

Define whether these configuration files are deleted or retained in the start directory of a

Creo installation.

Yes: Delete

No: Retain

u Alternative path

Config.pro, Config.sup, Creo_parametric_admin_customization.ui and – from Creo

version 11.0.0.0 – Mapkeys.pro

Define whether these configuration files in the alternative target directory are deleted or

retained. 

Yes: Delete

No: Retain

5.19.5.4  Write

Configuration files for Creo can be located in three different places, which can affect the

configuration of Creo. Here, you can influence the copy settings of GENIUS TOOLS Starter

and define target directories.

Warning: A new configuration file will only be written if no configuration file is yet

stored at the location. Use the settings in the Cleanup tab to avoid difficulties.

u Target directories

Use alternative path (from 9.0.2.0)

As of Creo version 9.0.2.0, it is possible to write the Creo configuration files config.pro,

config.sup as well as creo_parametric_admin_customization.ui in a directory other than

Text, Home or Start. 
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Yes: The alternative path below is used and the environment variable

PTC_CREO_ALT_SETTINGS_PATH is set. The target directory for the file config.pro is no

longer used for version 9.0.2.0 and later. For projects of older Creo versions, the

config.pro file is written to the target directory up to 9.0.1.0 and the config.sup file is

written to the text directory.

No: Do not use an alternative path.

Alternative path

Specify a directory for which users have write access. The directory is displayed in the

Info tab of GENIUS TOOLS Starter App.

Config.pro location (up to 9.0.1.0)

Select the directory to which the config.pro file will be copied. If no directory is selected,

the file will be copied to the home directory.

Text: The config.pro file is copied to the text directory of the Creo installation.

Home (Default): The config.pro file is copied to the home directory of the user.

Start: The config.pro file is copied to the startup directory.

Please note: Make sure the user has access rights to create files in the text directory of a

Creo installation. This will be of special importance if Creo is installed in the Programs

directory.

UI file location

Select the directory to which the customization.ui file will be copied. If no directory is

selected, the file will be copied to PTC_WF_ROOT.

PTC_WF_ROOT: The file creo_parametric_customization.ui is copied to the Settings

directory in PTC_WF_ROOT. If the file creo_parametric__admin_customization.ui exists

and no alternative path is specified from Creo version 9.0.2.0 and later, it will be copied

to the text directory.

Start: When existent, the creo_parametric__admin_customization.ui file is copied to the

text directory. The creo_parametric_customization.ui file is copied to the Creo startup

directory.

Please note: If Creo is to read the customization.ui file from the startup directory, the

following option must be set in the config.pro file: load_ui_customization_run_dir
yes.

u Config Handling

Specify whether the following configuration files should be written.

Please note: To copy current configuration files, the corresponding files in the target

directory have to be deleted first (see Cleanup tab). This makes sure that the config.pro

settings defined by the administrator will always be used.
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Config.pro

Yes: A config.pro is compiled and copied to the target directory unless a config.pro file

exists there already.

No: Writing config.pro is skipped.

Transfer mapkeys from config.pro (from 11.0.0.0)

As of Creo version 11.0.0.0 mapkeys must be saved in a separate file. GENIUS TOOLS

Starter can extract existing mapkeys and create the new mapkey file mapkeys.pro. If the

home or start directory is specified as the Config.pro target directory, the mapkeys are

created as user mapkeys, otherwise they are created as administrator mapkeys.

Yes: Mapkeys from the config.pro file are extracted if there are no mapkeys in config.sup.

Yes, transfer all: Mapkeys from the config.pro file are extracted, if mapkeys are found in

config.sup.

No: No support by GENIUS TOOLS Starter. Creo automatically loads user or

administrator mapkeys into the mapkeys dialog, but does not create a mapkeys file for

administrators. A message window appears.

Config.sup

Yes: If a config.sup is found in the project folder, it will be copied to the target directory

unless a config.sup file exists there already.

No: Writing config.sup is skipped.

Transfer mapkeys from config.sup (from 11.0.0.0)

As of Creo version 11.0.0.0 mapkeys must be saved in a separate file. GENIUS TOOLS

Starter can extract existing mapkeys and create the new mapkey file mapkeys.pro. The

mapkeys are created as administrator mapkeys.

Yes: Mapkeys from the config.sup file are extracted and written to the text directory, or if

defined, to the alternative path.

No: No support by GENIUS TOOLS Starter. Creo automatically loads administrator

mapkeys into the mapkeys dialog, but does not create a mapkeys file. A message

window appears.

Customization.ui

Yes: If a customization.ui is found in the project folder, it will be copied to the target

directory unless a customization.ui file exists there already.

No: Writing customization.ui is skipped.

Config.val

Yes: If a config.val is found in the project folder, it will be copied to the target directory

unless a config.val file exists there already.

No: Writing config.val is skipped.

5.19.5.5  Installing

Im Tab Installieren wird definiert, wie Creo Parametric-Setups auf Anwenderrechnern

ausgeführt werden. Legen Sie vorher ein Template-Setup an. Konsultieren Sie das Kapitel

Installing Creo on user computers für die Schritt-für-Schritt-Anleitung.



195GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

u Source folders

Setup folder

Enter the directory that contains the Creo Parametric and Help setups:

%GTS_ROOT_DIR%\parametric\install\definitions\standard\setup

u Definitions

Target directory

Specify the directory to install on user computers.

Execution folder

Enter the execution path.

Install / deinstall

Upgrade: The old Creo version in the target directory is replaced. Enter the installation

directory of the previous version as the target directory.

Parallel: All versions are kept.

Deinstall: The version configured in the project is deinstalled.

Installation mode

Manual: Setup is executed when the user starts a project in GENIUS TOOLS Starter App.

Automatic: Setup is executed when the setup for the defined Creo version is available

on the computer and the project is validated. 

Warning: Deinstall can only be executed with the Installation mode Manual.

u Options

Install help

Determines whether the help is installed.

Install diagnostic tools

Determines whether Creo diagnostic tools are installed.

Install Thumbnail Viewer

Determines whether the thumbnail viewer is installed.

Activate taskkill

Defines whether potentially disruptive Creo processes are terminated.

Write firewall entries

Defines whether Creo is allowed to pass through the firewall.

u Credentials

Username and password of the administrator

Enter the Windows access data with admin rights. Domain users must enter the spelling

username@domain. Local users only enter the user name.
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Validity

Enter an expiration date for the validity of the access data.

5.19.6  Project settings

Project settings are the specifications you make in the main page Projects  under

Applications > Creo Parametric in the tabs Creo, Start, Windchill and Environment.

After having created a new project with the general project specifications, fill in the

following input fields. These entries overwrite both the unit-specific entries and the

standard settings for the startup behavior of the application, which are made under

Configuration > Creo Parametric > Tabs: Application / Start. For more information, see the

chapter Configuration concept.

5.19.6.1  Settings for Creo projects

After having created a new project, specify the following settings in the Creo tab.

u Creo Parametric

Release

Defines the Creo Parametric version to be used. A path can be configured, or determined

automatically from the registry of the application computer. See Installation directories of

a CAD application.

Fixed path: Select the Creo directory from the drop-down menu. This may differ from

the Creo directory for the global standard settings. Without a directory defined here, the

settings for the standard unit will be used. (See Configuration > Creo Parametric > Unit:

Standard > Application > General > Startup settings > Creo install path).

Creo versions: It is possible to preset the Creo version. If you select Creo 9, for example,

the installation directory for the latest Creo 9 release on the application computer will be

determined from the registry.

Please note: Creo has to be installed locally on the application computer in order to

have registry entries available. The user has to have read permission in HKLM.

Lowest shipcode (optional)

Select the lowest usable weekly version. There is a dropdown list for versions up to Creo 4.

Starting with Creo 5, enter the required version manually in a four-digit format like 8.0.1.0.

Highest shipcode (optional)

Select the highest usable weekly version. There is a dropdown list for versions up to Creo

4. Starting with Creo 5, enter the required version manually in a four-digit format like

8.0.1.0.

Project folder (optional)

Folder in configuration\projects. The files config.pro, config.sup, customization.ui and
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config.val are copied as templates from this directory to the application computer.

Data folder (optional)

Main directory of an operating environment to which Creo-related data is saved, see Creo

data packages.

Please note: The files config_*.pro, config_*.sup and customization.ui should be stored

separately from the data structure due to their potential multiple use. These

configuration files should be managed in the specific subdirectories of the configuration

directories Units, Projects, or Users, or in the Standard directory for global settings.

The next section Creo directories is explained in the chapter Workspace for Windchill.

5.19.6.2  Creo data packages

All Creo object data is stored in subdirectories for each operating environment, the data

packages, for example <GTS_ROOT_DIR>\parametric\data\sut_creo9.

The Creo data is stored in the following directory structure within a data directory:

– config: bend table, search.pro, hole chart, DTL file for drawing representation, DMT

file for colors in Creo, FMT file for displaying parts lists in the browser

– library_dir: all library parts and their directories with MNU file.

– material_dir: material files for Creo in the MAT format

– modelcheck_dir: configuration files for ModelCheck

– nc_dir: templates and configurations for NC machining

– Drawings (texture): files for drawing frames, notes and symbols

All references to data in the data directory are defined in project configuration files, i. e. in

configuration blocks (config_*.pro files) in the projects directory. If there are no project-

specific references, the general configuration files in the standard directory will be used,

i. e., the config_*.pro files under <GTS-OperatingEnv>\parametric\configuration\standard.

It is recommended to consistently use variables in your references. For example, a

reference to a data directory from a config_*.pro uses the variable $GTS_DATA.

Example: A reference in the configuration file config_sut_de_c9p_dir_file.pro in the

project directory project_creo9p_de reads

pro_library_dir $GTS_DATA\library_dir

This reference points to the directory library_dir within the data directory.
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Hint: It is recommended to use variables where possible.

Please note: Many configuration options can be set only once in Creo. In this case, the

value of the latest entry is used, that is, the value from the file that is copied last. There

is a defined call hierarchy for the files, see Call hierarchy.

5.19.6.3  Defining start behavior for a project

In the Start tab specify the start behavior of an individual project. These specifications

overwrite the specifications for the start behavior set for units or the default settings (main

menu item Configuration > Group (select) > Creo Settings > Tab: Application > Area:

Startup behavior). For more information consult Configuration concept.

u Startup settings

Starting behaviour 

Select the application which will open the project.

Creo (default): The project is started with Creo.

External: The project is started with another application (e. g. SAP). For more

information got to chapter Linking projects with SAP.

If External is selected two additional fields open:

External start command

Enter the path to the executable file that is to start the project.

Command arguments for external start

Enter commands that specify how the executable file is started. Set the commands in

quotation marks.

Creo startkey

The start command (PSF file) of the respective Creo installation. The directory of the Creo

installation is defined in the Creo Tab under Release. The startkey can be written as file

name (e. g. parametric.psf) or as path (e. g. D:\PTC\Creo6\bin\proel.psf)

Warning: If several keys are permitted for a project (in the Licences tab), the startkey

will become the default setting for the selection field in GENIUS TOOLS Starter App, i. e.

users will be able to choose another startkey.  

Please note: If a defined startkey is not available on the client computer, you can

choose to display the project in GENIUS TOOLS Starter App as follow (Go to

Configuration > Unit > GENIUS TOOLS Starter App > Projects > Displaying invalid

projects):

– Display with error warning: Project without a valid license is displayed with a red

background and cannot be started. (Select Yes, as error)

– Project is not displayed. (Select No)
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Copy Creo startkey

Specify whether the startkey (PSF file) required for the project is copied to the BIN

directory of Creo.

Yes: The project relevant start key is copied.

No: The project relevant start key is not copied.

Please note: For this option, write permissions are required on the application

computer in the Creo BIN directory.

Please note: Take care when synchronizing startkeys. A configuration error may lead

to erroneous distribution of startkeys to application computers that should not have

certain licenses available.

Language /Show only installed languages

See chapter Language of a Creo project.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

5.19.6.4  Language of a Creo project

The language of the user interface of Creo Parametric can be set in the Projects main page

under Creo Parametric > Select projects > Tab: Start > Startup settings. The following

languages are available: English, German, Italian, French, Spanish, Japanese, Chinese

(simplified), Chinese (traditional), Korean, Russian, Brazilian Portuguese.

Define the following settings:

Language

The language in which Creo should run can be specified. If no setting is selected, Creo

Parametric will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable (LANG, if defined on

the application computer, will be set to that language.

Show only installed languages

By default only languages of the installed Creo versions are displayed in the drop-down

menu (see above setting). This input overwrites any unit setting.

Yes: Menu contains only installed Creo languages.

No (default): Menu contains all languages supported by Creo.
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Creo language as a project option
Administrators can also grant users the possibility to select a language, see Define project

options > language selection field.

5.19.6.5  Default settings for license borrowing

You can define the maximum duration of borrowing PTC and GENIUS TOOLS licences in

Creo Parametric > Projects > Tab: Start. This information overwrites the unit-specific

settings.

u License borrowing

Maximum duration

Specify for how many days licenses may be borrowed at most. Please note that in Creo,

the maximum borrow duration is determined by the environment variable

LM_BORROW_DURATION. Project Configurator does not check whether the value you enter is

valid for Creo.

Default duration

Specify the borrow duration in days that is set as the default when a user borrows licenses.

u Creo License Server

Creo license server 

Select the Creo license servers to be used for the selected unit.  The list is created in

Resources > Creo license servers. 

No selection (default): The license server, which is specified in the Creo startkey, is

used.

5.19.6.6  Environment variables

In the Environment tab you can set environment variables for a Creo Parametric project. 

The variables set here are added to the variables defined for units. Values set here for an

existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A

list of created and affected environment variables can be found in the appendix.

5.19.6.7  Installing Creo

Im Tab Installieren wird definiert, wie Creo Parametric-Setups auf Anwenderrechnern für

das ausgewählte Projekt ausgeführt werden. Legen Sie vorher ein Template-Setup an.

Konsultieren Sie das Kapitel Installing Creo on user computers für die Schritt-für-Schritt-

Anleitung. 
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5.19.6.8  Assigning Creo licenses to projects

A project can be started with a Creo Parametric license packages by assigning one Creo

startkey to it or by giving several for selection. 

A startkey is 

– a configured start command that opens Creo with one or several defined licenses or

license extensions,

– a PSF file located in PTC's bin directory.

The Start tab of the group as well as project settings lists all startkeys that have been

created as a resource.(See chapter Creating Creo startkeys.) The checked startkeys will be

those that users can select in GENIUS TOOLS Starter App. (See Making use of project

options.) If users are provided with several keys to choose from, the number of projects

can be greatly minimized. 

Administrators can create projects that either have 

1. one startkey or 

2. several startkeys that users can choose from in GENIUS TOOLS Starter App.

Projects with several startkeys can either 

2.1. have a startkey set as default or

2.2. use the startkey last selected by the user.

Please note: All settings described here can be made both in a project and in the

higher-level configuration levels (units, standard). The query of the Creo startkeys

corresponds to the general query sequence: Standard > Unit > Subunit > Project.

Individual startkeys can be locked independently of the assigned options to select for

users under Resources > Creo startkeys > Block: Yes/No. 

1. Projects with one defined startkey
Enter a Creo startkey in the Start tab in the Creo startkey configuration area. You can

either enter the file name (e.g. parametric.psf) or a complete path (e.g. D:\PTC\Creo

11.0.0.0\Parametric\bin\parametric.psf).

With a subscription license, you also have the option of selecting a startkey from the Creo

startkeys section below. 
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Global settings (unit Standard) for the startkey parametric.psf

Defined vs inherited project settings for startkey parametric.psf

2. Projects with several startkeys to choose from
If several Creo startkeys are permitted for a project, a selection field (project option) is

created in GENIUS TOOLS Starter App. See chapter Making use of project options.

– In Creo startkeys segment of the Start tab tick the Creo startkeys that should be

available for the project (project settings) or for all projects assigned to a unit (unit

settings).

– Decide which default setting the drop-down menu should contain. There are two

possibilities: 

2.1. Projects with several startkeys and a default startkey 
In the Default Creo startkey area, select the startkey that is to appear as the default setting

in the drop-down menu. This means that users do not have to make a selection to start a

project. If users want to use a different Creo startkey, this must be actively selected in the

selection field.

Several startkeys with parametric.psf as 

default value
Selecting a startkeys on a project in GENIUS 

TOOLS Starter App
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2.2. Projects with several startkeys without a default startkey 
If you select the entry Last used in the Default Creo startkey section, GENIUS TOOLS

Starter App remembers the startkey that a user last used for this project and uses it to

start Creo Parametric.

Several startkeys with the default set on the  

startkey used last 

Selecting a startkeys on a project in GENIUS 

TOOLS Starter App

5.19.6.9  Assigning Creo license extensions to projects

In addition to selectable Creo start keys, you can create the option for license extensions

to be selected individually, i.e. independently of the start key for a project. Users see this

as a checkbox in a project.

Project options in GENIUS TOOLS Starter App: checkboxes for license extensions

Advantages: 

Assigning selectable license extensions to a project can reduce the number of Creo

startkeys created, and therefore reduce the number of projects available to users in

GENIUS TOOLS Starter App. If the license conditions allow it, you can, for example,

dispense with the selection of a Creo start key altogether by creating all license extensions

as project options

These project options are not created in GENIUS TOOLS Project Configurator, but with

configuration blocks. The procedure is explained in the chapter Using project options. 
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5.19.6.10  Workspace for Windchill

Set workspace directories for Windchill and Creo in the dialog Creo Parametric directoires

in the Creo tab. 

You can also define these entries on a unit-specific basis in the Configuration menu item

under Creo Parametric > Tab: Application.

u Creo Parametric directories 

Windchill user root folder / Creo Agent home directory 

Specify the PTC_WF_ROOT directory in which the workspace and user-specific settings can

be stored. 

The Creo Agent home directory, in which data relevant for Creo Agent, such as server

information, is saved, has to be set to %PTC_WF_ROOT%.

If no path is specified, the two variables are not set and a note about the default path of

Creo Agent home (APPDATA/PTC/Creo/Platform/<CPA_Version> is written to the log file.

Please note: If you want to specify separate Windchill directories for various Creo

versions you can use variables, like %GTS_PROERELEASE%, which will resolve to the

Creo version, e. g. Creo6, or %GTS_PROJECT_NAME% in building your path.

Windchill cache directory

Cache directory for caching of Windchill data. To use automatic server registration, the

Windchill cache directory must be located below the Windchill user root folder, see

chapter Automatic Windchill Server Registration.

Please note: Try not to modify this option. To change the storage location of the

cache, rather change the setting Windchill user root directory.

Use the Windchill tab is to register the servers. Detailed information about the procedure

are in the chapter Automatic Windchill server registration. 

Dynamic server settings for different Creo versions
When you change the Creo version, the local cache directories should be deleted from the

disk and re-created with the current Creo version. This means that when you use different

Creo versions, you also need to create different cache directories. Also, the storage

location for Windchill server registration information should be different.

There are two ways to ensure separate cache and server registration storage for different

projects:

1. Configure independent Windchill user root directories for different projects.

2. Use variables in configuring the Windchill user root directory.
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The following variables can typically be used:

Variable Description

%GTS_PROERELEASE% Returns the Creo version as Creo3, Creo4 etc.

%GTS_PROJECT_NAME% Returns the project name

%username% Returns the name of the Windows user

%computername% Returns the computer name

These variables can be used in the setting the path for the Windchill user root directory.

Example: D:\ptc\workspaces\%username%\

%GTS_PROERELEASE%\%GTS_PROJECT_NAME%

The Creo Agent home directory, where server registration information is saved, schould

also depend on the Windchill user root directory. To set this up, you can define a variable

for the Windchill user root directory under Configuration > Standard > Additional

Environment Settings.

Name Value

Creo Agent Home %PTC_WF_ROOT%

Making the Windchill user root directory dependent on the Creo version by using %

GTS_PROERELEASE% and making the Creo Agent home directory dependent on that via %

PTC_WF_ROOT% will lead to all server information and data being stored separately per

version.

If you also make the Windchill user root directory dependent on the project name using %

GTS_PROJECT_NAME%, the storage location will be project-dependent and will change with a

new Creo version.

Do not use %GTS_PROJECT_NAME% if you use GENIUS TOOLS Starter projects to manage

different Creo license packages, because you cannot use local workspaces for multiple

projects in this way.

5.19.7  Displaying projects in GENIUS TOOLS Starter App

You can define general settings to present projects in GENIUS TOOLS Starter App, as well

as provide the following project details and functions that are specific to Creo Parametric

projects.



206GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Analyse and borrow licenses
The key icon  opens the Licenses tab with the functions to analyze and borrow licenses,

if users have the corresponding access rights.

– Setting: Under Organization > Access > Select role > Tab: Function Access > Dialog:

Project > Can analyze licenses / Can borrow licenses.

GENIUS TOOLS Starter App borrows its license and then starts the borrowing process from

PTC. Thereafter, Creo and, if configured in the project, GENIUS TOOLS for Creo each

borrow their licenses, see License borrowing process.

– The default and maximum borrowing period can be predefined in Projects > Creo

Parametric > Select Project > Tab: Start > Borrow Licenses.

Backup
The creo_parametric_customization.ui (short: customization.ui) file contains the user-

specific settings for the Creo graphical user interface and can be backed up and managed

by the user. (See Backup.)

Analysis
The info symbol  opens separate utility GENIUS TOOLS Config Analyzer to view and edit

all configuration blocks and batch files used for the project and their storage location.

– Setting: Button can be deactivated under Can analyze projects under Function access >

Project

Project report
The project report – created by clicking on the  button (5) –  is a separate PDF file

containing all information about the selected project and the current user. 

– Setting: The button can be deactivated with Can create project report under Function

access > Project

The information is grouped as follow: 

– General project details

– GENIUS TOOLS STARTER Network-settings

– GENIUS TOOLS Starter App
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– Additional Environment Settings

– Synchronization

– Licensing

– Creo Settings

– Delete Creo configuration locally

– Write Creo configuration locally

– Windchill Settings

– Used Files

– Batch-files

– Config.sup

– Config.pro

– Customization.ui

– Dynamic Customization.ui

– Config.val

– Assigned rights

– Appendix

– All environment variables

– Generated config.sup

– Generated config.pro

– Generated config.val

5.19.7.1  Defining project options

Administrators can give users the option to select from the following project options.

– Creo language (1)

– Creo startkey (2)

– project options for license extensions, add-on programs and configuration settings:

· single project options (3)

· switch options (4)

· grouped  project options (5)

Selectable project options in GENIUS TOOLS Starter App
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Like all Creo Parametric project settings project options can be defined for a specific

project as well as for units, subunits or system-wide.

Language selection field
You can set whether users can select the language of the projects they have access to. The

right Creo language selectable is granted in Configuration > GENIUS TOOLS Starter App >

Select unit >  Projects and applies to all projects. (See Language selection.)

Selection field for Creo startkey
A startkey is a configured start command that opens Creo with one or more specified

licenses or license extensions. Startkeys are PSF files in the bin directory. You can assign

multiple startkeys to a project. The procedure is described in chapter Assigning Creo

licenses to projects If users have multiple startkeys to choose from, a selection field

appears in the selected project in GENIUS TOOLS Starter App.

Users can be given start keys to select from:

– per project: select the startkeys in Projects > Creo Parametric > (select) Project > Tab:

Start > Segment: Creo Startkey Configuration. For more information, see the chapter

Assigning Creo licenses to projects. 

– for several projects that can be accessed by a unit: Select the startkeys in Configuration

> Settings: Creo Parametric > Select project > Tab: Start > Segment: Creo Startkey

Configuration

The administrator can set in GENIUS TOOLS Project Configurator whether a project should

have a default start command or whether the start command last selected by the user

should be used again. (See chapter Assigning Creo licenses to projects, 2.1. and 2.2..)

If the right to select is not assigned, neither selection field nor information about the used

start key appears. If you want to give users an information about the start key, you can

insert this in the name of the project or in the subtitle, e.g. Creo Parametric 7.0. AAX.

Checkboxes for project options
Administrators can define further project options that are tailor-made to a company's

requirements, e. g. for starting Creo with:

– additional license extensions, such as Simulation Live or Manikin,  

– additional programs such as Keyshot,

– any other configuration setting.

These types of project options are not created in GENIUS TOOLS Project Configurator, but

with configuration blocks. The chapter Making use of project options explains the

procedure.
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For presenting the checkboxes in GENIUS TOOLS Starter App you can define the number

of columns, see Arranging checkboxes. 

5.19.8  Linking Creo projects with SAP

With GENIUS TOOLS Starter you have the possibility to open a Creo Parametric project

with a user-defined command. You can use this option, for example, to link a project with

SAP-ECTR (SAP Engineering Control Center interface to PTC Creo).

To use other applications that start a Creo Parametric project, proceed as follows. 

1. Check Creo versions and information for licenses and license servers (Creo

startkey) 

Check that the Creo version defined in the Creo project in GENIUS TOOLS Starter matches

the Creo version that is to be started by the external application. The correct

parametric.exe is available by the environment variable PROE_START. 

Check that licenses and license servers defined in the Creo project in GENIUS TOOLS

Starter match the entries in the external application. We recommend using the gts.psf file

as Creo startkey for the external application. This ensures that the correct licenses and

license servers are used.

2. Change startup behavior of the project

In  GENIUS TOOLS Project Configurator in the Projects page, go to the corresponding

project and in the Start tab, go to the Startup settings section. Change the startup behavior

of the project from Creo to External.  Two further input fields open.

3. Enter information about the external start behavior 

In the field External start command, enter the path to the application (executable file) with

which the project is to be opened.

In the field Command line arguments for external start field, enter the commands with

which the executable file should be opened.

All other information about a project does not change. (See chapter Settings for Creo

projects.)
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5.19.9  Customizing Creo user interface

If you want to customize the user interface of Creo, go in Creo to File > Options >

Configuration editor. 

Changes made in Creo will by default be saved in the file creo_parametric_customization.ui

in the directory %PTC_WF_ROOT%\.Settings, e. g. %APPDATA%

\PTC\ProEngineer\creo4\.Settings.

Alternatively, you can have this file stored in the startup directory. To do so, select a group

in GENIUS TOOLS Project Configurator and in Creo Settings > Write > Target Directories >

Ui file location select Start.

5.19.9.1  creo_parametric_customization.ui

The file creo_parametric_customization.ui (short: customization.ui) contains the settings for

the graphical user interface (UI) of Creo. 

To customize the user interface specific to a user or a group of users, do as follows:

1. Modify the settings for the user interface in Creo in File > Options > Configuration

editor.

2. Copy the file creo_parametric_customization.ui that is saved in %PTC_WF_ROOT%

\.Settings by default. (The use of the startup directory as alternative storage location is

described in the previous chapter.)

3. Save the copied ui-file to one of these directories: userdata, users, projects, units or

standard. (See also Directory structure.) In a subdirectory of unit, the UI file would, for

example, determine the Creo user interface for the named unit.
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The Customization.ui file is a configuration file of Creo and not a configuration block

(config_*.pro file) of GENIUS TOOLS STARTER. This changes the procedure to read the

settings. A single customization.ui file is read out, meaning that one customization.ui file

cannot add configuration settings to an existing file, it can only substitute another

customization.ui.

The customization.ui file that is found first determines the Creo user interface. The call

hierarchy is as follows: 

1. userdata > 2. users > 3. projects > 4. units > 5. standard

Company-wide configuration with
creo_parametric_admin_customization.ui
The administrator can set up a configuration that is valid for the whole company or for

specific users, projects or units. To do so, change the name of the ui-file that is

automatically saved by Creo from creo_parametric_customization.ui to

creo_parametric_admin_customization and save it to one of these directories: userdata,

user, project, unit oder standard. 

The settings in the admin file creo_parametric_admin_customization are overwritten or

complemented by those in the individual  creo_parametric_customization.ui.

Executing the file creo_parametric_admin_customization.ui follows a hierarchical search in

these directories: 

1. users > 2. projects > 3. units > 4. standard

The administrator can thus set up a standardized graphical user interface for specific users,

projects and units, as well as a company-wide UI configuration.

Please note: A company standard, i. e. a UI file in the standard directory, can only be

implemented if there are no admin_customization.ui files in the directories users,

projects and units.

Individual customization.ui file
A user can manage his or her own customization.ui file by saving it to a directory userdata

to which the user needs write access. There are two possibilities. One, the user can access

the  userdata directory in the caddepot directory of the administration computer – from

where it will be synchronized to the client computer. Two, a directory can be created in

any location on the client computer. There, it does not undergo data synchronization. (See

also the chapter on User-driven configuration.)

The administrator can determine the storage location of the userdata directory in

Configuration > (select) group > Creo Settings > Application > User Settings >

Configuration folder. 
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Backup mechanism with GENIUS TOOLS Starter App
You can create a backup file from creo_parametric_customization.ui in GENIUS TOOLS

Starter App. This can be useful for users who manage their own UI configuration files, as

well as for administrators who modify Creo UI settings for test purposes. A description of

the procedure can be found in the chapter GENIUS TOOLS Starter App > Creating backup

copies. 

5.20  Creo Elements/Direct Modeling

A Creo Elements/Direct Modeling project consists of configuration files, an operating

environment and data packages for standard parts.

Please note:  The work with projects for Creo Elements/Direct Modeling is a feature

that requires a subscription license.

A Starter project configuration is generated from settings of the Power Extension

environment and is not from individual configuration blocks. 

For Creo Elements/Direct Modeling, batch files can be used that are opened before the

application is started, i.e. starter batch files. See also chapter Batch files.

5.20.1  Project display in GENIUS TOOLS Starter App

For the Creo Elements/Direct Modeling application, project details are displayed in the

tabs Info, Licenses and Backup.

Language selection can be provided as a project option. Project options that appear as

checkboxes cannot be created.

Also note the general settings for presenting projects to users in GENIUS TOOLS Starter

App.  
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5.20.2  Unit settings

In the main page Configuration  you can define the behavior of this program for the

selected unit (5) or for the system-wide standard (4). 

Click Application (1), Start (2) and Cleanup (3) to switch between tabs.

Settings for unit and groups for the application Creo Elements/Direct Modeling

Please note: If an input field inherits values from the higher-level configuration levels,

you will still only see the global default value displayed in

gray.

Settings that are made directly to for CED-project overwrite the unit settings entered here

and are made under Projects > Creo Elements/Direct Modeling > Select Project > Modeling

tab, see project settings. 

For general information on units, see the chapter Configuring heterogeneous

environments: and for the inheritance of settings go to the chapter Call sequence for

settings.

5.20.2.1  Application

u Application

Creo Elements/Direct install path

Enter a directory on the user computer which has Creo Elements/Direct Modeling

installed.

Allow interactive customization

Defines whether interactive customization are allowed.

Yes:  Interactive customization are allowed.

No:  Interactive customization are not allowed. The variable

SDDISALLOWINTERACTIVECUSTOMIZATION is set.

Store UI layout files

Defines whether user specific files (*_fluentui_layout.def) are saved. 

Yes: Files are saved.
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No: Files are not saved. The variable SDDONTSTOREUILAYOUTFILES is set.

u Plot configuration

HPGL plotting

Specify whether the plot settings from Power Extensions (PowerX_Styles\plotdefs) are used.

u User settings

Configuration directory

You can store customized configuration files of users in the userdata directory.

u Solidpower environment

Set TSPRO environment

If you have a data package for Creo Elements/Direct Modeling, select Yes. 

TSPRO directory

Enter the path to the directory that contains the data for Creo Elements/Direct Modeling.

Standard parts directory / Solidpower directory

Enter the path to the directory that contains the data for standard parts.

5.20.2.2  Start

In the Start tab you define the startup behavior of the application.

u  Startup settings 

Startup directory

Enter the working directory of Creo Elements/Direct Modeling.

Language

The language in which Creo Elements/Direct Modeling starts can be specified. If no setting

is selected, the application will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.



215GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

u Creo Elements/Direct license server

Creo Elements/Direct license server

Enter the license server that should be used for the selected unit, e. g. localhost, mels

No input (default): The license server that was entered in the setup is used.

u Licenses

The license server is determined automatically from the registry and cannot be specified

here.

Show licenses

Specifies whether the licenses specified in a project are displayed in the licenses tab of

GENIUS TOOLS Starter App.

Yes: Licenses are listed. The license status is not obtained; validation is possible by using

the Analyze Licenses function.

No: Licenses are not displayed. The settings Get extensions, Calculate licenses by

extension and Identify license users can not be utilized.

Identify license users

Specify whether users of a license can be determined.

Yes: In the GENIUS TOOLS Starter App, the users currently using a license feature are

displayed as a tooltip in the license display. The Windows user is replaced by the

GENIUS TOOLS Starter user alias from the workspace Users.

No: No user names are obtained or displayed.

Please note: To display names, the user names must be configured via Resources >

Users. Otherwise, the Windows user name is displayed.

 Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The servers are checked for

availability with a ping before a license evaluation. If it is not possible to ping the server,

the query will be performed anyway.

In addition, the value set here is used as the maximum time to query the licenses.

Default: 0 = No maximum query time is set.

5.20.2.3  Cleanup

Here, you can manage the cleanup settings of GENIUS TOOLS Starter App for projects. 

u User directory

SolidPower directory

Determines whether the SolidPower settings directory in the user directory is deleted

before project start.
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Yes: Delete

No: Retain

Default settings (LSP files)

Determines whether all LSP-files are deleted from the Default_Settings directory.

Yes: Delete

No: Retain

Further files or directories

Specify additional files or directories with user settings shall be deleted. The specification

is relative to the user directory, e. g. ANNOTATION\am_fluentui_layout.def

5.20.3  Project settings

Project settings are the specifications you make in the main page Projects  under

Applications > Creo Elements/Direct Modeling in the tabs Modeling, Start and Environment.

After having created a new project with the general project specifications, fill in the

following input fields. These entries overwrite both the group-specific entries and the

standard settings for the startup behavior of the application, which are made under

Configuration > Creo Elements/Direct Modeling > Tabs: Application / Start. For more

information, see the chapter Configuration concept.

5.20.3.1  Essential specifications

In the tab Modeling you specify essential details for a Creo Elements/Direct Modeling

project. 

Input fields without settings inherit the settings from unit specifications.

u Modeling

Release

Defines the Creo Direct/Elements Modeling version to be used. A path can be defined or

determined automatically from the registry of the application computer.

Fixed path: Select the directory from the drop-down menu. This can differ from the

Creo directory for the standard unit as defined on the Configuration page. If you do not

specify a Creo directory, the settings for the standard unit will be used.

Direct Modeling versions: Select a version, e. g.<Direct Modeling 20.4>. The

installation directory will be determined from the registry.

Please note: Creo Direct/Elements Modeling has to be installed locally on the

application computer in order to have registry entries available. The user must have read

permission in HKLM.

Project directory (optional)

Directory under elements_direct\configuration\projects. 
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Corp directory

Specify the path to the directory that contains company-specific configuration settings.

Site directory

Specify the path to the directory that contains site-specific configuration settings.

User directory

Specify the path to the user directory.

u Solidpower environment

Set TSPRO environment

If you have a data package for Creo Elements/Direct Modeling, select Yes. 

TSPRO directory

Enter the path to the directory that contains the data for Creo Elements/Direct Modeling.

Standard parts directory / Solidpower directory

Enter the path to the directory that contains the data for standard parts.

5.20.3.2  Startup behavior

In the Start tab you define the startup behavior for a Creo Elements/Direct Modeling

project. The specifications set here overwrite the settings for units. 

Consult the chapter Creo Elements/Direct Modeling > Unit settings > Start for a

description of the input fields. 

5.20.3.3  Environment variables

In the tab Environment you can set environment variables for a CED project. 

The variables set here are added to the variables defined for units. Values set here for an

existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A

list of created and affected environment variables can be found in the appendix.

5.21  Solidworks

A Starter project for the application SolidWorks requires:

– essential specifications

· a defined SolidWorks release

· SolidWorks-related data packages

– unit and project settings

– configuration blocks (SLDREG files)
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· for functions and behavior of SolidWorks

· for embedding additional applications (AddIns)

– settings for additional applications / linkages (batch files)

Please note: Creating starter projects with SolidWorks is a feature that requires a

subscription license.

For general information consult the chapter Starter projects.

For SolidWorks projects, project options can be created so that users can select directly at

the project which AddIns should, for example, be also started.

For SolidWorks all batch files can be used, which are opened before, during or after the

start of the application, see chapter Batch files. 

5.21.1  Configuration blocks für Solidworks

The behavior of SolidWorks is determined by entries in the registry. GENIUS TOOLS Starter

copies all project relevant configuration blocks (configuration component files) into a

configuration file (config.sldreg) and writes the settings that it contains into the registry

before starting SolidWorks .

The configuration blocks must be created manually and stored in the configuration layers

Standard, Unit, Project, User, see chapter Configuration concept. 

A configuration block for the application SolidWorks: 

– is a text file that must start with "config_" and end with ".sldreg", e. g.

config_addin_3dexp.sldreg,

– is one of many configuration sub files which are read by GENIUS TOOLS Starter and

which create the configuration of a SolidWorks Starter project,

– can be defined with conditions (see chapter Conditional configuration blocks), 

– can contain one or more configuration options, e. g. for 

· user interface and model appearance settings

· template settings

· settings for colors and materials

· import and export settings

If a configuration option is set multiple times, the last entry  – according to the call

hierarchy of the configuration blocks – is the valid option value. If a configuration option is

not set, the default value of the software is active. 
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Default settings
You can also write fallback options to an extra file named default.sldreg. This file can, for

example, contain specifications for the user interfaces. The default file will be processed

automatically if there is no user configuration in the registry (under Current User) for

SolidWorks.  Afterwards, the configuration file config_*.sldreg will be loaded if it is

available.

Creating configuration blocks for SolidWorks
1. Create a text file that starts with config and ends with .sldreg, e.g.

config_addin_3D.sldreg. 

2. Write in the first line: Windows Registry Editor Version 5.00

Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,

configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks using the add-on program

GENIUS TOOLS Config Editor, which provides color highlighting, auto-completion and

error messages.

Example: Set drawing frame of company ABC
Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\SOFTWARE\SolidWorks\SolidWorks 2021\Document Templates]

"Default Part template"="%GTS_DATA%\Document templates\\ABC\Part.prtdot"

"Default Assy template"="%GTS_DATA%\Document templates\ABC\Assembly.asmdot"

"Default Draw Template"="%GTS_DATA%\Document templates\ABC\Drawing.drwdot"

Example: Create a single project option for loading drawing frames of company

ABC.

When creating single project options, note that a semicolon (;) must be used as comment

character, e.g. ; gts_is_selectable = true. See chapter Single project options.

Windows Registry Editor Version 5.00

; gts_display_name = ABC drawing frame

; gts_description = ABC drawing frame

; gts_selection_name = ABC drawing frame

; gts_selection_default = false

; gts_is_selectable = true

[HKEY_CURRENT_USER\SOFTWARE\SolidWorks\SolidWorks 2021\Document Templates]

"Default Part template"="%GTS_DATA%\Document templates\inneo\Part.prtdot"

"Default Assy template"="%GTS_DATA%\Document templates\inneo\assembly.asmdot"

"Default Draw Template"="%GTS_DATA%\Document template\inneo\drawing.drwdot"
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Example: Create switch options for AddIns

To provide additional programs (AddIns) as options for SolidWorks projects, use the

gts_choose expression and write 00000001 for true value (ON) and 00000000 for false value

(OFF), see Switch options.

Windows Registry Editor Version 5.00

[HKEY_CURRENT_USER\SOFTWARE\SolidWorks\AddInsStartup\{1A49690A-CC1F-4C81-9B96-303C52F14AC3}]

@=dword:gts_choose{SolidWorks Composer||00000001||00000000}

5.21.2  Unit settings

In the main page Configuration  you can define the behavior of SolidWorks that will

apply to the system-wide standard (1) as well as for units and subunits (2).

Click Application (3), Start (4), Delete (5), and Write (6) to switch between tabs.

Please note: If an input field inherits values from the higher-level configuration levels,

you will still only see the global default value displayed in

gray.

Settings made directly on a SolidWorks project overwrite the settings made here, see

Project Settings.

For general information on units, see the chapter Configuring heterogeneous

environments: and for the inheritance of settings go to the chapter Call sequence for

settings.

5.21.2.1  Application

u Application

SolidWorks install path

You can specify a directory on the user computer where SolidWorks is installed or leave

this field empty, which means the installation directory is searched for automatically from

the local Windows registry and the version is used as specified in the project settings. For

more information consult the chapter CAD-specific project settings.

Please note: It is generally recommended to have the installation path be determined

from the local Windows registry.
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Data directory

Enter the data directory to be used. The data directory is the main directory of an

operating environment containing SolidWorks-related data, e. g. %GTS_ROOT_DIR%

\solid_works\data\swx_22.

u User settings

Configuration folder

Customized configuration blocks from users (Config files) can be stored in the userdata

directory.

Private configuration block

Enter the name of user-defined config_*.xml files, e. g. config_%username%.sldreg. It is

appended to the Config files in the users, projects, units and/or standard directories.

Please note: For storing their private config_*.sldreg files, users must have write access

to the userdata directory, as well as the access right Can save personal Configuration file

[to userdata directory] on server.

See also Config tab in GENIUS TOOLS Starter App.

5.21.2.2  Start

In the Start tab you define the startup behavior of the application.

u Startup behavior

Startup directory

Enter the working directory of SolidWorks.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer.

Show only installed languages

By default only languages of installed versions are displayed in the drop-down menu (see

above setting). 

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.

Enable stop batches

Yes: Additional batch files can be executed after the application has been stopped.

No: No stop batch files can be executed.
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Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

u Licenses

The license server is determined automatically from the registry and cannot be specified

here.

Show licenses

Specifies whether the licenses specified in a project are displayed in the licenses tab of

GENIUS TOOLS Starter App.

Yes: Licenses are listed. The license status is not obtained; validation is possible by using

the Analyze Licenses function.

No: Licenses are not displayed. The settings Get extensions, Calculate licenses by

extension and Identify license users can not be utilized.

Identify license users

Specify whether users of a license can be determined.

Yes: In the GENIUS TOOLS Starter App, the users currently using a license feature are

displayed as a tooltip in the license display. The Windows user is replaced by the

GENIUS TOOLS Starter user alias from the workspace Users.

No: No user names are obtained or displayed.

Please note: To display names, the user names must be configured via Resources >

Users. Otherwise, the Windows user name is displayed.

 Timeout for FlexNET server

Enter a maximum duration for the license query in seconds. The servers are checked for

availability with a ping before a license evaluation. If it is not possible to ping the server,

the query will be performed anyway.

In addition, the value set here is used as the maximum time to query the licenses.

Default: 0 = No maximum query time is set.

5.21.2.3  Cleanup

Here, you can manage the cleanup settings of GENIUS TOOLS Starter App for projects. 

u HKEYCURRENT_USER

Registry branch

Defines, whether the configuration settings for SolidWworks are deleted in the registry
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before project start.

Yes: Delete

No: Retain

5.21.2.4  Write

u Registry settings

Specify whether the file config.sldreg, generated by GENIUS TOOLS Starter, is executed.

This writes the entries to the registry.

Write registry entries

Yes (default): GENIUS TOOLS Starter writes into the registry.

No: No entries are written into the registry.

5.21.3  Project settings

Project settings are the specifications you make in the main page Projects  under

Applications > SolidWorks in the tabs SolidWorks, Start and Environment.

After having created a new project with the general project specifications, fill in the

following input fields. These entries overwrite both the unit-specific entries and the

standard settings for the startup behavior of the application, which are made under

Configuration > SolidWorks > Tabs: Application / Start. 

For more information, see the chapter Configuration concept.

5.21.3.1  Essential specifications

In the tab SolidWorks you specify essential details for a SolidWorks project. 

u SolidWorks

Release

Define the SolidWorks version to be used. The path can be fixed or determined

automatically from the registry of the application computer.

Fixed path: Select the directory from the newly appearing drop-down menu. If you do

not specify a directory, the settings for the unit Standard will be used. (Configuration >

SolidWorks > Standard > Tab: Application > SolidWorks install path)

SolidWorks versions: Specify a certain version. For example, the selection

<SolidWorks22> will determined the path to the lastest SolidWorks 22 version from the

registry.

Please note: SolidWorks has to be installed locally on the application computer in order

to have registry entries available. The user must have read permission in HKLM.
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Project folder

Directory in <application>\configuration\projects. From this directory configuration blocks

are copied to the application computer.

Please note: Configuration blocks should be stored separately from the data structure

due to their potential multiple use. They should be managed in the specific

subdirectories of the configuration directories units, projects or users, or in the standard

directory for global settings. See Configuration concept.

Data folder

Main directory of an operating environment in which application-related data is located.

5.21.3.2  Start behavior

In the Start tab you define the startup behavior for a single project. The specifications set

here overwrite the settings for units.

Starting behaviour 

Select the application that will open the project.

AutoCAD application (default): The project is started with the selected AutoCAD

application.

External: The project is started with another application (e. g. SAP).

If External is selected two additional fields open: 

External start command

Enter the path to the executable file that is to start the project.

Command arguments for external start

Enter commands that specify how the executable file is started. Set the commands in

quotation marks.

Startup directory

Enter the working directory of SolidWorks.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer.

Show only installed languages

By default only languages of installed versions are displayed in the drop-down menu (see

above setting). 

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.
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Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

5.21.3.3  Environment variables

In the tab Environment you can set environment variables for a SolidWorks project. 

The variables set here are added to the variables defined for units. Values set here for an

existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A

list of created and affected environment variables can be found in the appendix.

5.21.4  Project display in GENIUS TOOLS Starter App

General settings for projects are made in GENIUS TOOLS Project Configurator, see present

projects in GENIUS TOOLS Starter App. 

Project information
For the SolidWorks application, project details are displayed in the tabs Info, Licenses,

Config, Project Options and Backup. For a description of the information and functions in

the tabs, see the GENIUS TOOLS Starter App chapter under SolidWorks.

SolidWorks project display in GENIUS TOOLS Starter App

Project options
Administrators can set up a SolidWorks project with the following options:

– language: in the menu item Configuration under Settings > GENIUS TOOLS Starter App >

Projectste, see also Selection field for language. 

– project options (checkboxes)

· for embedding addin applications (switch option, in italic font) 
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· for one or more configuration settings (single project option)

· for combining configuration settings (combined project option)

Consult the chapterMaking use of project options for instructions of how to create the

needed options as well as the Configuration blocks chapter for examples.

5.22  Inventor

A Starter  project for the application Inventor requires:

– essential specifications

· a defined Inventor release

· Inventor-related data packages

– configuration blocks

· for settings of functions and behavior of Inventor (XML files)

· for embedding additional applications (ADDIN files),

– settings for additional applications / linkages (batch files)

– Project file (IPJ-Datei)

· for managing Inventor data

Please note: Creating starter projects for Inventor is a feature that requires a

subscription license.

For general information consult the chapter Starter projects.

5.22.1  Configuration principles

The behavior of Inventor is determined by two configuration files. These are:

UserApplicationOptions.xml

Configuration file for general configuration settings, e. g. for template paths, import and

export settings, settings for colors and materials.

InventorCustomization.xml

Configuration file for user interface settings.

The XML configuration files are created for each version and are located at:

 %APPDATA%/Autodesk/Inventor <version>  
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Embedding additional applications
By default, most additional applications (AddIns) that are installed with Inventor are

started automatically. If the default behavior for an add-on application is to be changed, a

file with the extension .addin must be created for that application. This is a text file that

can have any name, e. g. AdditiveMFG.inventor.addin.

The default settings can be found under %ALLUSERSPROFILE%\Autodesk\Inventor

<version>\Addins. 

ADDIN files, version dependent

If the default behavior of the add-on module is to be changed for a specific version, the

ADDIN configuration file is placed here:

 %APPDATA%/Autodesk/Inventor <Version>/Addins

ADDIN files, version independent

If the default behavior of the add-on module is to be changed for all versions, the ADDIN

configuration file is stored here:

 %APPDATA%/Autodesk/ApplicationPlugins

5.22.1.1  Project configuration with GENIUS TOOLS Starter

Configuration settings

By using GENIUS TOOLS Starter, configuration options are not written to Inventor

configuration files, but to different configuration subfiles of GENIUS TOOLS Starter, the

configuration blocks.

Configuration blocks that contain configuration settings can be stored in four different

configuration levels. When selecting a project in GENIUS TOOLS Starter App, the blocks

are loaded from the corresponding configuration levels and their contents are written to

the two required Inventor configuration files, UserApplicationOptions.xml and

InventorCustomization.xml, see next chapter.

The XML configuration files must be deleted from the Inventor directory before they can

be rewritten. This is set by default in GENIUS TOOLS Starter. Changes to this write

behavior can be made in the Delete and Write tabs of the unit settings.

By default, the XML configuration files are saved to the Inventor version directory (%

APPDATA%/Autodesk/Inventor <version>). However, you can specify a different directory,

in the unit settings in the Write tab > Target Directories.

Additional applications (AddIns)

The inclusion of additional applications can also be defined in the four different

configuration levels, by placing ADDIN files. The next chapter explains how to create

ADDIN files.
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Decide whether AddIn applications should be started for a specific version or for all

versions. Specify this in the unit settings in the Write tab under Target Directories > Add-

Ins. The possible locations are in the Appdata directory, see previous chapter

Configuration principles.

Write tab in the group settings

Project options

For Inventor projects, options can be created so that users can select directly at the project

which AddIns, for example, should be started.

A special feature is that for Inventor project options can be created to start the read-only

mode, see Read-only-Mode.

Batch files

For Inventor projects all batch files can be used, which are opened before, during or after

the start of the application, see chapter Batch files.

Inventor project files

For a Starter project you can use Inventor project files (IPJ files) which determine the

location of the work data, templates, styles and libraries.

Libraries are defined in the Libraries tab of GENIUS TOOLS Project Configurator and are

thereby written to the Inventor project file (IPJ file). If no IPJ file exists in an operating

environment, GENIUS TOOLS Starter uses the default project file at CC:

\Users\Public\Documents\Autodesk\Inventor <version>.
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You can store one or more IPJ files in the configuration layers standard, units, projects,

users of an operating environment. The search sequence is as follows: 

1. users > 2. projects > 3. units > 4. standard

The first IPJ file found is read, i. e. no settings are added to an existing file. See Call

sequence for files.

5.22.1.2  Configuration blocks for Inventor

Configuration blocks must be created manually and stored in the configuration levels

Standard, Unit, Project, User, see chapter Configuration concept. 

A configuration block for Inventor:

– is a text file with the extension .xml or .addin.

Type Notation Content Behavior

1 config_*.xml

z. B. config_dir_file.xml

general configuration

settings, e. g. for

template paths, import

and export settings,

settings for colors and

materials

specifications are

transferred to the

configuration file

UserApplicationOptions.x

ml before startup

2 ui_*.xml

z. B.

ui_customization.xml

user interface settings Details are transferred to

the

InventorCustomization.x

ml configuration file

before startup

3 *.addin

AdditiveMFG.inventor.ad

din

Includes or exlcudes

additional applications

file is saved version-

dependent or

independent,

starting an additional

application possible as a

project option

– can contain conditions (see chapter Conditional configuration blocks),

– can contain one or more configuration option(s).

If a configuration option is set multiple times, the last entry is – according to the call

hierarchy of configuration blocks – is the valid option value. If a configuration option is

not set, the default value of the software is active.



230GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Project Configurator

Creating configuration blocks for Inventor
1. Create a text file with the file ending .xml or .addin in the required configuration

directory.

2. Write in the first line: <?xml version="1.0" encoding="utf-16" standalone="no" ?>

Please note: For the correct display of German umlauts in GENIUS TOOLS Starter App,

configuration blocks must be written in UTF8.

You can conveniently create and modify configuration blocks using the add-on program

GENIUS TOOLS Config Editor, which provides color highlighting, auto-completion and

error messages.

XML file (type 1)

Example: Setting template paths

Create a text file named config_templates.xml with the following content.

<?xml version="1.0" encoding="utf-16" standalone="no" ?>

<ApplicationOptions Platform="Vista" Version="27.1 Production Candidate">

<File TemplatesPath="%GTS_DATA%\Templates\%LANGUAGE%\" />

<Save SaveReminder="0"/>

</ApplicationOptions>

ADDIN file (type 3)

Example: Execute add-in module “Additive Manufacturing” at startup

Create a text file named AdditiveMFG.inventor.addin and specify the ClassID and ClientID

of the add-on application, and the LoadOnStartUp command:

<Addin>

<!--Created for Autodesk Inventor Version 20.0-->

<ClassId>{4e2d52fb-8288-4427-b912-20ef97f073c9}</ClassId>

<ClientId>{4e2d52fb-8288-4427-b912-20ef97f073c9}</ClientId>

<LoadOnStartUp>1</LoadOnStartUp>

</Addin>

ADDIN file (type 3) as project option

Example: Make add-in module “Additive Manufacturing” available as a single

project option

Create the text file from the previous example. Insert the following between the first line

and the ClassID and ClientID:

<!-- gts_is_selectable=true -->

<!-- gts_selection_default=true -->

<!-- gts_display_name= Additive Manufacturing -->
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Other variables can be used, see table in chapter Single project options. Note the

application-specific notation of the GTS variables. 

5.22.1.3  User-driven configuration for Inventor

Users can manage Inventor configuration blocks themselves, overriding the settings made

by the administrator, if they have the appropriate access right. 

This type of user-defined settings are created by storing a private configuration block in

the userdata directory. Set the path to the userdata directory in GENIUS TOOLS Project

Configurator in Configuration > Settings: Inventor > Select Group > Tab: Application > User

Settings > Private configuration folder, as well as the notation of the private configuration

blocks. 

Consult the chapter User-driven configuration for detailed instructions.

5.22.2  Unit settings

In the menu item Configuration  you can define the program behavior of Inventor that

should apply to the selected group. You can make settings globally for the Standard unit

(1), as well as for units (2).

To fill in all fields, switch between the tabs Application, Start, Cleanup and Write (3). 

Unit settings for the application Inventor in GENIUS TOOLS Project Configurator

Settings for a single project are also possible. They overwrite the unit settings made here,

see Project settings.

Please note: If an input field inherits values from the higher-level configuration levels,

you will still only see the global default value displayed in

gray.

For general information on units, see the chapter Configuring heterogeneous

environments: chapter and on inheritance of settings, see the chapter Call sequence for

settings.
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5.22.2.1  Application

u Application

Inventor install path

You can specify a directory on the user computer where Inventor is installed or leave this

field empty, which means the installation directory is searched for automatically from the

local Windows registry and the version is used as specified in the project settings. For

more information consult the chapter CAD-specific project settings.

Please note: It is generally recommended to have the installation path be determined

from the local Windows registry.

Data directory

Enter the data directory to be used. The data directory is the main directory of an

operating environment containing Inventor-related data, e. g. %GTS_ROOT_DIR%

\inventors\data\inv_22.

Content Center directory

Target directory for Content Center libraries. Default: C:\ProgramData\Autodesk\Inventor

<Version>\Content Center\Libraries

u User settings

Private configuration directory

Customized configuration files of users can be stored in the userdata directory.

Private configuration block (Config)

Enter the name of a user-defined config_*.xml file for general settings, e. g. config_%

username%.xml. It is appended to the config_*.xml files in the users, projects, units and/or

standard directories and copied to the file UserApplicationOptions.xml.

Private configuration block (UI)

Enter the name of a user-defined ui_*.xml file for user interface settings, e. g. ui_%

username%.xml. It is appended to the ui_*.xml files in the users, projects, units and/or

standard directories and copied to the file InventorCustomization.xml.

Please note: For storing their private configuration blocks, users must have write

access to the userdata directory, as well as the access right Can save personal

Configuration file [to userdata directory] on server. See also Config tab in GENIUS

TOOLS Starter App.

5.22.2.2  Start

In the Start tab you define the startup behavior of the application.
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u Startup

Read-only mode selectable in GENIUS TOOLS Starter App

In GENIUS TOOLS Starter App a project options appears for selecting the read-only mode,

e. g. models cannot be edited. (See Project options.) 

Yes: Users can select the reading mode. 

No: There is no checkbox for selecting the read mode.

Startup directory

Enter the working directory of Inventor.

Language

The language in which the application starts can be specified. If no setting is selected, the

application will select the operating system language automatically.

<not specified / empty>: GENIUS TOOLS Starter does not create a language variable

(LANG) on the application computer (recommended).

System: The country-specific settings of the operating system are adopted.

<language>: This language is used, and the language variable LANG,if defined on the

application computer.

Show only installed languages

By default only languages of installed versions are displayed in the drop-down menu (see

above setting). 

Yes: Menu contains only installed languages.

No (default): Menu contains all languages supported by the application.

Enable stop batches

Yes: Additional batch files can be executed after the application has been stopped.

No: No stop batch files can be executed.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

5.22.2.3  Cleanup

By using GENIUS TOOLS Starter, you can store configuration subfiles ("blocks") in four

configuration levels. When a project is selected by a user, the corresponding blocks are

read from the configuration levels and the XML configuration files are created afresh. To

do this, any existing XML configuration files must be deleted first. This is set in the default

settings of GENIUS TOOLS Starter, but can be changed here. 

u User directory

Define whether the following configuration files are deleted or retained in the target

directory (as defined in the Write tab).
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Yes: Delete

No: Retain

UserApplicationOptions.xml 

Configuration file for general configuration settings, e. g. for template paths, import and

export settings or settings for colors and materials.

InventorCustomization.xml

Configuration file for user interface settings.

Add-Ins, version dependent

Configuration file(s) for embedding additional applications (.addin).

Add-Ins, version independent

Configuration file(s) for embedding additional applications (.addin).

u Startup directory

Project file (*ipj)

Define whether the Inventor project file (as defined in the Write tab) is deleted or retained

in the target directory.

u Content Center libraries

Content Center libraries

Define whether the Content Center libraries (as defined in the Libraries tab) are deleted or

retained in the target directory.

5.22.2.4  Write

Here, you can define target directories for Inventor configuration files and change the

write settings of GENIUS TOOLS Starter. 

u Target directories

UserApplicationOptions.xml

Select the directory in which the configuration file will be written. If no directory is

selected, the file will be written to the Appdata directory.

Appdata (default): %APPDATA%/Autodesk/Inventor <version>

Custom: The file is written to the directory specified in the upcoming field.

InventorCustomizations.xml

Select the directory in which the configuration file will be written. If no directory is

selected, the file will be written to the Appdata directory. 

Appdata (default): %APPDATA%/Autodesk/Inventor <version>

Custom: The file is written to the directory specified in the upcoming field.

Add-Ins

Select the directory to which the configuration files (ADDIN files) will be written. If no

directory is selected, the file will be written to the version dependent directory.

Appdata, version dependent (default): %APPDATA%/Autodesk/Inventor
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<version>/Addins

Appdata, version independent: %APPDATA%/Autodesk/ApplicationPlugins

u Config handling

GENIUS TOOLS Starter reads configuration subfiles ("blocks") and writes their contents to

Inventor configuration files. Specify whether the follwing Inventor configuration files are

created (default) or not: UserApplicationOptions.xml, InventorCustomizations.xml, Add-

Ins, Inventor project file (IPJ file), Content Center Libraries.

Yes (default): Write

No: Do not write

Warning: A new configuration file is only created if there is no configuration file with the

same name in the target directory. Make sure that the default setting Delete is set in the

Delete tab.

5.22.2.5  Libraries

Specify the libraries that should be available for the selected group or unit in the Inventor

projects they have access to. Unlike other settings in GENIUS TOOLS Project Configurator,

multiple entries are possible here. The inheritance behavior is therefore different.

Please note: The library information of a unit overwrites all library information of the

higher order unit(s). 

If you want to add a library path to a subordinate unit, do not forget to copy the paths of

the unit above into this unit. Use the copy function for this purpose, because copied

library entries (grayed out) adopt changes made in the original path.

The libraries defined here are written to the self-created Inventor project file (IPJ file) or to

the default IPJ file.

Appearance libraries

Enter one or more ADSKLIB files.

Active: Check the box to activate the library in Inventor.

Path: Library. The folder icon opens the Windows Explorer.

Delete: Deletes the path.

Copy: Copies the path.

Material libraries

Enter one or more ADSKLIB files.

Workspace

Enter the directory of the workspace.

Path name:  You can assign a name for the path.

Workgroup search paths

Enter one or more directories for workgroups.
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Libraries

Enter one or more directories for further libraries.

Frequently used subfolders

Enter one or more subdirectories located in one of the above defined paths.

Content Center libraries

Enter one or more IDCL files.

ReadOnly: Activates the read-only mode for this library.

AttachName: You can specify a name for the library. Default: file name

Servername: You can specify a server name. Default: localhost.

Content Center libraries
By default, Inventor installs Content Center libraries (IDCL files) at C:

\ProgramData\Autodesk\Inventor <version>\Content Center\Libraries. Additionally, you

can create your own Content Center libraries. You can use GENIUS TOOLS Starter to

distribute these to the user computers. To do so, store the IDCL files in the data directory

in the Caddepot, i. e. under %GTS_DATA%\Inventor <Version>\Content Center\Libraries.

GENIUS TOOLS Starter then copies these libraries to the target directory at project start,

since all Content Center libraries must be located in the same directory.

The target directory is preset to C:\ProgramData\Autodesk\Inventor <Version>\Content

Center\Libraries. If you want to change the target directory, you have to set two entries:

– In the UserApplicationOptions.xml file, set the following entry:

<ContentCenter DesktopContentDir="%GTS_DATA%\Inventor <Version>\Content Center\Libraries"/>

– In the Application tab change the target directory under Content Center directory.

In the Write tab you can activate or deactivate the copying of Content Center libraries.

IDCL files are never overwritten, i. e. they are only copied if they do not yet exist in the

target directory. Hence, standard Inventor Content Center libraries will not be overwritten.

In the Delete tab the cleanup behavior for Content Center libraries can be defined.

Standard Inventor libraries are not deleted,. Only IDCL files are deleted whose file name

does not begin with AI<4-digit version number>_Inventor.

5.22.3  Project settings

Project settings are the specifications you make in the main page Projects  under

Applications > Inventor.

After having created a new project with the general project specifications, fill in the

following input fields in the tabs Inventor, Start and Environment. These entries overwrite

both the group-specific entries ans well as the standard settings for the startup behavior

of the application, which are made under Configuration > Inventor > Tabs: Application /

Start. 
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For more information, see the chapter Configuration concept.

5.22.3.1  Essential specifications

In the tab Inventor you specify essential details for an Inventor project. 

u Inventor

Release

Define the Inventor version to be used. The path can be fixed or determined automatically

from the registry of the application computer.

Fixed path: Select the directory from the newly appearing drop-down menu. If you do

not specify a directory, the settings for the unit Standard will be used. (Configuration >

Inventor > Standard > Tab: Application > Inventor install path)

Inventor versions: Specify a certain version. For example, the selection <Inventor_22>

will determine the path to the latest Inventor 22 version from the registry.

Please note: Inventor has to be installed locally on the application computer in order to

have registry entries available. The user must have read permission in HKLM.

Project folder

Directory in <application>\configuration\projects. From this directory configuration blocks

are copied to the application computer.

Please note: Configuration blocks should be stored separately from the data structure

due to their potential multiple use. They should be managed in the specific

subdirectories of the configuration directories units, projects or users, or in the standard

directory for global settings. See Configuration concept.

Data folder

Main directory of an operating environment in which application-related data is located.

5.22.3.2  Start behavior

In the Start tab you define the startup behavior for a single project. The specifications set

here overwrite the settings for units.

Starting behaviour 

Select the application that will open the project.

Inventor (default): The project is started with Inventor.

External: The project is started with another application (e. g. SAP).

If External is selected two additional fields open: 

External start command

Enter the path to the executable file that is to start the project.
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Command arguments for external start

Enter commands that specify how the executable file is started. Set the commands in

quotation marks.

Use read-only mode

Specify whether the project is to start in read-only mode.

Yes: The project starts in read-only mode. The environment variable

GTS_USE_INVENTOR_READONLY is set to 1. This allows the selected mode to be used as

information in, for example, a batch script to start Inventor externally.

No (Default): The project starts in professional mode. The environment variable

GTS_USE_INVENTOR_READONLY is set to 0.

Please note: The setting Use read-only mode can be overridden if the user is given the

option to select the mode, in 

Startup directory

Enter the working directory of Inventor.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

5.22.3.3  Libraries

In the Libraries tab, specify the paths to the libraries that should be available at project

level. The entries made here overwrite the settings for units. They are described in the Unit

settings > Libraries chapter.

5.22.3.4  Environment variables

In the tab Environment you can set environment variables for an Inventor project.

The variables set here are added to the variables defined for units. Values set here for an

existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A

list of created and affected environment variables can be found in the appendix.

5.22.4  Read-only mode

Inventor can be started in read-only mode. There are two options are available.
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1. Start project in read-only mode
Go to the Project Settings in the Start tab and turn on the swith Use read-only mode.

Using read-only mode as project setting

The project starts in read-only mode. The environment variable

GTS_USE_INVENTOR_READONLY is set to 1. This allows the selected mode to be used as

information in, for example, a batch script to start Inventor externally.

This setting can be overridden by the user if his unit or group is given the permission to

select the mode, i.e. a project option is created.

2. Project option for read-only mode
You can grant users the option to select the read-only mode directly on the project in

GENIUS TOOLS Starter App. To do this, set the Read-only mode selectable in GENIUS

TOOLS Starter App to Yes in the Start tab of the unit settings.

Read-only mode as project option in the group settings

If in the project settings the switch Use read-only mode is set to Yes, as in the example

above, the checkbox is by default already checked.

Checked project option in GENIUS TOOLS Starter App

5.22.5  Project display in GENIUS TOOLS Starter App

To present projects in GENIUS TOOLS Starter App, you can specify the general settings

that apply to all applications. There are also the following application-specific options.
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Project information
For the Inventor application, project details are displayed in the tabs Info, Config, UI,

Project Options and Backup. For a description of the information and functions contained

therein, see the GENIUS TOOLS Starter App chapter under Inventor.

Inventor project display in GENIUS TOOLS Starter App

Project options
The following project options can be made available:

– Language: in the menu item Configuration under Settings > GENIUS TOOLS Starter App

> Projects, see Selection field for language.

– Project options (checkboxes):

· to start in read-only mode (previous chapter)

· for embedding add-in applications (single project option)

· for one or more configuration settings (single project option)

· for combining configuration settings (combined project options)

· for switching between defined configuration settings (switch option)

For creating project options, consult the chapter Configuration blocks for Inventor as well

as the instructions for creating the different types of project options.

5.23  AutoCAD

Starter  projecte for the applications AutoCAD, AutoCAD Architecture und AutoCAD

Mechanical are created with

– essential specifications

· a defined release

· application-related data packages

– specifications for the start behavior 

– settings for additional applications / linkages (batch files)
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Please note: No unit settings can be defined yet for projects of the AutoCAD

applications and no configuration blocks can be created.

Creating starter projects for AutoCAD applications is a feature that requires a

subscription license.

For general information consult the chapter Starter projects.

5.23.1  Project settings

Project settings are the specifications you make in the main page Projects  under

Applications > AutoCAD, AutoCAD Architecture or AutoCAD Mechanical in the tabs

AutoCAD, Start and Umgebung

The applications AutcoCAD Architecure and AutoCAD Mechanical have the same input

fields since all AutoCAD applications are started with the same execution file (EXE file).

GENIUS TOOLS Starter generates the correct start command for the applications in the

background.

5.23.1.1  Essential specifications

After having created a new project with the general project specifications, fill in the

following input fields. 

Release

Define the version to be used. The path can be fixed or determined automatically from the

registry of the application computer.

Fixed path: Select the directory from the newly appearing drop-down menu. If you do

not specify a directory, the settings for the standard unit will be used. (Configuration >

Application > Standard > Tab: Application > Install path)

Versions: Specify a certain version. For example, the selection <2022> will determine

the path to the latest installation of the version from the registry.

Please note: The application has to be installed locally on the application computer in

order to have registry entries available. The user must have read permission in HKLM.

Project folder

Directory in <application>\configuration\projects. From this directory configuration blocks

are copied to the application computer.

Please note: Configuration blocks should be stored separately from the data structure

due to their potential multiple use. They should be managed in the specific

subdirectories of the configuration directories units, projects or users, or in the standard

directory for global settings. See Configuration concept.
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Data folder

Main directory of an operating environment in which application-related data is located.

5.23.1.2  Start behavior

In the Start tab you define the startup behavior for a single project. 

Starting behaviour 

Select the application that will open the project.

AutoCAD(default): The project is started with the selected AutoCAD application.

External: The project is started with another application (e. g. SAP).

If External is selected two additional fields open: 

External start command

Enter the path to the executable file that is to start the project.

Command arguments for external start

Enter commands that specify how the executable file is started. Set the commands in

quotation marks.

Startup directory

Enter the working directory of AutoCAD.

Synchronize with project start

Defines whether project data is to be synchronized before a project opens. This

guarantees that all configuration and batch files are up to date when starting a project. 

No (default): No data is synchronized before opening a project.

Yes: Data is synchronized, i. e. the directories standard, units, projects and users in the

<application>\configuration directory.

5.23.1.3  Environment variables

The variables set here are added to the variables defined for units. Values set here for an

existing environment variable will overwrite the values for units.

Outdated environment variables will continue to be created for compatibility reasons. A

list of created and affected environment variables can be found in the appendix.

5.24  Working with satellites

A satellite (also: synchronization or mirror server) is a computer or a sector of a computer

onto which the state of one or more operating environments of a central main server is

mirrored by data synchronization.

Operating satellites is beneficial at locations that have a slow connection to the main

server. User computers can significantly reduce the time required for data synchronization

by accessing a satellite that is easier to reach.
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You can operate active and passive satellites.

An active satellite is a server that request data to be synchronized from the main server at

a defined time interval. This requires GENIUS TOOLS Starter Service. 

A passive satellite is a shared directory on a computer, to which data from the main server

is copied. It does not require a service. 

Active satellit Passive satellite

Server Shared folder on a computer 

Requires GENIUS TOOLS Starter Service No service required

Changes in files on the main server will be

synchronized to the target with the next

synchronization according to the defined

time interval

Changes in files on the main server will be

synchronized immediately. The defined

synchronization interval serves as a back

up, meaning that after this period all files

will be synchronized at the latest.

5.24.1  Creating satellites

In the Satellites page  you can create and manage satellites and monitor

synchronization.

A computer is installed as a satellite if you specify this in a configuration file of the GENIUS

TOOLS Starter Service. The configuration files (CFG files) must be located in the

configuration directory in the installation depot. 

Path: \\<mainserver>\GTSTARTER\installdepot\gts-service-latest\conf
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Menu item Satellites in GENIUS TOOLS Project Configurator

Procedure: Adding new satellites

In order to operate satellites GENIUS TOOLS Starter Service must be running on the main

synchronization server (“main server”). Active satellites also require this service, passive

satellites do not. The procedure is described in detail in the document GENIUS TOOLS

Starter Installation.pdf in the chapter GENIUS TOOLS Starter Service.

1. Create a new configuration file (CFG file) with the plus symbol. A new dialog opens.

2. Select the type of satellite.

3. Fill in the input fields as described in the program help.

4. Save the settings.

Result: The configuration file is saved in the configuration directory.

Warning: If access to the configuration directory is not possible, you can select a

different storage location in the save dialog. The file must then be moved to the

configuration directory manually.

5. Go to the Main server page.

6. Enter the web URL in the notation http://<mainservername>:<portnumber>. The port

name must correspond to the value for the entry service.rest.port= in the

configuration file gt_service_<mainservername>.cfg. The standard port is 8092.
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7. Switch on the Use satellite radio button.

8. Restart the main server.

Result: GENIUS TOOLS Starter App automatically determines which synchronization server

(satellite or main server) responds fastest based on the ping runtime. This is then used for

synchronization to the user computer. 

5.24.2  Monitoring satellite status

The satellite page contains an overview of all satellites known to the main server. The

following information show whether the satellites are available.

Status

If GENIUS TOOLS Starter Service is not running, a red circle is displayed for active satellite.

As the service is not running on passive satellites, their status cannot be displayed.

Last started

Displays time when the GENIUS TOOLS Starter Service was last started.

Last sync time

Displays time when synchronization was last started.

Last shutdown

Shows when the GENIUS TOOLS Starter Service was last stopped.

5.24.3  Managing satellites

Use the following non-automated actions to control the synchronization of satellites and

GENIUS TOOLS Starter Service.

 Restore satellite configuration file

Restores the state of the file before the last change. 

 Trigger synchronization

The satellite is synchronized immediately regardless of the configured interval.

 Restart

GENIUS TOOLS Starter Service is terminated on the active satellite and restarted. 

 Stop GENIUS TOOLS Starter Service

GENIUS TOOLS Starter Service is terminated on the active satellite.

Warning: After this action, the service must be restarted on the active satellite.

Delete

This function includes the following actions:

– Uninstalls the GENIUS TOOLS Starter Service on the satellite.
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– Removes the results file on the main server.

\\<mainserver>\gtstarter\installdepot\gts-service-

latest\results\gts_satellite_info_<satellite_name>.json

– Removes the configuration file in the configuration directory.

\\<mainserver>\gtstarter\installdepot\gts-service-

latest\conf\gt_service_<satellite_name>.cfg.

– Deletes the satellite entry in GENIUS TOOLS Project Configurator.

5.24.4  Editing satellite configuration

You can edit the configuration of existing satellites by clicking on the corresponding line

and changing the option values in the Configuration section. They are described in the

inline help.

Please note: If the configuration files for the main server and satellites contain

different information, the setting of the satellite applies.

An overview of all options can be found in the GENIUS TOOLS Starter installation manual

in the chapter GENIUS TOOLS Starter Service > Working with satellites > Configuration

options for satellite operation.

5.25  Working with Windchill

GENIUS TOOLS Starter can be used in conjunction with Windchill. The following section

describes requirements and considerations for working with Windchill.

If you want GENIUS TOOLS Starter to look for Creo data in Windchill first, and in the

project directories in the second place, you should set your system settings to Using

Windchill. To do so, go to Configuration > Standard > Windchill settings > General > Using

Windchill > Yes.
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Main menu item Configuration > Settings

5.25.1  Object search hierarchy in Creo

Creo looks for objects in the following order:

1. Creo session

2. Search or call directory in which the parent object has been found, or directory which is

specified in the Open dialog.

3. Active Windchill workspace.

4. Active Windchill commonspace

5. Local working directory

6. Search paths

(See http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190.)

5.25.2  Using a Windchill library

You can define dedicated directories for libraries, drawing frames, start objects and UDF in

Creo. When you are using Windchill, these directories can point to products or libraries in

the Windchill environment. The required syntax of the config.pro entry is as follows, using

the library directory of Windchill PDMLink as an example.

Pro_library_dir wtpub://<Windchill_server>/<Context>/<Directory>

– wtpub: refers to the Windchill commonspace

– <Windchill server>: name of the Windchill server as registered in Creo

– <Context>: context you want to refer to, e.g., SUT libraries

– <Directory>: directory within the context

http://www.ptc.com/appserver/cs/view/solution.jsp?n=131190
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Each user can define their own name for the Windchill server. This means that the general

config.pro entry cannot point unequivocally to a storage location, as maybe not all users

have used the same name when first registering the server. The following section

describes how GENIUS TOOLS Starter can be used to influence Windchill server naming.

5.25.3  Automatic Windchill server rename

In the general Windchill settings in GENIUS TOOLS Project Configurator, you can define a

Windchill server name that should be used system-wide (Configuration > Standard >

Windchill settings > General > Windchill server name). To link this name with an existing,

manually configured Windchill server, you also have to make two other settings:

1. Windchill server URL: address of the Windchill server

2. Server auto rename: Yes (under Register)

If a server is found under the URL you have specified for the Windchill server, this server

will be renamed to the specified name on the next Creo start.

5.25.4  Automatic Windchill server registration

The Windchill server registration enables the automatic registration of a Windchill server

under a given name in PTC Creo.

The concept of automatic server registration is that previously registered servers are

retained without changing the entire registration and that a newly registered server is set

to active. It is also part of the concept that server registration does not result in the

registered server reverting to active as soon as a project with the corresponding

configuration is selected. Usually the user wants Windchill settings of the previous Creo

session to be set again after restarting Creo.

Users who are to get access to a Windchill server via automatic server registration need to

have a valid Windchill account and have access to the defined workspace in the defined

Windchill context. It can be useful to create a context (product, library or project) that is

not otherwise used and that these users have access to.

Please note: In order to use automatic server registration, the following requirements

must be met:

– Using Windchill must be activated.  (Configuration > Select unit > Windchill Settings >

Section: General)

– The Windchill Context must be set and must exist.

– The default workspace must be located in the Windchill Context that is given.

– The Windchill cache directory must be a subdirectory of the Windchill user root folder.

Users who are to be granted access to a Windchill server using automatic server
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registration must have a valid Windchill account and access to the specified workspace in

the registered Windchill context. It may be advisable to create an otherwise unused

product, library or project to which these requirements apply and to which users have

access.

Automatic server registration is configured under configuration > (Select unit) > Windchill

settings. The Windchill settings are expanded once you set Use Windchill to Yes.

u General

Use Windchill

Activate/deactivate the Windchill server. To use Windchill automatic server registration,

this function must be set to Yes.

Yes: Activates Windchill-relevant settings such as automatic server registration.

No: Windchill settings will be disregarded.

No, don't register: The Creo session is started without an active Windchill server.

However, the Windchill server remains in the server registry without being selected.

Windchill server name

Specify the name with which the server will be registered in Creo.

Windchill server URL

Specify the URL under which the server can be reached.

u Register

Server auto register

Select whether the server should be registered automatically.

Yes: The above mentioned Windchill server is automatically registered and is then

available within Creo.

No: The server is not entered automatically.

Server auto rename

If a server already exists at Windchill server URL and has a different name than Windchill

server name, the server will be renamed when starting Creo next.

Set Windchill server online

Select whether the server should be put online.

Yes: A new server that was added by auto-registration will automatically be put online.

No: The server is registered offline.

u Windchill context

Default workspace name

Name of the workspace that is active during registration. The default workspace has to be

present under the context given.

Windchill context type

Type of context: Product, Library, Project.
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Windchill context

Context of the workspace.

Changing server path from HTTP to HTTPS
When changing the Windchill server path from HTTP to HTTPS, Creo Parametric may

encounter errors that interfere with the correct execution of Windchill auto-registration.

To avoid this, it is recommended to create a new cache directory and delete the old server

path – after a transition period, if necessary.

The entry for the Windchill cache directory is located in the main menu item Configuration

under Creo settings > Section: Startup settings.

5.25.5  Project-specific Windchill settings

You can also define a Windchill server to be used for a specific project. To do so, go to the

Projects page, select the desired Creo Parametric project and make the project-specific

Windchill settings in the Windchill tab.

See also Workspace for Windchill.

5.25.6  Integration in Windchill Worker

If you want to open Creo with Windchill, you can use GENIUS TOOLS Starter to apply the

project settings and environment variables. In this case, you will neither get the GENIUS

TOOLS Starter user interface nor will Creo be opened. For this option, you must create an

extra project for access by the Windchill Worker. Proceed as follows.

Steps for integrating GENIUS TOOLS Starter into an existing Windchill Worker

Creating a project in GENIUS TOOLS Project Configurator

1. In the main page Projects  click the Create button. A new project is created with the

name "New Project". 

2. Rename the project. The default name is publish. 

3. If you want the project to be invisible to users, hide it in the Creo tab in the section

General with Hide Project. Alternatively, you can create a role which you grant access

to the project.

4. If necessary, assign a separate license to the project in a Creo startkey (PSF file). 

Including the call to the GENIUS TOOLS Starter App in the Worker batch file

5. Open the batch file proeworker.bat in the Windchill Worker directory.

6. Enter the following line below the line set PVIEW_HOME=D:\ptc\object adapter:
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call <cadpoolpath>\<nameofoperatingenvironment>\software\worker.bat <project
name>

The project name corresponds to the name selected in step 2.

Install Cadpool on user computer

7. Make sure that GENIUS TOOLS Starter is installed on the user computers that are to

access the project. To do so, perform an initial synchronization by opening the file

gts.exe from the operating environment of the Caddepot directory which is located

on the administration computer: <caddepotpath\<working environment

name>\software\gts.exe

This will install the Cadpool directory and synchronize it with the Caddepot directory.

5.25.7  Freely configurable debug mode

GENIUS TOOLS Starter provides a freely configurable debug mode that allows you to use

the Windchill Workgroup Manager to interact with Windchill in debug mode.

The files logger.cfg.debug and logger.cfg.bat are used for this purpose according to the

call hierarchy for configuration files. Place both files in the standard directory <working

environment name>\configuration\standard. 

Hint: Information on how to use client log files for debugging with Windchill

Workgroup Manager can be found at PTC in article CS140107.

logger.cfg.debug

If the logger.cfg.debug file exists multiple times within the directory, it is copied together

like a config.pro file. File names are used in the following notation: logger.cfg*.debug 

After merging logger.cfg.debug the log output folder is always set to HOME\ANALYSEWF

by adding the line log_dir_path.

logger.cfg.bat

The batch file is used to define environment variables which should be additionally

defined in the Creo session if the debug mode is used. If more than one batch file exists,

all batch files matching the logger.cfg*.bat notation will be executed.

The debug mode is switched on in the user menu of GENIUS TOOLS Starter App with

Debug Creo/Windchill.

https://www.ptc.com/en/support/article/CS140107
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6  GENIUS TOOLS Starter App

GENIUS TOOLS Starter App lists the projects defined in GENIUS TOOLS Project

Configurator and lets the users start them.

If changes are made to the central configuration, these changes are taken up by GENIUS

TOOLS Starter App with the next synchronization.

Information on the configuration of the interface and the selection options can be found

in the chapter Settings for GENIUS TOOLS Starter App.

6.1  Starting GENIUS TOOLS Starter App

By default, GENIUS TOOLS Starter App is configured to start automatically with the

operating system. GENIUS TOOLS Starter App is displayed in the Windows task bar and

can be called up from there.

If GENIUS TOOLS Starter App is not started automatically, the app can be started via a

centrally configurable desktop link.

Please note: To close GENIUS TOOLS Starter App, select Exit in the user menu .

When you click Close, the window is minimized.

6.2  Login

An input window for login credentials appears if a system other than Windows is required

for authentication, e. g. Windchill.

For more information, consult the chapter Authentication.
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6.3  User interface

GENIUS TOOLS Starter App comes with a clearly structured user interface. Depending on

the configuration, for example, license information on the PTC products configured for

each project is listed in the user interface.

Start the desired project with a double-click. The desktop application is started with the

configuration defined for the project.

Auto projects are applications which cannot be configured and are automatically listed by

GENIUS TOOLS Starter.

User interface of GENIUS TOOLS Starter App

The user interface of GENIUS TOOLS Starter App is divided into three areas.

Left area for selection of a

1. unit and 

2. project collections: company-specific (e. g. My Projects, Project Archive) and

application-specific (e.g. Creo Parametric, Creo Elements/Direct Modeling), as well as

auto projects: applications that are be automatically listed by GENIUS TOOLS Starter

(e. g. MathCad, KeyShot). .

Central area with project list

3. Configurated Starter project, maybe with project options

The  information area on the right side opens when clicking on a project details button in

a selected project. These are the corresponding  

4. information tabs: 

Info: Shows the most important project (name, directories, Creo startkey, language of

the project).
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Licences: Displays all license servers and gives access to analyzing and borrowing

licenses if user has access rights.

Config: Shows configuration blocks and their location for the selected project, as well as

additional applications (toolkit applications).

Project options: Shows all selectable configuration settings for license extensions,

additional programs etc. (Single project options).

Backup: Allows users to save user-specific settings, UI settings for Creo.

Modify: Saves the project with the project options selected by the user as custom

projects.

Warning / Error: These tabs are only displayed if a project cannot be started or causes a

warning.

There are two bars for operating the Starter App

5. Sidebar with user menu 

6. Footer with information on licenses and synchronization

6.4  Sidebar

The sidebar contains the following functions.

  User

A picture can be displayed here. Store it in JPEG, PNG, SVG or GIF format (100*130 px)

under the name of the user, in the userdata directory, e. g.

<caddepot>\<environment>\userdata\%USERNAME%\%USERNAME%.png.

 Refresh Projects (F5)

Refresh Projects reloads all project configurations from the local computer.

Message from Administrator (F4) 

There are new messages from your administrator when a red number is displayed on the

letter symbol. Messages that have been opened are displayed in gray color and can be

reread. Messages are saved as text files in the _Information directory, see also Sending
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messages to the users.

 User menu

6.5  User menu

To access the user menu, click on the gear symbol  in the sidebar.

Language: user interface language

You can switch the user interface language between English, German and French at any

time. The language setting is saved and will be used the next time you start the software.

The software first starts with a German user interface if the operating system locale is set

to German. For all other locale settings, the software first starts with an English user

interface.

Theme: user interface color settings

The software comes with the color themes Blue, Light and Dark. You can switch themes at

any time. The theme setting is saved and will be used the next time you start the software.

Synchronize now (F8)

GENIUS TOOLS Starter immediately synchronizes from the central Caddepot, regardless of

the specified synchronization interval, and loads any updated files into the Cadpool.

Pause synchronization (F7)

GENIUS TOOLS Starter stops synchronization until it is re-started by the user. The setting

Pause synchronization is saved for the next start and marked by a yellow bar below the

header. When the user resumes synchronization, they are asked whether they want to

resume and overwrite local changes.

Pause synchronization if you want to prevent local changes from being overwritten until

they have been added to the Caddepot by your administrator.

Please note: Your administrator defines whether you can pause the synchronization. If

you are not allowed to pause the synchronization, the item Pause synchronization is not

displayed in the menu.

Debug Creo/Windchill

Switches Creo debug mode on. This mode processes the files logger.cfg.debug and

logger.cfg.bat. Settings for this are made by the administrator, see chapter Freely

configurable debug mode.
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Help

– Help (F1): Software manual for GENIUS TOOLS Starter, which corresponds to this

document.

– Support: Contact details for the technical support of INNEO or a company-specific link

which can be set up in GENIUS TOOLS Project Configurator. Inneo's support can be

reached by email, telephone and with Teamviewer. 

– Info (F12): Current GENIUS TOOLS Starter version. 

Open home

Opens the user directory in the file manager.

Open log file (F2)

Opens the log file that is written on each project start. The log file gts-starter-INNEO.log is

saved in the user directory of the client.

Please note: Please always find and check your log file before opening a call with the

support hotline. The log file is required for troubleshooting any issues.

Open sync log file (F3)

Opens the log file that is written by GENIUS TOOLS Starter App and  GENIUS TOOLS

Project Configurator at each synchronization. The log file gts-starter-INNEO-sync.log is

saved in the user directory of the client.

Reset window size

Restores the default size of the dialog window of GENIUS TOOLS Starter. The window can

be adjusted to all sizes. 

Switch user – only visible with an alternative authentication system

Switches to another user of the applied authentication system, e. g. Windchill.

Exit

Closes the software. Clicking on the Close button (X) in the header will minimize the

program window.

Project Configurator (F8)

Opens GENIUS TOOLS Project Configurator.
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Please note: Your administrator defines whether you can access GENIUS TOOLS Project

Configurator via access rights. If you are denied access, the item GENIUS TOOLS Project

Configurator is not displayed in the menu.

6.6  Footer

The footer contains the following information. 

Data base mode

The state of the database is displayed in the footer:

 Database requires a subscription license. Projects cannot be started when working with

a permanent license.

 Database has been created with a permanent license. It can be accessed by both

permanent and subscription license.

License mode

The GENIUS TOOLS Starter App footer shows the current license mode by displaying an

icon.

 Full version 

 Full version. No free subscription license available, i. e. projects cannot be started.

 Borrowed license 

 Educational or home use 

 Fail-safe mode for GENIUS TOOLS Starter: If the license server is not available, the

fallback license is used.

A fail-safe license is available only after GENIUS TOOLS Starter has found valid licenses

on a license server during project validation. Projects are validated by the command

Refresh Projects  in the sidebar.

Warning: The fail-safe mode works for GENIUS TOOLS Starter only, not for GENIUS

TOOLS for Creo or other products.
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Synchronization mode and synchronization status

To the right of the icon for the license mode, information on the synchronization mode is

displayed. For more information, please refer to Procedures and synchronization.

 Synchronization is active 

Hover the mouse on the synchronization symbol to see the paths to the Caddepot and to

the local operating environment as a tooltip.

 Synchronization inactive

The synchronization of toolkit applications is paused as long as Creo is running 

 Local operating environment

There is no synchronization; you work on a local directory 

License borrowed until:

This icon appears when licenses have been borrowed.

The synchronization status with the date and time of the last synchronization is displayed

in the middle area of the footer.

Running applications

If a supported desktop application is running, the application icon will be displayed in the

footer, e. g.

 Creo Parametric

 Creo Elements/Direct Modeling

6.7  Selecting a unit

When using a subscription license, units can be defined as an additional configuration

layer to reflect different company branches or divisions. A user can be assigned to multiple

units. (See chapter Configuring heterogeneous environments.)

If units are used in the working environment and the user can choose from at least two

units, a separate dialog opens to select a unit or subunit.
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Units are displayed in alphabetical order, unless a unit is defined to be the first on the list.

This can be specified in GENIUS TOOLS Project Configurator by inserting a space character

in front of the unit name. (See Displaying units in GENIUS TOOLS Starter App.)

In this dialog box you can select a unit. Note that units can be selected from several levels.

If no selection is made, the first unit in the drop-down menu will be used. 

Confirm the selection with the Change button at the bottom right.

6.8  Display of projects

Information about a project is available in the area below the selected project, the info

tabs, and by the color of the bar to the left of the project name.

Color coding: License check for projects
In GENIUS TOOLS Project Configurator, your administrator can define whether you can

check for available licenses (this adds the Analyze licenses button in the Licenses tab) and

how projects should be displayed if there is no license available for them. The display of

projects without a license can be set by the administrator as follows:

– The projects are not visible for the user. 

– The projects are marked with a red background and cannot be started. 

– The projects are marked with a gray background and cannot be started. 

– The projects are marked with a yellow background and can be started. 

The setting are made in GENIUS TOOLS Project Configurator under Configuration > Group

(select) > Settings: GENIUS TOOLS Starter App > Segment: Projects, see Marking invalid

projects.

For Creo Parametric and SolidWorks projects, it is possible to check available licenses. 
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Info symbols
When selecting a project the following icons will appear in the area below the project

name. Some icons can be disabled.

 

 

Clicking on an info icons opens tabs or functions. 

Symbol / Function Available for projects of Can be

dis-

abled?Creo CED Solid-

Works

Inventor Auto-

CAD,

Apps

Opens the

tab Info

X X X X X yes

Opens the

tab Licenses

X X X yes

Opens the

tab Konfig

X X X no

Opens the

tab UI

X no

Opens the

tab Backup

X X X yes

Opens

Project

report (PDF

file)

X yes
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Symbol / Function Available for projects of Can be

dis-

abled?Creo CED Solid-

Works

Inventor Auto-

CAD,

Apps

Opens

GENIUS

TOOLS

Starter App

Config

Analyzer

X yes

Opens the

tab Modify

X X X X X no

Will occur if

some

checkboxes

cannot be

displayed in

the dialog

window.

Opens the

tab Project

options

X X X no

Will occur if a

project

triggers a

warning.

Opens the

tab  Warning

X X X X X no

An overview of how to configure the info icons and tabs can be found in the GENIUS

TOOLS Project Configurator chapter under Customizing information panes.
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6.9  Project options

Project options can be made available for CAD applications. They are displayed either in

the form of 

– drop-down menus, for the choice of language and Creo start key, or

– checkboxes, for the choice of license extensions, additional applications and

configuration settings.

If some checkboxes cannot be displayed below the project, an the arrow symbol appears

that opens the Project options tab listing all available options.

The following table explains the different types of project options 

Type Function Description

1 Language selects the language in which the application starts the

project

2 Creo startkey selects the license package (PSF key) to start a Creo

Parametric project with

3 Single project

option

activates one or more configuration settings

activates additional programs for Creo Parametric

projects

3 Single project

option

activates license extensions  for Creo Parametric projects

activates additional programs for Inventor projects
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Type Function Description

4 Switch option

(italic)

switches between two values of one or more

configuration settings

activates add-ins for SolidWorks

5 Combined

project option

activates combined configuration settings, i. e. settings

located in different directories and levels

after selection further single project options (3) may

become available

6 Context menu,

opens with right-

click

opens a menu to deselect or select all options

The checkboxes for these project options are created with configuration blocks. Consult

the instructions for Making use of project options.

Behavior of switch options
In contrast to single project options, a value will be read from a switch option even if the

option is not checked (disabled state), see Switch options. For users who have the right to

deactivate configuration blocks in the Config tab of GENIUS TOOLS Starter App, this

means: 

1. Deactivating the configuration block will ignore the content of the configuration block,

i. e. as with all configuration blocks, it will not be included into the configuration.

2. In contrast to single project options, the checkbox of the switch options then

disappears, because neither the checked (true value) nor the unchecked setting (false

value) is to be used for configuration.

Only checked configuration blocks (in the Config tab) generate checkboxes for switch options
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6.10  Custom projects

Users can save a project with all selected project options as a custom project.

Modify tab for saving a custom project

Procedure: Creating a custom project (user-defined project)

1. Select the desired project options (language, Creo start key, checkboxes with

configuration settings).

2. Click the Save icon  to open the Modify tab.

3. Enter a name for the custom project.

4. You can check the selected project options in the Customizations area.

5. Click on Save .

Result: The custom project appears in the project list with the specified name and a purple

label indicating the original project from which it has been created. 

6.11  Favorites

Favorites are projects that users mark as by clicking on the star symbol . This creates a

user-defined project collection listed under Favorites. 

If the first project is marked as a favorite, the Favorites button appears on the left of

GENIUS TOOLS Starter App. A red balloon appears in the button after a project has been

marked as a favorite.
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6.12  Creating backup copies

In GENIUS TOOLS Starter App, a backup file can be created of the configuration files of

CAD applications. This is useful for users who manage their own configuration files, but

also for administrators who want to make test changes, for example to the Creo user

interface. 

In the project details area of GENIUS TOOLS Starter App, click the button . The Backup

tab of the project opens. The files for a backup differ depending on the application and

are described below in the chapter Backup of an application. 

6.13  Tabs for all applications

Different tabs are available for the various applications. The Info, Warning, Error and

Modify tabs are available for all applications. There are additional tabs for various CAD

applications, see the following chapters.
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Info
The Info tab contains

information on the

selected project. 

Users may be able to

open all directories

and files – such as

the PSF file (Creo

startkey) – in the

Info tab of a project

by double-clicking

on a line. To access

this function, users

need to be given the

access right Can

open configuration

blocks. 

The information varies from application to application. 

– Project name

– Project directory 

– Data directory

– Working directory

– Installation directory

– Language of the application

– Creo startkey, Alternative path, Windchill (for Creo Parametric projects)

– Executable file, Commandline arguments (for Apps projects)

Warning 
The Warning tab will only be displayed if a project causes a warning. The tab opens when

clicking on the symbol  next to the project name. 

– Project folder not found: Check the project folder specification in GENIUS TOOLS

Project Configurator in the Projects menu item. 

– Startkey must be selected: Select a Creo startkey in the dropdown menu for the project

option.
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Error
The error tab will only be displayed if a project cannot be started. It contains information

about the error. Errors can be: 

– Creo cannot be started.

– No licenses are available.

– Creo startkey is incorrect or does not exist.

Modify
The Modify tab opens when clicking the button Customize project . After entering a

name, the project is saved with all the selected project options as a custom project. The

selected project options are listed in the Customizations area.

6.14  Creo Parametric

For projects of the Creo Parametric application, the project icons (1) will open the tabs

Info, Licenses, Config, Backup and Modify. You can also select the language (2) and a Creo

startkey (3), if you have been granted access rights. The settings required for this are

described in the Defining project options chapter.

Creo Parametric projects can contain project options as checkboxes (4) which activate one

or more configuration settings. 

In addition, a project report can be generated for Creo Parametric by clicking the  icon

and the GENIUS TOOLS Starter App Config Analyzer analysis program can be opened by

clicking the   icon (2).

Project details and options of a Creo Parametric project

6.14.1  Licenses

The Licenses tab contains information on the license servers assigned to a project of a

CAD application as well as the possibility to analyze these server as well as to borrow
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licenses, if the users have the corresponding user rights. The administrator defines which

license functions users can use, see chapter Displaying license information.

License tab of a Creo Parametric project

1. License server
All license servers specified in the project are listed here without being checked for

availability. The dots turn green or red only after a license analysis (2) 

2. Analyze licenses
After clicking the symbol  Analyze licenses (2) all licenses – and for Creo Parametric: all

lilcense extensions – needed for the project are listed and their availability is displayed in

the column Free. 

If you are running a CAD programm on your local computer, using one license, and there

are no other licenses available on the license server, the number of free licenses is given as

1, not 0. Also, the note Multiple usage is displayed. This is meant to show that you can

start additional instances the CAD programm because no additional license is required.
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Also, the time passed since the last analysis is shown.

3. Borrow licenses
If a user is permitted to borrow licenses, the Borrow button  (3) is displayed, which

opens the license borrowing dialog.

Please note: If you are working with borrowed licenses and without synchronization,

the Licenses tab is hidden. If you are working with borrowed licenses, empty

information tables are hidden.

Display of borrowed licenses

Projects with borrowed a Creo license can be recognized quickly in the main window by

the note on the right.

In the tooltip of the plane button in the footer you can see which GENIUS TOOLS licenses

have been borrowed and until when.
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Borrow licenses

1. In the Licenses tab, click Borrow (2). The

Borrow licenses dialog is displayed.

2. Select the number of days for which you

want to borrow the licenses and click

Borrow. GENIUS TOOLS Starter App

borrows the licenses for GENIUS TOOLS

Starter. The PTC license borrowing

dialog for Creo opens.

3. In PTC Creo license borrowing dialog,

select the correct startkey and the

duration of borrowing in days. The

correct startkey is the one that starts

with the selected project (see Info tab in

GENIUS TOOLS Starter App). Click Start.

Creo is started with the borrowed

licenses.

4. Once Creo has been started completely, GENIUS TOOLS for Creo will automatically

borrow its licenses. If GENIUS TOOLS for Creo does not start, check in the PTC message

window whether the full startup of Creo is displayed.

Please note: If you click on Borrow (step 2) and then cancel the PTC borrow dialog

(step 3) you will have borrowed a GENIUS TOOLS license. 
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Return licenses

To return borrowed Startup TOOLS licenses, select Return all borrowed GT licenses in the

user menu .

6.14.2  Config

The Config tab lists all files used for configuring the project (configuration blocks) ordered

in the directories the files are stored as well the additional applications (toolkit

applications) used in the selected project.

The tab opens by clicking on the  button.

Configuration blocks can be 

– opened and edited by double clicking on them and 

– activated or deactivated for the selected project

if the user has been granted function access to do so. Your administrator defines this, see

chapter Granting function access rights.

Private configuration block
The area Private configuration block is only visible in the Config tab, if an appropriate file is

located in the userdata directory. Path specifications and notation of the file are defined in

the user settings.

Users have the option to edit their local, private configuration block (config file) and write

it back to the administration computer using the  upload button. The Upload button is
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visible if the user has been given the function access right Can save private configuration

block to server. 

Please note: Pause data synchronization when editing a private configuration block.

Toolkit applications used from alternative directory
Additional applications, as specified in the files protk.dat, prodev.dat and creotk.dat, are

listed, if they are located in an alternative directory, see Alternative path specification.

6.14.3  Backup

In the Backup tab users can secure and restore the user specific settings for the user

interface of Creo. It opens with the  button.

Please note: Backup tab and icon will be visible, if users are granted the access right

Can save user-specific settings / customization.ui file.

The file creo_parametric_customization.ui (short: customization.ui) is the Creo

configuration file that contains user-specific settings for the graphical user interface of

Creo Parametric. You can create a backup copy of this file if you have the necessary access

rights.

A click on the folder icon opens the target directory.

Procedure: Create a backup copy for Customization.ui configuration file

1. In the Backup tab click the button  Backup user customization.ui. 
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2. If a backup file already exists: Confirm in the following dialog box that the existing

creo_parametric_customization.ui should be deleted.

Result: The file is saved as creo_parametric_customization.ui.old in the target directory. 

To restore the user UI file:

3. Click  Restore user customization.ui. 

4. In the following dialog box, select whether to delete the backup file.

Result: The creo_parametric_customization.ui.old file is changed to

creo_parametric_customization.ui in the %PTC_WF_ROOT%\.Settings directory.

6.15  Creo Elements/Direct Modeling

For projects in Creo Elements/Direct Modeling, you can open the tabs Info, Licenses,

Config, Backup and Modify (1) and select the language (2), if you have the appropriate

rights.

Project details and options of a CED project

The Info tab specifies the corp directory, the site directory and the user directory.

6.15.1  Licenses

The Licenses tab shows the license servers used in the project. The functions to analyze or

borrow licenses analysis is not available.

6.15.2  Backup

In the Backup tab users can secure and restore the directory for user specific settings. It

opens with the  button.

Please note: Backup tab and icon will be visible, if users are granted the access right

Can save user-specific settings / customization.ui file.
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6.16  Solidworks

For SolidWorks application projects, you can open the tabs Info, Licenses, Config,, Backup

and Modify (1-5) and select the language (6) if you have the appropriate rights. 

SolidWorks projects can contain project options as checkboxes (7). Project options can be:

– activate additional programs (AddIns): shown in italics

– activate additional configuration settings

Project details and options of a Solidworks project

6.16.1  Licenses

The functions in the Licenses tab correspond to those of Creo Parametric projects. (See

Licenses.)

For SolidWorks projects, the borrowing process differs in that SolidWorks licenses are

borrowed directly in the SolidNetWork License Manager client.

6.16.2  Config

The Config tab displays all configuration blocks for SolidWorks, i. e. files of the notation

config_*.sldreg, sorted by their storage directories. The tab is opened with the button. 

The functions for opening and deactivating the configuration blocks correspond to those

in Creo Parametric projects. Likewise, user-defined settings can be saved in a personal

configuration block if the right to do so has been granted.

6.16.3  Backup

In the Backup tab users can backup (1) and restore (2) user-specific settings from the

registry. It opens with the  button.

Please note: Backup tab and icon will be visible, if users are granted the access right

Can save user-specific settings / customization.ui file.
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User configuration

Users can back up (1) and restore (2) the entire SolidWorks user configuration from the

registry. 

The registry branch is backed up as:

HKEY_CURRENT_USER\SOFTWARE\SolidWorks\SolidWorks <version> Old.

Default user configuration

Default user settings are settings from the configuration file default.sldreg. If GENIUS

TOOLS Starter App finds a default file that applies to the select project, the path to the

directory (3) as well as a button for taking over those settings (4) will be displayed.

6.17  Inventor

For projects in the Inventor application, you can open the Info, Licenses, Config, Backup

and Modify tabs and select the language if you have the corresponding access rights.

Display of an Inventor project with open Info tab

Inventor projects can contain project options

– to select Inventor's Read-only mode, see chapter Read-only mode.

– to activate one or more configuration settings

– start additional programs (AddIns)
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To create them, consult the chapter Read-only mode as well as the instructions for

creating company-specific project options.

6.17.1  Config

The Config tab displays all configuration blocks containing the general settings for the

selected Inventor project. The tab is opened with the button . 

The tab lists files of the notation config_*.xml, i. e. configuration blocks for configuration

settings such as template paths, export settings or color effects. All configuration blocks

are copied together into the Inventor configuration file UserApplicationOptions.xml before

the project is started and stored in the target directory specified.

The functions for opening and deactivating the configuration blocks correspond to those

of the Config tab in Creo Parametric projects. Likewise, user-defined settings can be saved

in a private configuration block if the right to do so has been granted.

All additional applications (AddIns) that are available for the project are also listed.

(Whether an AddIn is started or not depends on the LoadOnStartup value).

6.17.2  UI

The UI tab lists all configuration blocks containing the user interface settings for the

selected Inventor project. The tab is opened with the icon .

The tab lists files with the notation ui_*.xml notation, grouped by their storage directory.

These configuration blocks are copied together to the Inventor configuration file

InventorCustomizations.xml before the project is started and stored in the specified target

directory.

The functions for activating and opening the files correspond to those of the Config tab in

Creo Parametric projects.

6.17.3  Backup

In the Backup tab, the user-specific settings of Inventor can be secured. The tab is opened

with the icon .

A backup copy of the Inventor configuration files can be created if the access rights to do

so are granted.

– UserApplicationOptions.xml is the configuration file for general configuration settings,

e.g. template paths, import and export settings, settings for colors and materials.

– InventorCustomization.xml is the configuration file for user interface settings.
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Please note: Backup tab and icon will be visible, if users are granted the access right

Can save user-specific settings / customization.ui file.

Clicking the folder icon opens the target directory. The XML configuration files are created

for each version and are located at:

 %APPDATA%/Autodesk/Inventor <Version>

Clicking the disk icon  saves the XML files as UserApplicationOptions.xml.old or

InventorCustomization.xml.old in the destination directory. 

If a backup copy exists, the file size and last modified date is displayed and the backup can

be restored with the Restore icon .

6.18  Sending messages to the users

GENIUS TOOLS Starter includes a functionality for administrators to send messages in

form of text files to users who can access them in the GENIUS TOOLS Starter App sidebar.

Creating a message
Step 1: Go to the operating environment's _Information directory in the caddepot

directory.

Step 2: Create a TXT or a PDF file with your message. The name of the text file has to start

with the prefix alert_, e. g., alert_message.txt.

After synchronization the existence of new messages is displayed to users by coloring the

message symbol red . After reading the document can be opened again.

6.19  GENIUS TOOLS Starter App Config Analyzer

GENIUS TOOLS Starter Config Analyzer is a tool that allows you to view and edit

configuration blocks (in the Project information page) as well as to directly compare

configuration settings of two projects (in the Compare projects page). The batch files used

are listed.

You can access the Config Analyzer by clicking the Analyze button  in the Config tab of

GENIUS TOOLS Starter App.
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This button can be hidden by the administrator in GENIUS TOOLS Project Configurator

under User Rights > Function access > Can analyze project.

6.19.1  Project information

In the Project Information section  of the GENIUS TOOLS Starter App Config Analyzer, you

will see a list of all configuration blocks (config files) and batch files used for the project, as

well as their location (column: Location). Configuration files can be located in the

Standard, Unit or Project  directories.

You can edit configuration files with GENIUS TOOLS Config Editor by clicking on the Edit

symbol (3). 

The analysis of the configuration files refers to the found weekly version of Creo.

User interface for project information

Search and sort configuration files
Search (1): Search for a file (at least three letters)

Sort (2): Click on the following areas to sort the files by the size of the value (ascending or

descending)

– Lines (number of lines)

– Unknown: Config option not found in the Creo weekly version (i.e. does not exist or is

hidden) or value not found

– Default: Default value of the configuration option in the Creo weekly version

– Mapkeys: Number of mapkey definitions 

– Toolkit: Number of Toolkit applications

– Edit: opens GENIUS TOOLS Config Editor
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6.19.2  Compare projects

The dialog Compare Projects  allows you to directly compare the configuration settings

of two projects. 

Select the projects from the drop-down menu (3). The projects available for selection are

those that you are allowed to open in GENIUS TOOLS Starter App.

Search (1) for a configuration option (at least three letters) or use the All, Equals and Not

Equals buttons to compare configuration options (2).

User interface for comparing projects
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7  GENIUS TOOLS Config Editor

7.1  Introduction

GENIUS TOOLS Config Editor allows you to analyze and edit configuration files for various

CAD applications.

The following functions are available:

– editing of configuration files an blocks for

· Creo Parametric 

· SolidWorks 

· Inventor 

– syntax highlighting

– for configuration options for Creo Parametric

· auto-completion on inputting and display of the possible values

· color coding for duplicate, hidden and unknown configuration options for each

version

· comparing configuration files of different versions

– easy editing of GTS config variables for creating company-specific project options in

GENIUS TOOLS Starter App.

– Batch mode for editing multiple files.

GENIUS TOOLS Config Editor is delivered with GENIUS TOOLS Starter and is available with

a subscription license. 

GENIUS TOOLS Starter has been an independent module of GENIUS TOOLS Startup

TOOLS since version 6.

7.2  Starting the program

You can open GENIUS TOOLS Config Editor from any user computer where GENIUS

TOOLS Starter is installed. The program can be started as follows:

1. in the Windows context menu,

2. with the EXE file,

3. in the project display of GENIUS TOOLS Starter App.
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GENIUS TOOLS Config Editor behaves like other editing programs in that all open files are

opened the next time the program is started. A file can be dragged into the dialog

window of the editor by clicking on it.

Please note: GENIUS TOOLS Config Analyzer requires a subscriptions license. Without

a subscription license you can open a configuration file with other editing programs.

1. Starting with Windows context menu
The line Open with GT Config Editor is added to the context menu by default during setup

and will be available after the first start via the EXE file or GENIUS TOOLS Starter App.

The entry Register in Windows context menu can be disabled in the Config Editor user

menu.

2. Starting the EXE file
The file GTConfigEditor.exe is located in the tools folder, which is located in the caddepot

of the installation computer as well as in the cadpool of the user computer. Path:

cadpool/<working environment name>/tools/config-editor

3. Starting in GENIUS TOOLS Starter App

3.1. For projects of Creo Parametric, Inventor and SolidWorks

Open the Config Tab using the Config files button  in the info area (1) of a project.

Double-clicking on a configuration file in the Config tab (2) opens the file in GENIUS

TOOLS Config Editor.

3.2. For projects of Creo Parametric

Open the tool GENIUS TOOLS Config Analyzer via the Analysis  button in the Info area

(1) of a project. 

Clicking the Edit button in the last column of a config file opens GENIUS TOOLS Config

Editor.
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Please note: The Analysis button can be hidden by the administrator in GENIUS TOOLS

Project Configurator under User Rights > Function Access > Can Analyze Project.

7.3  User interface

The user interface of GENIUS TOOLS Config Editor is divided into the following sections. 

1. Sidebar with start dialog and batch mode and compare versions dialog

2. User menu

3. Selection of version (for configuration files for Creo Parametric)

4. Command bar

5. Display of Confi.pro files with context menu

6. Information area

7. Status bar
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Select version for Creo Parametric files
Select the Creo Parametric version (3) and open the configuration file (config_*.pro) you

want to edit. The weekly versions start with a letter up to Creo main version 4. After that,

the weekly versions are digits of the main version.

  versus 

You can compare several files by arranging them side by side in the window. (See Display

of files.)

Please note: This area is omitted for configuration files for Inventor and SolidWorks.

Command bar 
The command bar (4) contains the following functions

– New file: Creates a new text file.

– Open file: Opens the Windows file manager with a dropdown menu for supported file

types. A file can also be dragged into the dialog window.

– Save: Saves the current file (Strg + S).

– Save all files: Saves all files (Strg + Shift + S).

– Save as: Opens the Windows file manager.

– Reload file and revert changes: Deletes the unsaved changes.

– Copy: Copies the selected text.

– Cut: Deletes the selected text and keeps it on the clipboard.

– Paste: Pastes the text from the clipboard.

– Delete: Deletes the selected text.

– Undo / Redo: Deletes or restores the last action.

– Increase / decrease font size: Decreases or increases the font size.

– Show / hide tabs: Shows or hides spaces, tabs and line breaks.

– Format file: Formats the currently selected file.

– Find and replace: Opens a dialog box with two tabs for Search and for Find/Replace,

see Editing config files. (Strg + F, Strg + H)

– Replace SUT variables: Replaces the GENIUS TOOLS Startup TOOLS (SUT) variables

with the new GENIUS TOOLS Starter (GTS) variables that came into use as of version 6



284GENIUS TOOLS Starter 
  

                                                                                                                                                                       © 2024 INNEO Solutions GmbH

GENIUS TOOLS Config Editor

of Startup TOOLS. (Since then GENIUS TOOLS Starter is an independent module of

Startup TOOLS.)

Context menu
Open the context menu by right-clicking on the file name to get the following options:

Close all – Close all but this file – Copy file path to the clipboard – Open directory in

Explorer.

Information area
For Inventor configuration files (XML files), the first error is displayed with line

specification.

For configuration files of Creo Parameter there is more information, see Info area for

config files.

Status line
The status line (7) contains the following information:

– Line: Indicates the line in which the cursor is located.

– Column: Indicates the position in the line where the cursor is located.

– Length: Displays the number of all characters.

– Lines: Displays the number of all lines.

And for configuration blocks for Creo Parametric:

– Number of configuration options with a warning. (Click on the red symbol to jump to

the next option.)

– Number of configuration options with a note. (Click on the orange symbol to jump to

the next option.)

7.4  User menu

The user menu opens in the header bar with the gear button.
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1. Language 

The language setting of the user interface can be changed between German and

English while the program is running. The setting is saved for the next start.

If the country setting of the operating system is German, GENIUS TOOLS Config Editor

will start in German. All other country settings will start in English.

2. Theme

The user interface of the software is offered in the color schemes light and dark. The

setting is saved for the next start.

3. License server

Opens the input dialog for the license server. 

Change here the license server that provides the license for GENIUS TOOLS Config

Editor in the notation 7766@localhost.

4. Creo versions

Opens the input window for selecting the Creo versions for which you want to view

configuration files.

The databases for configuration options are available for all Creo versions, meaning you

can edit configuration files regardless of whether the Creo version is installed on your

computer.

Please note: The databases of the enabled versions are loaded into the user directory

AppData\Roaming\INNEO\GENIUS_TOOLS\GENIUS TOOLS Config Editor.

During setup, the activated checkboxes show the Creo versions that are installed on

your computer. If no Creo version is found on the computer, all checkboxes are

activated.
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5. Register in Windows context menu

Adds the command Open with GT Config Editor to the Windows context menu. This

entry is activated by default.

6. Help

Help (F1): Opens the help for GENIUS TOOLS Config Editor. The help corresponds to

this document.

Support: Opens the website of the technical support of Inneo Solutions GmbH.

Info (F12): Displays the license agreement of the current version of GENIUS TOOLS

Config Editor.

7. Reset Window Size

Restores the default size for the GENIUS TOOLS Config Editor dialog window. The

dialog window can be resized to any size.

8. Exit

7.5  Display of files

You can display multiple files both one below the other and side by side, e. g. to compare

two configuration files.

This is particularly useful for comparing Creo configuration blocks of different versions.

See chapter Comparing versions.

Display of two files next to each other 
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Procedure: Setting up the file display

– Change the position of a single file by clicking and dragging the file to the desired

location using the split star. 

7.6  Supported files

With GENIUS TOOLS Config Editor you can edit configuration files and blocks for different

CAD applications.

A configuration file contains all settings of an application without using GENIUS TOOLS

Starter, e. g. the file config.pro for Creo Parametric.

A configuration block

– is one of many configuration subfiles that are read by GENIUS TOOLS Starter to create

the configuration of a Starter project,

– is a text file that contains one or more configuration settings,

– must be created with an application-specific name.

The following configuration blocks can be created for the respective CAD applications.

Configuration-

block

Content Example

Creo Parametric

1 config_*.pro

(also: Config-

Datei)

All settings (configuration

options) for executing the

application

config_sut_de_c6p_dir_file.pro

config_c5p_mapkeys.pro
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Configuration-

block

Content Example

2 config_*.sup Settings that cannot be

modified by users

config_design_en.sup

SolidWorks

3 config_*.sldreg All settings,

Embedding additional

application (AddIns)

config_addin_compose.sldreg

Inventor

4 config_*.xml All settings config_dir_file.xml

5 ui_*.xml Settings for user interface ui_customization.xml

6 *.addin Embedding additional

application 

AdditiveMFG.inventor.addin

7.7  Configuration files for Creo Parametric

Information and color coding are more extensive for configuration blocks for Creo

Parametric.

7.7.1  Display of configuration options

Creo configuration option define settings in Creo Parametric and are written into a

configuration block. For better readability GENIUS TOOLS Config Editor displays

configuration options as follows. 

Configuration options that are highlighted in color contain notes (orange) or warnings

(red) which are explained in the information area. 

Color code Description

accuracy_lower_bound Configuration option

1.0e-6 Numerical value

 yes Nonnumerical value (e. g. yes, medium)
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Color code Description

$GTS_DATA Variable

– e. g. variable of Startup TOOLS (SUT) and GENIUS

TOOLS Starter (GTS)

! gts_display_name GTS config variable

– contains information to create a company-specific

project option for GENIUS TOOLS Starter App

Configuration option with the default value

– is listed in the info area

Duplicates (multiple entries of a configuration

option)

– are listed in the information bar

– Please note: Duplicate options that can regularly

be entered several times in a config file – such as

mapkey or search_path – are not marked in

orange.

Hidden configuration option

– are not officially supported by the Creo

manufacturer

– is listed in the info area

Unknown configuration option

– due to incorrect spelling or because it is not

known in the selected Creo version

– is listed in the info area

Mapkey line is too long

– up to Creo version 4: max. 81 characters allowed

– from Creo version 4: max. 260 characters allowed

!changed 01/02/22 Comment

7.7.2  Info area

In the lower part of the main window configuration options with a note or a warning, i. e.

those colored in orange or red, are listed. You can thus get a quick overview of the

content of a config.pro file for Creo Parametric. 
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Info area of the Config Editor

1. Unknown configuration options

Options will not be recognised as such

– if they do not exist, e. g. in case of incorrect spelling notation, or 

– if they are not known in the selected Creo version, e. g. the smooth_lines option exists

only since Creo version 5.

2. Duplicates / duplicates

Configuration options that are set two or more times. Here: in line: 13 and 14.

3. Default value

Configuration options in which the default value is set.

4. Hidden configuration options

Options which are not officially supported by makers of Creo Parametric.

7.7.3  Comparing versions

In the menu item Compare versions  you can view the configuration options and the

default values that have changed from one Creo Parametric version to another. 
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Select a version (main plus subversion) on the left (1) and another version on the right (2)

and press the Compare button (3).

The following results are displayed:

– Configuration options whose default values have changed (4): The default values are

listed first for the older version and then for the newer version, regardless of how the

versions have been selected in the command bar.

– Added options with default values (5).

– Removed options (6).

The information (hidden) refers to hidden configuration options.

7.8  Editing config files

Find and replace 

The magnifying glass button opens the Find and Replace dialog. So does Ctrl + F.
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Edited file

Changes to a file are indicated with an asterisk.

Functions for Creo configuration files
Files that contain configuration options for Creo Parametric (config_*.pro files) are

supported by additional functions.

Autocomplete

When entering a new configuration option, a list of the possible configuration options

opens. The list includes hidden configuration options.

Options when entering "dis".

Suggest function

When entering a value for a the configuration option, a list of all possible values opens.

For hidden configuration options no values are suggested. The GTS config variable

gts_choose is always an option.
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Possible values for a configuration option

Tooltip

Each configuration option is explained in a tooltip which contains

– the possible input values, 

– the default value and

– a description of the option.

Functions for Inventor configuration files

Collapse

Program code can be collapsed with the minus symbol.

7.9  GTS config variables

All configuration blocks can also be used for creating a project option. To do this, enter

GTS config variables as a comment in the file (configuration block).

Make sure to use the correct comment characters for the application-specific file type.

These are:

– for Creo Parametric configuration blocks: !

– for SolidWorks configuration blocks: ,
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– for Inventor configuration blocks: <!-- -->

Enter the necessary expression gts_is_selectable = true as a comment, as well as other GTS

config variables if required for the display of the project option. Auto-completion and,

after clicking on a function, an explanation are available for the input.

The table lists GTS config variables that can be used for all CAD applications. For detailed

instructions and more variables for license extensions for Creo Parametric projects, refer to

the GENIUS TOOLS Starter manual.

GTS config

variable for all

applications

Specification / 

Example

Description

gts_is_selectable = true/false Defines if the project option appears as a

checkbox (in the Options tab as well as below

the project name)

gts_selection_defa

ult = 

true/false Defines whether the project option is selected

by default or not, i. e. whether the box is

checked. Default: false.

gts_display_name

= 

Simulation Live

(Real-time

simulation)

display name in the Config tab

– if not specified, the file name is used

gts_selection_nam

e = 

Simulation Live display name in selected project and in the

Options tab

– if not specified, gts_display_name is used

gts_selectable_pos

= 

1 specifies the position in the list of project

options. This does not change the order in

which the configuration file is processed.

– if this command is not specified, the project

option will be placed after the options with

position and ordered alphabetically
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GTS config

variable for all

applications

Specification / 

Example

Description

gts_description = Simulation for

fluids for Creo

from version 7.0. 

Tooltip text for name of project option

– if not specified, the file name is used

GTS config

variable for

switch options

Specification / 

Example

Description

gts_choose gts_choose{Big

Assemblies ||

display_points

NO ||

display_points

YES}

The gts_choose expression is set instead of the

value of a configuration option and must contain

two values.

7.10  Batch mode

In batch or batch mode , you can revise any number of config files. You can: 

– find files with hidden config options,

– find files that contain fixed paths,

– search and replace words,

– replace SUT variables with GTS variables. (This actions assigns the corresponding GTS

variables automatically.)

Please note: Do not mistake GTS variables (environment variables) for GTS config

variables.
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Batchmode dialog: Finding files with hidden options

Procedure

1. Drag the action you want to perform to the processing list.

2. In the processing list click on the action and fill in the details.

3. Under Settings (3) specify the folder where the config files are located. Activate

Recursive search to include files in all contained subfolders in the search. 

4. Click the arrow icon (4).

Result: You will see the executed actions and the found options and paths in the log area.

Show preview

For the actions Search and replace and Replace SUT variables, you can get a preview in an

extra window which shows all hits. You can disable individual hits and choose to apply or

cancel the replacement. With the option Next change you can jump to the next hit within a

file.
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Preview for searching and replacing a value of a configuration option
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8  Appendix

8.1  Start parameters

You can start GENIUS TOOLS Starter App with the following parameters.

Start parameter Description

-gts:admin Starts GENIUS TOOLS Project Configurator.

-gts:appdata Redefines the path to the Appdata directory.

-gts:debug Activates debug logging.

-gts:expcfg Defines the location of the expcfg.bat file of the worker.

-gts:home Sets the home directory. Example: D:

\gtstarter\cadpool\inneo\software\GTS.exe -gts:home=

%SystemDrive%\home\%USERDOMAIN%.%USERNAME%

\pro.creo3

-gts:lang Starts GENIUS TOOLS Starter App in a defined language

(de/en/fr).

-gts:L Sets Creo language.

-gts:CL Set language for GENIUS TOOLS Starter.

-gts:licDebug Activates debug logging for the license server (loud

alarm when license problems occur).

-gts:licServer Sets the license server.

-gts:licTimeout Defines the maximum waiting time to receive a license, in

milliseconds. Entries from 1000 to 60000. Default: 10000.

Setting is passed on to Creo by environment variable

GT_LIC_TIMEOUT.

-gts:networkTimeout Redefines the network timeout. Entries in milliseconds.

-gts:noChecksum Deactivates checksum tests during synchronization.

-gts:noProjectAutostart Prevents the project (gts:p) from being started

immediately.
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Start parameter Description

-gts:noSync Deactivates synchronization.

-gts:p Starts a project and filters the project list.

-gts:pui Filters the project list to a list of projects specified

separated by commas (-

gts:pui=pname1,pname2,pname3).

-gts:temp Redefines path to the Temp directory.

-gts:units Defines the ID string of a unit.

-gts:worker Starts in Worker setting.

-gts:workingDir Defines the directory where the runtime data (log files) of

GENIUS TOOLS Starter is stored.

8.2  Environment variables

Created environment variables

GTS environment

variable

Description / example Old SUT

variable

GT_LIC_SERVER contains the specifications of -gts:licServer

GT_LIC_TIMEOUT contains the specifications of -

gts:licTimeout (maximum waiting time of a

license query)

GTFC_ADMIN contains the result of the switch Is GTfC

Admin in GENIUS TOOLS Project

Configurator > Organization > Access >

Role > Function Access

TBXADMIN

GTS_APPS_DIR Finds the selected, application-specific

directory for add-on applications. 

<Caddepot>\<operatingenvironment>\<a

pplication>\apps
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GTS environment

variable

Description / example Old SUT

variable

(GTS_CFG_LW)

recommended instead:

GTS_ROOT_DIR

GTS:<Cadpool>\<operatingenvironment>

GTS: D:\gtstarter\cadpool\2017_latest

SUT: <DriveLetter>

SUT: P:

STOOLS_CFG_L

W

GTS_*_ESCAPED Variant of a variable that prevents the

variable from being resolved, e. g. needed

in mapkeys. Is defined automatically, see

explanation in section below.

GTS_CONFIGURATION_D

IR

Finds the selected, application specific

configuration directory.

<Caddepot>\<operatingenvironment>\<a

pplication>\configuration

GTS_CREO_INSTALL_DEFI

NITIONS_DIR

definitions directory under the install folder

GTS_CREO_INSTALL_DIA

GNOSTIC

1 if diagnostic tools are activated, otherwise

0

GTS_CREO_INSTALL_FIRE

WALL

1 if Write firewall entries is activated,

otherwise 0

GTS_CREO_INSTALL_HEL

P

1 if Install help is activated, otherwise 0

GTS_CREO_INSTALL_HEL

P_XML_DIR

XML directory for the help

(install/definitions/<Unit or

standard>/XML/help_Creo<MainVersion>)

GTS_CREO_INSTALL_MAI

N_VERSION

Creo main version to be installed

GTS_CREO_INSTALL_TAS

KSKILL

1 if taskkill is activated, otherwise 0

GTS_CREO_INSTALL_UNI

T_FOLDERS

List of the currently selected units (e. g.

“Germany|Leipzig|Construction”)
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GTS environment

variable

Description / example Old SUT

variable

GTS_CREO_INSTALL_UPG

RADE

-upgrade if the installation type was set to

upgrade, otherwise “”

GTS_CREO_INSTALL_VER

SION

Creo version to be installed (e. g. 11.0.1.0)

GTS_CREO_INSTALL_VIE

WER

1 if Install Thumbnail Viewer is activated,

otherwise 0

GTS_CREO_INSTALL_XML

_DIR

XML directory (install/definitions/<Unit or

standard>/XML/Creo<MainVersion>)

GTS_DATA Finds the selected data package directory,

is from version 9.0 application specific: i. e.

in Creo Parametric it has been changed

from

<Caddepot>\<operatingenvironment>\dat

a\<companydata>

to 

<Caddepot>\<operatingenvironment>\<a

pplication>\data\<companydata>

SUTDATA

GTS_DATA_LIB Datalib directory

GTS_ENV_NAME         Name of operating environment.

GTS_EXECUTION_DIR Points to the directory which contains the

executed file (*.exe, *.bat, *.pdf).

GTS_MAIN_SERVER_DIR Server path of the main server

GTS_MC SUTMC

GTS_NET_LW Name of the first network drive.

GTS_PLOT_CONFIG_DIR Directory for the plot configuration of Creo

Parametric

PLOT_CONFIG_

DIR

GTS_PLOT_FILE_DIR File for the plot settings of Creo Parametric PLOT_FILE_DIR

GTS_PROEDATECODE Version of Creo Parametric SUT_PROEDATE

CODE
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GTS environment

variable

Description / example Old SUT

variable

GTS_PROERELEASE Version of Creo Parametric SUT_PROERELEA

SE

GTS_PROJECT_DIR Finds the selected project directory, from

version 9.0 application-specific. Path:

<Caddepot>\<operatingenvironment>\<a

pplication>\configuration\projects\<projec

tname> 

APPL_PROJECT_

DIR

GTS_PROJECT_DIR_NAME Name of project directory (until version 9.0

in GTS_PROJECT_DIR.)

GTS_PROJECT_NAME Name of current project SUT_PROJECT_N

AME

GTS_ROOT_DIR Main directory of the operating

environment

SUT_ROOT_DIR

GTS_SATELLITEONLY_DIR Directory that only exists on the main

server and the satellite

GTS_SERVERONLY_DIR Directory that exists only on the server

GTS_SERVER_DIR Path to the server

GTS_SYNC_LAST Last synchronization date

GTS_SYNC_MODE Synchronization mode

GTS_TEMP Points to the temp directory

GTS_TRAIL_DIR Trail directory of Creo Parametric TRAIL_DIR

GTS_UNIT_DIR Finds the selected unit directory, from

version 9.0 application-specific. Path:

<Caddepot>\<operatingenvironment>\<a

pplication>\configuration\units\<unitdirect

oryname> 

as of version

11.0, use instead

of:

GTS_USER_GRO

UP,

GTS_COMPUTER

_GROUP

GTS_UNIT_DIR_NAME Name of unit directory 
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GTS environment

variable

Description / example Old SUT

variable

GTS_UNIT_NAME Name of unit that is selected by the user

GTS_USER STOOLS_USER

GTS_USER_CONFIG_DIR Directory that contains the personal

settings of users

USER_CONFIG_

DIR

GTS_USER_LW Letter of user drive STOOLS_USER_L

W

GTS_USERLONG STOOLS_USER_L

ONG

GTS_USERSHORT STOOLS_USER_S

HORT

GTS_VERSION Version of GENIUS TOOLS Starter

GTS_WCSRVNAME Windchill server name STOOLS_WCSRV

NAME

GTS_WCSRVURL Url of windchill server STOOLS_WCSRV

URL

GTS_WORKING_DIR Points to the start directory (for Creo

Parametric: working directory)

LANG Language LANG

Created environment variables: ESCAPED variant
Since version 6.0.2.0 variables are resolved in configuration files. This means that mapkeys,

in which environment variables with path specifications are used, no longer work. In order

to allow you to continue using variables in mapkeys and other places where a resolution is

undesirable, a new variant of all environment variables was introduced with the extension

_ESCAPED. 

The ESCAPED variant of a variable is defined automatically: If an environment variable is

defined without the ESCAPED extension, GENIUS TOOLS Starter automatically writes the

value of this environment variable into the ESCAPED environment variable.

All variables can be extended with _ESCAPED. In particular, the following variables are

required for use in Mapkeys: GTS_PLOT_CONFIG_DIR_ESCAPED,
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GTS_SERVERONLY_DIR_ESCAPED, GTS_SERVER_DIR_ESCAPED, GTS_TRAIL_DIR_ESCAPED,

GTS_UNIT_DIR_ESCAPED, GTS_USER_CONFIG_DIR_ESCAPED.

Affected environment variables
PTC_WF_ROOT

Environment variable that overwrites the default location of the Creo directory. (WF

comes from “Wildfire”, name of the predecessor product of Creo.)

PTC_WF_CACHE

Environment variable that refers to additional cache space.

PTC_SESSION_LOG_PATH

PTC_SESSION_TRACEBACK_PATH

PTC_SESSION_TRAIL_PATH

8.3  Regular expressions

Regular expressions can be used for names that create users and computers.

Character Description

\ Indicates the following character as a special or verbatim character. For

example “n” is corresponds to the character “n”. “\n” corresponds to a

line-break character. The sequence “\\” corresponds to “\”, “\(”

corresponds to “(”. 

^ Corresponds to the beginning of the input.

$ Corresponds to the end of the input.

* Corresponds to the proceeding character zero or multiple times. For

example “zo*” matches either “z” or “zoo”. 

+ Corresponds to the proceeding character one or multiple times. “zo+”

for example matches “zoo”, but does not match “z”.

? Corresponds to the proceeding character zero or one time. For

example “a?ve?“ matches the “ve” in “never”.

. Corresponds to all single characters except for a line-break character.
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Character Description

(Pattern) Matches Pattern and saves the equivalent. The compared substring

can be retrieved from the resulting matches listing using the elements

[0]...[n]. For comparing of characters put in parentheses ( ) use “\(” or

“\)”.

x|y Corresponds to either x or y. For example matches “l|red” either “l” or

“red”. “(l|r)ed” matches “led” or “red”.

{n} n is a positive integer. Corresponds to exactly n times. “o{2}” for

example does not match the “o” in “Robert” but the first two “o”s in

“Booooat”. 

{n,} n is a positive integer. Corresponds to at least n times. “o{2}” for

example does not match the “o” in “Robert” but all “o”s in “Booooat”.

“o{1,}” is equivalent to “o+”. “o{0,}” is equivalent to “o*”.

{n,m} m and n are positive integers. Corresponds to at least n and maximum

m times. For example “o{1,3}” matches the first three “o”s in

“Boooooat”. “o{0,1,}” is equivalent to “o?”.

[xyz] A group of characters. Corresponds to any of the included characters.

“[abc]” for example matches the “a” in “falling”.

[^xyz] A group of excluded characters. Corresponds to any character not

included. “[^abc]” for example matches the “f” in “falling”.

[a-z] A character range. Corresponds to any character in the specified range.

For example, “[a-z]” matches any lowercase alphabetic character in the

range from “a” to “z”.

[^m-z] An excluded range of characters. Corresponds to any character not

included in the specified range. “[m-z]” for example matches all

characters not included in the range from “m” to “z”.

8.4  GTS config variables

The following GTS config variables are needed for generating single project options to

select license extensions and extensions for Creo Parametric projects.
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GTS config

variable for all

applications

Specification / 

Example

Description

gts_is_selectable = true/false Defines if the project option appears as a

checkbox (in the Options tab as well as below

the project name)

gts_selection_defa

ult = 

true/false Defines whether the project option is selected

by default or not, i. e. whether the box is

checked. Default: false.

gts_display_name

= 

Simulation Live

(Real-time

simulation)

display name in the Config tab

– if not specified, the file name is used

gts_selection_nam

e = 

Simulation Live display name in selected project and in the

Options tab

– if not specified, gts_display_name is used

gts_selectable_pos

= 

1 specifies the position in the list of project

options. This does not change the order in

which the configuration file is processed.

– if this command is not specified, the project

option will be placed after the options with

position and ordered alphabetically

gts_description = Simulation for

fluids for Creo

from version 7.0. 

Tooltip text for name of project option

– if not specified, the file name is used

The following GTS Config variables are used to create single project options for selecting

license extensions for Creo Parametric projects.
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GTS config

variable

Specification /

Example

Description

gts_creo_lic = <licensenumber>,

e. g. 379 

Creo Parametric: License number(s) of the

extension(s) to be added. Multiple numbers

must be separated with empty space.

– if this entry is set, an icon key appears next to

the checkbox in the project

– license numbers can be read from the

license.dat file in the licensing folder under

PTC/FLEXnet Admin License Server

gts_creo_lic_displ

ay_name =

<text>, e. g.

Simulation Live

Creo Parametric: Tooltip text for license symbol

(key)  

– if not specified, the line under License name

is empty

gts_requires_base_l

ic =

<baselicense>,

e. g.

PROE_Foundation

Defines condition: if the base license is not

available, the project option will be deactivated,

i. e. no checkbox is displayed. 

– It checks if the base license is specified in the

PSF key.

– Multiple licenses must be separated with

empty space. The project option will be

deactivated, unless all of the listed licenses

are available.

gts_auto_activate_

base_lic =

<baselicense>,

e. g.

PROE_Foundation

Defines condition: If the base license is

available, the project option will be preselected,

i. e. the box is checked.

– Multiple licenses must be separated with

empty space. The project option will be

deactivated, unless all of the listed licenses

are available.

– Take care not to simultaneously set the

variable ! gts_selection_default to true. 

If the file is to control an auxiliary application, specify the corresponding configuration

option, such as a protkdat entry. (Example: protkdat

$GTS_ROOT_DIR\configuration\application\protk_keyshot.dat). These entries do not
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GTS config

variable

Specification /

Example

Description

create icons next to the checkbox.

The gts_choose variable can be used to create switch options and to include add-on

applications for Solidworks.

GTS config

variable for

switch options

Specification / 

Example

Description

gts_choose gts_choose{Big

Assemblies ||

display_points

NO ||

display_points

YES}

The gts_choose expression is set instead of the

value of a configuration option and must contain

two values.

GTS config

variable for

SolidWorks

Specification / 

Example

Description

gts_choose gts_choose{Soli

dWorks

Composer||

00000001||

00000000}

The gts_choose expression must contain two values

for registry entry.

Comment characters for each application

Application Configuration block

required (text file)

Com-

ment

charac-

ter

Example

Creo Parametric config_*.pro, config_*.sup ! ! gts_display_name =
Keyshot plugin

SolidWorks config_*.sldreg ; ; gts_display_name =
3DConnexion
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Application Configuration block

required (text file)

Com-

ment

charac-

ter

Example

Inventor config_*.xml, ui_*xml, *.addin <!--
-->

<!-- gts_display_name =
Additive Manufacturing -->

8.5  Start values in Startup TOOLS

Access to the individual extension modules of GENIUS TOOLS for Creo
and editors
The start switches for user modules are set to 1, i. e. they can be opened by users.

The start switches for the editors of these modules are set to 1 or to %GTFC_ADMIN%. The

%GTFC_ADMIN% variable contains the result of the switch Is GTfC Admin in GENIUS

TOOLS Project Configurator > Organization > Access > Roles > Function Access.

The variable %GTFC_ADMIN% is set in the delivery state of the Startup TOOLS in the

following configuration options.

Editor Name and value of configuration option („start switch“)

GENIUS TOOLS Library

Editor

gt_start_library_editor=%GTFC_ADMIN%

GENIUS TOOLS Material

Editor

gt_start_material_editor=%GTFC_ADMIN%

GENIUS TOOLS Name

Generator Editor

gt_start_name_generator_editor=%GTFC_ADMIN%

GENIUS TOOLS Quick

Access Editor

gt_start_quick_access_editor=%GTFC_ADMIN%

GENIUS TOOLS UDF

Forms Editor

gt_start_udf_forms_editor=%GTFC_ADMIN% 

8.6  GENIUS TOOLS Starter: part of Startup TOOLS

GENIUS TOOLS® Starter is a stand-alone application within the product package GENIUS

TOOLS Startup TOOLS.
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9  Glossary

Administration computer

Computer on which the administrative user has full write access to the Caddepot

directory in order to manage all data on the file system level.

Application computer, workstation

Computer on which the (Creo) user works. The application computer houses the

Cadpool directory, which contains the local operating environment.

Authentication provider

An authentication provider is an executable file that requests or receives user data from an

authentication system.

Cadpool

Directory on the application computer that contains the local operating environments.

The Cadpool directory is synchronized from the Caddepot.

Caddepot

Directory on the administration computer that contains the central operating

environment.

Client

Term for application computers for Startup TOOLS versions up to 2018.

Computer group

When updating to version 11.0.0.0 and newer, existing computer groups will be

transformed into units.

Conditional configuration block

Configuration file whose validity is restricted to condition(s) by one or more tag ID(s).

Notation: config_*.TAGID.pro

Config file (also: config_*.pro file)

See configuration block.

Configuration block

Configuration file which is read by GENIUS TOOLS Starter to create the configuration of

a Starter project. Notation: config_*.pro, config_*.sldreg.

Config.pro

Most important Creo Parametric configuration file, defines user settings.

Config.sup file

Creo configuration file which contains settings that cannot be changed by the users, e.g.
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to ensure drawing standards.

Config.val file

Creo Parametric configuration file which contains validation settings for data import.

Creo

Name of CAD software by PTC with the applications Creo Parametric (formerly

Pro/Engineer) ans Creo Elements/Direct (formerly CoCreate).

Creo configuration file

File which determines settings for a Creo session. There are four types of configuration

file: config.pro, customization.ui, config.sup and config.val.

Creo startkey (also: PSF key, start command)

Configured start command that opens Creo Parametric with one or several defined

licenses or license extensions. Stored as PSF file in PTC bin directory.

Customization.ui file

Creo Parametric configuration file which contains user interface customizations for a

user. The precise name of the file is creo_parametric_customization.ui

Data directory

Main directory for all data related to an operating environment at <GTS-

OperatingEnv>\data.

Educational license

License for academic institutions.

Escaped variable

Variant of an environment variable that prevents the variable from being resolved. It is

defined automatically.

Free tag ID

Textual marking in a configuration block which restricts the file to the selection of a

combined project option.

GENIUS TOOLS

Family of software products by INNEO Solutions GmbH, including Startup TOOLS, Model

Processor, and freeware tools such as Purge.

GENIUS TOOLS for Creo

Component of the Startup TOOLS software product which contains functional

enhancements for Creo.

GENIUS TOOLS Environment Administrator

Stand-alone administrative tool. It is used to create and update work environments, edit

work environment properties and migrate from older versions of Startup TOOLS to
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version 6 and later. GENIUS TOOLS Environment Administrator is located at ...

\installdepot\gtsa-latest\gtsa-exe.

GENIUS TOOLS License Manager

Administrative tools for managing Startup TOOLS licenses.

GENIUS TOOLS Project Configurator 

Administrative component of GENIUS TOOLS Starter for managing project

configurations and other properties of an operating environment. Open GENIUS TOOLS

Project Configurator from the user menu of GENIUS TOOLS Starter App.

GENIUS TOOLS Starter

Software product consisting of the three components GENIUS TOOLS Project

Configurator, GENIUS TOOLS Starter App and GENIUS TOOLS Environment

Administrator.

GENIUS TOOLS Starter App

Stand-alone component of GENIUS TOOLS Starter which lets users start configured Creo

projects. GENIUS TOOLS Starter app is located in each operating environment under 

...\caddepot\lokal\software\GTS.exe. 

GENIUS TOOLS Starter App Config Analyzer

Dialog box in GENIUS TOOLS Starter App, in which configuration settings of projects can

be analyzed and edited.

GENIUS TOOLS Starter Service

Method in GENIUS TOOLS Starter for faster data synchronization.

GTS

Abbreviation for GENIUS TOOLS Starter.

GTS.exe

Name of the executable file for GENIUS TOOLS Starter App.

GTSA.exe

Name of the executable file for GENIUS TOOLS Environment Administrator.

GTS Alias

User alias in GENIUS TOOLS Starter, for use in additional applications for Creo. The GTS

alias is available as an environment variable (%GTS_USER%) in Creo. If you do not specify

an alias, the user name will be used.

GTS Alias Long

Long user alias. The long alias is available in Creo via the environment variable %

GTS_USERLONG%.
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GTS Alias Short

Short user alias. The short alias is available in Creo via the environment variable %

GTS_USERSHORT%.

GTS-config-variable

Variable that defines settings in a configuration block to create a single project option

for GENIUS TOOLS Starter App, e. g. gts_display_name

GTS variable

Environment variable that creates inforamtion for GENIUS TOOLS Starter, e. g.

GTS_UNIT_DIR.

Home Use license

License for private use.

Initial synchronization, initialization

First synchronization run which creates the Cadpool directory on the application

computer and synchronizes it with the Caddepot.

Installdepot

Subdirectory of the installation directory that contains the release and version setups

without settings and customizations. All setup programs unpack their data to this

directory.

Installation computer

Computer on which the setup programs are run. Typically, this is also the administration

computer.

LDAP (Lightweight Directory Access Protocol)

Network protocol for accessing a distributed directory service, e. g. the Windows user

management.

License extension

License for additional Creo Parametric functionality that is drawn at the start of the

program and blocked during the session.

Mapkey

Macro defining a sequence of commands and functions which can be created in Creo to

simplify often-used procedures.

Mediadepot

Subdirectory of the installation directory. It contains setup files for different releases and

versions. All setup files will install or unpack to the Installdepot directory.

NAS (Network Attached Storage)

File server providing independent storage capacity in a network of computers.
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NC (Numerical Control)

Computer-based applications for controlling machine tools and production lines.

Operating environment

Directory that contains all the data required for working with the desktop application.

This includes configuration data, libraries, templates and additional applications. The

operating environment also contains a database with all configured projects.

Operating environment, local

Operating environment on the application computer.

Organization tree

Structure of all units and subunits that specifies the call hierarchy. Created in GENIUS

TOOLS Project Configurator.

Perpetual license, permanent license

License that allows using a defined version of a software for an unlimited period of time.

PDM directory

Subdirectory of the directory standard, units, projects and users which is included into the

call hierarchy for configuration files and batch files if Windchill is active.

PDMLink

Component of the Windchill software product family that is used for product data

management.

Power Extensions

Application from INNEO for central administration of an operating environment for Creo

Elements/Direct projects.

PTC

The software company that develops Creo.

Project

See Starter project.

Project, blocked

Project that a user can neither access nor see in GENIUS TOOLS Starter App.

Projekt, hidden

Project that a user cannot see in GENIUS TOOLS Starter App, but is able to access it with

a transfer parameter.

Project, invalid

Project, for which a user has no valid license or required license extensions. Access to it

an display in GENIUS TOOLS Starter App can be configured.
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Project directory

Directory for project data at <GTS-OperatingEnv>\configuration\projects\%

GTS_PROJECT_DIR%

Project option

Option to select on one or more projects in GENIUS TOOLS Starter App the Creo

language, Creo startkey as well as license extensions and add-on programs.

Resource directory

Directory gt_resource_folder, which is located in the system directory configuration of

Creo Parametric and contains information for the modules of GENIUS TOOLS for Creo.

Role

Group of users or computers that are assigned access rights to projects and GENIUS

TOOLS Starter App functionality.

Satellite (also: synchronization or mirror server)

Computer or shared folder on a computer to which the state of one or more operating

environments of a central main server is mirrored. 

Searchmode directory

Name of the directory PDM until version 9.0.0.

Starter project

Project created in GENIUS TOOLS Project Configurator which contains company-specific

data and additional applications and whose settings, such as license and project

specifications, can be made in different configuration levels.

Startup TOOLS

Software package that comprises the products GENIUS TOOLS Starter, GENIUS TOOLS

Library, GENIUS TOOLS Parameter, as well as Creo data packages and the GENIUS

TOOLS License Manager.

Startup TOOLS Server

Term for the administration computer for Startup TOOLS versions up to 2018.

STOOLS

Root directory name for Startup TOOLS versions up to 2018.

Subscription license

License that allows using a software for a limited period of time.

Subunit

Subordinate unit created by attaching a unit to another unit in the organization tree.

SUT

Abbreviation for Startup TOOLS.
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Synchronization

Functionality that copies the data of an operating environment in the Caddepot

directory to the Cadpool directory on an application computer.

Tag ID

Textual marking in a configuration block that is recognized by GENIUS TOOLS Starter.

There are tag IDs for units (unit tag ID) and for project options (free tag ID).

TeamViewer

Third-party software used by INNEO Solutions GmbH to provide remote support.

UDF (User-defined feature)

Template for repeatedly required Creo features.

Unit

Group of users who belong to a company department defined either geographically or

organizationally. Created in GENIUS TOOLS Project Configurator.

Unit directory

Directory in the units system directory that contains configuration blocks and other files

for a unit.

Unit tag ID

Tag ID that is assigned to a unit in GENIUS TOOLS Project Configurator.

Unit type

Individually defined category for units, for better representation in GENIUS TOOLS

Project Configurator.

User, dynamic

Variable entry in the Resources menu item under Role > LDAP or User group

(authentication provider).

User group

When updating to version 11.0.0.0 and newer, existing user groups will be transformed

into units.

User, permanent

Manually entered entry in the Resources menu item under Users.

Windchill

Software product by PTC for managing product data over the entire product life cycle.
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Copyright 2024 by:

INNEO Solutions GmbH

IT-Campus 1

73479 Ellwangen

Germany

This documentation is protected by copyright. All rights reserved.

Without prior written consent of an authorized representative of INNEO Solutions GmbH

it must not be copied, photocopied, reproduced, translated, communicated or converted

to electronic or machine readable form in whole or in part.

The unauthorized use of the documentation can lead to a claim for liquidated damages or

legal prosecution. INNEO Solutions GmbH does not accept liability for possible faulty

information in this documentation and the consequences resulting from such.

Note on registered trademarks:

Most of the software, hardware and trade names mentioned in this documentation are

also registered trademarks of the respective software manufacturers.

Registered trademarks and trade names of INNEO Solutions GmbH:

GENIUS TOOLS, Startup TOOLS, INNEO
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